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Safety Notices

A CAUTION notice denotes a hazard. It
calls attention to an operating proce-
dure, practice, or the like that, if not
correctly performed or adhered to,
could result in damage to the product
or loss of important data. Do not pro-
ceed beyond a CAUTION notice until
the indicated conditions are fully
understood and met.

A WARNING notice denotes a hazard.
It calls attention to an operating pro-
cedure, practice, or the like that, if not
correctly performed or adhered to,
could result in personal injury or
death. Do not proceed beyond a
WARNING notice until the indicated
conditions are fully understood and
met.
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Safety Summary

General
Before Applying
Power

Ground the
Instrument

Fuses

Do Not Operate in
an Explosive
Atmosphere

Do Not Remove the
Instrument Cover

Cleaning

Do Not Modify the
Instrument

In Case of Damage

The following general safety precautions must be observed during all phases of operation of this
instrument. Failure to comply with these precautions or with specific warnings or operating
instructions in the product manuals violates safety standards of design, manufacture, and intended
use of the instrument. Keysight Technologies assumes no liability for the customer's failure to comply
with these requirements. Product manuals are provided with your instrument on CD-ROM and/or in
printed form. Printed manuals are an option for many products. Manuals may also be available on
the Web. Go to www.keysight.com and type in your product number in the Search field at the top of
the page.

Do not use this product in any manner not specified by the manufacturer. The protective features of
this product may be impaired if it is used in @ manner not specified in the operation instructions.

Verify that all safety precautions are taken. Make all connections to the unit before applying power.
Note the instrument's external markings described in “Safety Symbols”.

If your product is provided with a grounding type power plug, the instrument chassis and cover must
be connected to an electrical ground to minimize shock hazard. The ground pin must be firmly
connected to an electrical ground (safety ground) terminal at the power outlet. Any interruption of
the protective (grounding) conductor or disconnection of the protective earth terminal will cause a
potential shock hazard that could result in personal injury.

See the user's guide or operator's manual for information about line-fuse replacement. Some
instruments contain an internal fuse, which is not user accessible.

Do not operate the instrument in the presence of flammable gases or fumes.

Only qualified, service-trained personnel who are aware of the hazards involved should remove
instrument covers. Always disconnect the power cable and any external circuits before removing the
instrument cover.

Clean the outside of the instrument with a soft, lint-free, slightly dampened cloth. Do not use
detergent or chemical solvents.

Do not install substitute parts or perform any unauthorized modification to the product. Return the
product to a Keysight Sales and Service Office for service and repair to ensure that safety features
are maintained.

Instruments that appear damaged or defective should be made inoperative and secured against
unintended operation until they can be repaired by qualified service personnel.

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice,
or the like that, if not correctly performed or adhered to, could result in damage to the
product or loss of important data. Do not proceed beyond a CAUTION notice until the
indicated conditions are fully understood and met.

A WARNING notice denotes a hazard. It calls attention to an operating procedure,
practice, or the like that, if not correctly performed or adhered to, could result in
personal injury or death. Do not proceed beyond a WARNING notice until the indicated
conditions are fully understood and met.
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Safety Symbols

Table 1 Safety Symbol

Symbol Description

Direct current

Alternating current

Both direct and alternating current

cl ¢

Three phase alternating current

P

Three phase alternating current

Earth ground terminal

Protective earth ground terminal

Frame or chassis ground terminal

Terminal is at earth potential

Equipotentiality

Neutral conductor on permanently
installed equipment

Line conductor on permanently installed
equipment

On (mains supply)

Off (mains supply)

Stand by (mains supply). The instrument is
not completely disconnected from the
mains supply when the power switch is in
the standby position

In position of a bi-stable push switch

IGO0~ EHFI®IS
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Symbol Description

Out position of a bi-stable push switch

Equipment protected throughout by
DOUBLE INSULATION or REINFORCED
INSULATION

Caution, refer to accompanying
documentation

Caution, risk of electric shock

Do not apply around or remove from
HAZARDOUS LIVE conductors

Application around and removal from
HAZARDOUS LIVE conductors is
permitted

Caution, hot surface

lonizing radiation

Indicates that antistatic precautions
should be taken

PS>0

CATI IEC Measurement Category |
CAT Il Measurement Category Il
CAT Il Measurement Category Il
CAT IV Measurement Category IV
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Compliance and Environmental Information

Table 2 Compliance and Environmental Information

Safety Symbol Description

CSA is the Canadian certification mark to demonstrate compliance with the Safety
(S © requirements.

The C-tick mark is a registered trademark of the Spectrum Management Agency of
Australia. This signifies compliance with the Australia EMC Framework regulations
under the terms of the Radio Communication Act of 1992.

ISM GRP-1A classification according to the international EMC standard.
ICES/NMB-001 compliance marking to the Canadian EMC standard.

CE compliance marking to the EU Safety and EMC Directives.

KC certification mark to demonstrate compliance with the South Korean EMC

[E requirements.

ECC-REM-ATI
TR South Korean Class A EMC declaration
This equipment is Class A suitable for professional use and is for use in
electromagnetic environments outside of the home.

This product complies with the WEEE Directive (2002/96/EC) marking requirements.

The affixed label indicates that you must not discard this electrical/ electronic

product in domestic household waste.

Product Category: With reference to the equipment types in WEEE Directive Annex |,

this product is classified as a “Monitoring and Control instrumentation product”.
[ Do not dispose in household waste.

To return unwanted products, contact your local Keysight office, or see

www.keysight.com/environment/product/ for more information.
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U4301A/B PCle Gen3 Analyzer—At a Glance

See

The U4301A/B PCle Gen3 analyzer lets you capture and decode PCl Express 3.0 (PCle 3.0) data and
view it in a Protocol Viewer window. The protocol analyzer supports all PCle 3.0 speeds, including 2.5
GT/s (Gen1) and 5.0 GT/s (Gen2) through PCle 8 GT/s (Gen3), and it supports link widths from x1 to
x16.

The U4301B PCle Gen3 analyzer is a module installed in a Keysight AXle chassis (for example, the
M9502A 2 slot chassis). The U4301A PCle Gen3 analyzer module can be installed in a Keysight
Digital Test Console chassis (for example, the U4002A portable 2-slot chassis) or a Keysight AXle
chassis (for example, the M9502A 2 slot chassis).

When a controller PC is connected to a Keysight chassis via an external PCle interface and cable, the
Keysight Logic and Protocol Analyzer application (running on the controller PC) lets you connect to
the chassis, set up U4301A/B PCle Gen3 analyzer data captures, and perform analysis.

The U4301A/B PCle Gen3 analyzer provides:

Effective presentation of protocol interactions from physical layer to transaction layer:
Industry standard spreadsheet format protocol viewer with:
Highlighting by packet type or direction.
Easy flow columns to better understand the stimulus and response nature of the protocols.

Context sensitive columns to show only the relevant information, minimizing the need to
scroll horizontally.

Flexible GUI configuration to meet debug needs, with pre-defined GUI layouts for Link Training
debug, Config accesses, and general I/0.
Simple and powerful state-based triggering:
New simple trigger mode makes it easy to setup single event triggers.
Powerful state-based triggering including:
Four states supported in trigger sequencer.
Triggering on patterns (ordered set patterns or packet types).
Internal counters and timers.
Triggering on an ordered set on a specific lane.
External trigger in/out.

Powerful hardware features ensure capture of important transition events:

Dual phase lock loops (PLLs) per direction ensuring that the analyzer will lock on speed change
events quickly and not miss any critical data.

Large 4 GB of capture buffer per module (up to 8 GB of capture for x16 analyzer), for long
recording sessions.

PCle Gen1 x4 link to the host PC, provides up to 10 Gbps of data download.
LEDs to show lane status and speed for fast understanding of current link status.

"Using the PCle Gen3 Analyzer" on page 8

Keysight U4301 PCle Gen3 Analyzer User’s Guide



Using the PCle Gen3 Analyzer

For an overview and list of features, see: "U4301A/B PCle Gen3 Analyzer—At a Glance" on page 7
Chapter 1, "Hardware and Software Installation" on page 13
Chapter 2, "Probing Options for PCle Gen3" on page 15
Chapter 3, "Specifying the Connection Setup" on page 17
Chapter 4, "Setting the Capture Options" on page 29
Chapter 5, "Tuning the Analyzer for a Specific DUT" on page 33
Chapter 6, "Manually Adjusting the Equalizing Snoop Probe (ESP) Settings" on page 49
Chapter 7, "Setting Up Triggers" on page 51
Chapter 8, "Running/Stopping Captures" on page 61
Chapter 9, "Viewing PCle Gen3 Packets and Traffic Overview" on page 63
Chapter 10, "Viewing and Interpreting Equalization Summary Data" on page 83
Chapter 11, "Configuring and Computing Decoded Transactions" on page 91
Chapter 12, "Viewing Offline Performance Summary" on page 131

See Also - U4305 PCle Gen3 exerciser documentation.
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Keysight U4301 PCle Gen3 Analyzer
User’s Guide

Hardware and Software In-
stallation

You install the U4301B PCle Gen3 analyzer in a Keysight AXle chassis (for example, the M9502A 2
slot chassis). The U4301A PCle Gen3 analyzer module can be installed in a Keysight Digital Test
Console chassis (for example, the U4002A portable 2-slot chassis) or a Keysight AXle chassis (for
example, the M9502A 2 slot chassis).

The Keysight chassis is connected to a controller PC via a PCI Express interface and a cable.

The controller PC runs the Keysight Logic and Protocol Analyzer application software which lets you
set up the U4301A/B PCle Gen3 analyzer, specify triggers and other data capture options, capture
data, and analyze the captured data using the Protocol Viewer window.

See the ~ “Keysight AXle based Logic Analysis and Protocol Test Mod ules Installation Guide” for information
on:

Installing the U4301A/B PCle Gen3 analyzer module into a Keysight AXle chassis.

Connecting the AXle chassis to a controller PC via the PCI Express interface.

Installing the Keysight Logic and Protocol Analyzer software on the controller PC.

KEYSIGHT
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Hardware and Software Installation
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Keysight U4301 PCle Gen3 Analyzer

User’s Guide

2 Probing Options for PCle
Gen3

The currently available options for probing a PCle Gen3 device under test (DUT) are:
U4321A solid slot interposer
U4322A midbus 3.0 probe
U4324A PCle Gen3 Flying Lead probe
U4328A M.2 (M-key) Interposer

Details about these probing options (and other PCle Gen3 tools) can be found in the » "PCI Express
Gen3 Hardware and Probing Guide".

KEYSIGHT
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2 Probing Options for PCle Gen3
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Keysight U4301 PCle Gen3 Analyzer
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Specitying the Connection
Setup

Once you have connected the U4301A/B module, probing hardware, and DUT in the required
configuration based on your probing requirements, the next step is to configure the connection setup
for the U4301A/B module in the Keysight Logic and Protocol Analyzer application. You use the
Connection Setup tab of the analyzer's Setup dialog to configure the connection setup.

The connection setup details that you specify in this tab tells the Logic and Protocol Analyzer
software how the U4301A/B module is connected to the DUT in terms such as the probing option
used, the direction of data capture (upstream, downstream, or bidirectional), and the link width
needed. For instance, if you have connected the U4301A/B module hardware to the DUT using the
U4321A Solid Slot Interposer card in a x8 bidirectional setup, then you need to select the U4321 Slot
Interposer Both Dir x8 as the Footprint option, 1 Bidirectional upto x8 as the Link type, and x8 as the Link
Width in the Connection Setup tab to reflect the hardware setup that you have configured.

For details on how to set up the hardware and probing connections between the
U4301A/B module and DUT, refer to PCI Express Gen3 Hardware and Probing
Guide.

For details on how to set up the chassis, U4301A/B module, and host PC, refer
to the AXle based Logic Analysis and Protocol Test Modules Installation Guide.

These guides are installed with the Logic and Protocol Analyzer software and
can also be downloaded from www.keysight.com.

Probing options

While specifying the connection setup, one of the key requirements is to select the probing option
that you have used with the U4301A/B module to probe the DUT and the data capture direction in
which you have configured the hardware setup.
Broadly, there are the following probing options available with the U4301A/B module:

U4321A Solid Slot Interposer card

U4322A Soft Touch Midbus 3.0 probe

U4324A PCle Gen3 Flying Lead probe

U4328A M.2 (M-key) Interposer

PCle Gen?2 probes with the U4317A adapter. This adapter is used for conversion between the PCle
Gen2 probes and U4301A/B PCle Gen3 Analyzer module. The PCle Gen2 probes supported are:

Nb5315A Solid Slot Interposer for PCle Gen?2

N4241A straight, N4242A swizzled, and N4243A split cable Soft Touch Midbus 2.0 probe for
PCle Gen2

N5328A Half Size Midbus probe
N4241F/Z Flying Lead probe for PCle Gen2

KEYSIGHT

TECHNOLOGIES



Specifying the Connection Setup

For each of the above probing types, different options are available in the Connection Setup tab
reflecting the data direction (upstream, downstream, or bidirectional). Upstream is the data direction
towards the root complex. Downstream is the data direction away from the root complex. Based on
your probing setup and the data capture direction in which you have configured the hardware setup,
you need to select an appropriate probing option in the Connection Setup tab.

U4321A Solid Slot Interposer Card

When used with a U4321A solid slot interposer card, one U4301A/B module can probe in the
upstream (x1-x16), downstream (x1-x16), or bidirectional (x1-x8) way.

If you need to probe in both upstream as well downstream directions with a x16 link width, you need
two U4301A/B Analyzer modules and a U4321A SSI card. To reflect such a hardware setup in the
Connection Setup tab of the Logic Analyzer application, you need to select U43271A Slot Interposer
Upstream as the probing option for one of the U4301A/B modules and U4321A Slot Interposer
Downstream as the probing option for the other U4301A/B module.

if you have connected the U4301A/B module hardware to the DUT using the U4321A Solid Slot
Interposer card in a x8 bidirectional setup, then you need to select the U4321 Slot Interposer Both
Dir x8 as the probing option.

U4322A Soft Touch Midbus 3.0 probe

The U4322A midbus 3.0 probes require footprints to be designed into the device under test. Each
probe requires its own footprint, and there are basically two variations:

Bidirectional — where half the footprint pins are for the upstream data and the other half are for
the downstream data.

Unidirectional — where all the pins on the footprint are for the data going in the same direction.
Reversed refers to optional lane reversal which is supported for upstream ports.

Based on how you have designed the footprint for the probe, you need to select an appropriate
probing option in the Connection Setup tab. For instance, if you have configured a x4 bidirectional
setup using a U4322A midbus probe, then you need to select U4322A Bidirectional Full as the
Footprint, 1 Bidirectional upto x8 as the Link type, and x4 as the Link Width in the Connection Setup
tab.

U4324A PCle Gen 3 Flying Lead probe

When used with a U4324A Flying Lead probe, one U4301A/B module can probe in the upstream
(x1-x16), downstream (x1-x16), or bidirectional (x1-x8) way. For x1-x8 bidirectional link type, you can
use the U4324A Flying Lead probes in a straight or a swizzled configuration.

If you need to probe in both upstream as well downstream directions with a x16 link width, you need
two U4301A/B Analyzer modules and eight U4324A Flying Lead probes. To reflect such a hardware
setup in the Connection Setup tab of the Logic Analyzer application, you need to select the U4324A
Flying Lead Probe as the probing option and Unidirectional as the link type for both the U4301A/B
modules.

If you have connected the U4324A Flying Lead probes in a x1 to x8 bidirectional straight setup, then
you need to select the U4324A Flying Lead Probe as the probing option and Bidirectional as the link

type.

If you have set up a swizzled x1 to x8 bidirectional configuration using the U4324A Flying Lead
probes, then you need to select the U4324A Flying Lead Probe Bi Swizzled as the probing option and
Bidirectional as the link type.

Keysight U4301 PCle Gen3 Analyzer User’s Guide



Specifying the Connection Setup 3

U4328A M.2 (M-key) Interposer

When used with a U4328A M.2 (M-key) Interposer, one U4301A/B module can probe a x1, x2, or x4
bidirectional PCle link configuration (as per the M.2 specifications).

To reflect such a probing hardware setup in the Connection Setup tab of the Logic and Protocol
Analyzer application, you need to select the U4328A M.2 (M-key) Interposer as the probing option
and Bidirectional as the link type for the U4301A/B module. The link width can be selected as x1, x2,
or X4.

To specify the connection setup

1 In the Keysight Logic and PRotocol Analyzer application's Overview window, from the PCle
analyzer module's drop-down menu, select Setup>Setup....

£2 Keysight Logic and Protocol Analyzer (LPA) - Unnamed Configuration - [Overview]
Elfile Edit View Setup Tools Markers Run/Stop Owerview Window Help

D= E | | |
H i to (M2 = —
Modules | Windows
B Fcie-00s | B3 Protocol 1
5 Viewer-1
O |
" | 5 MWew Probe (]
Mew Tool 4
MNew Window 4

Disable... Ig Irigger..
Rename...

2 From the Footprint Listbox, select the type of probing that you have set up between the U4301A/B
Analyzer module and DUT. For each of the supported four probing types, different probing
options are available in the Footprints listbox based on the data direction (upstream,
downstream, or bidirectional). Based on your probing setup and the link type needed, select an
appropriate probing option from the Footprint listbox. Refer to the “Probing options" on page 17
to know more about these options.
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3 Specifying the Connection Setup

& Setup
Connection Setup | Capture Setup | Phy Tuning
r Module
Link(s) Footprint

@ PCle-005  |U4321A Slot Interposer Both Dir x8 "J
U4321A Slot Interposer Both Dir x8 -

: I: J43224 Unidirectional Full
U43224 Unidirectional Full Reversed -

Link Naming and Lf| 43724 Bidirectional Full
Nams 43244 Flying Lead Probe
= All PCI-Express U43244 Flying Lead Probe Bi Swizzled
= PCle-003 | U4328A M.2 M-Key Interposer
PCle-007 M4241A+ 43174 Gen2 Bidirectional
PCTe-007 MA241A+U43174 GenZ Unidirectional
MN4241F/Z+U4317A Flying Lead Probe Uni |2
M4241F/Z+U4317A Flying Lead Probe Bi
M42424+ 043174 Gend Upstream
M42428+U43174 Gen2 Downstream
MNA243A+U43174 Gen2 Upstream
M42434+U4317A Gen2 Downstream
M53154+U43174 S51 Upstream
M53154+U43174 551 Downstream | 8]

M53284A+U4317A Gen2 1/2 Straight
MSAZ2EA AT TA Gan? 142 Altarnate

For more information on probing setups, click Connection diagram... or refer to the ~ "PCI Express
Gen3 Hardware and Probing Guide".

If you have installed multiple U4301A/B modules in the chassis, all these modules are listed in
the Module section of the tab. You need to select the probing option individually for these

modules.
B e
| Connection Setup Cavmre Setup l -Fih;,-‘-[umn;
Madule
Limefs) Faatprint Link Type Link Width Help Type Chas
© PCle-005 |U43214 Slot interposer Upstn | |1 Unidirectionaluptoxis *| [x1 =]  [lConnection disgam..| 4301 PCleGen3 Analyzer 0
© POe00s  |U4321ASiotinterposer Dowr * | |1 Unidirectionsluptox6 »| sl =|  |lWiConnection disgram..| L4301 PCieGen3 Analyzer 0
- m

3 Specify the link type.
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Specifying the Connection Setup 3

P

Connection Setup | Capture Setup | Phy Tuning
~Module

Link(s) Footprint Link Type L

@ PCle-005 [U-‘1321A Slot Interposer Both Dirx8 = | 1 Unidirectional up to x16 ~

T = 1 Unidirectional up to x16
1 Bidirechional up to x8 |

r Link Maming and Lane Setup

MName Clock Source  Master Lane  Lane Reversal Lane Polarity
= All PCI-Express Links
=l PCle-005 - -
PCle-005 Internal "J F‘ [fo "] [ Auto lNo Lanes Irm

The Link Type refers to the type of link that you want to create between the U4301A/B module and
DUT. You can select the 1 Unidirectional up to x16 link type if you want the U4301A/B module to
probe and capture data in only one direction (upstream or downstream). In the Unidirectional link
type, the U4301A/B module can support a unidirectional link with upto 16 channels in the same
direction. You can select the 1 Bidirectional up to x8 link type if you want the same U4301A/B
module to probe and capture data in both directions (upstream as well as downstream). In the
bidirectional link type, the U4301A/B module can support one bidirectional link with upto eight
channels for each direction. When you select the bidirectional link type, two sub-links are created
for the two directions. You can set the link attributes such as clock source, master lane, and lane
ordering separately for these two sub-links. These attributes are available in the Link Naming and
Lane Setup section.

The following screen displays the sub-links of a x8 bidirectional link. These sub-links have been
renamed on the basis of the direction these represent.

B s el
Connectian Setup | Capture Setup | Phy Tuning |
r Module
! Link{s) Footprint Link Type Link Width Help 1
© #Cle005 |W4321ASiotinterposerBoth D » | |1 Bidirectionaluptosd »|  [xb.v|  |FiConnection disgram..| 4301 PCle
e " J L
r Link Naming and Lane Setup
Name Clock Source  Master Lane  Lane Reversal Lane Polarity Inversion Lane Qrdering
= PCle-005 e B o
PCle-005:Up External2 =| |0 = | |Uff - | Auto ]?"c Lanes lmverted d
s — 1 — -
Plle-005:Down Extemal2 v | |0 7| {off > Auto. | No Lanes Inverted - [Defauid

4

If you have installed multiple U4301A/B modules in the chassis, all these modules are listed in
the Module section of the tab. You need to select the link type individually for these modules.

Select the link wid th.
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Module
Link(s} Foatprint Link Type Link Width Help
@ PCie-005 [U4321A SiotinterposerBott | |1 Bidirectional up tox8 * | ; {siConnection disgram...
| . 2 -
ud
Link Naming and Lane Setup ¥8
[ Mame Clock Source  Master Lane  Lane Reversal Y15 ity Inversion Lar

Select the link width that matches the negotiated link width of transmitter and receiver.

If you select the Link Type as 1 Bidirectional upto x8, then you can select the Link Width from x1 to
x8. The x16 option is disabled in this case because a U4301A/B Analyzer module can probe and
capture data in both directions with upto eight channels in each direction.

5 Verify the connection:
a Click Connection diagram....

Connection Setup | Capture Setup | Phy Tuning |
Module

b Use the Connection Diagram dialog to verify that your connection setup specification matches
the actual device under test connection.
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Specifying the Connection Setup

Podl Pod2 Pod 3 Poda

Upstream
Odd Even Odd Even

Downstream

¢ Close the Connection Diagram dialog.
6 Select the clock source:
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& Setup

Connection Setup | Capture Setup | Phy Tuning |

~ Module

Link(s) Footprint Link Type Link Wi

@ PCle-005 |U43224 Unidirection ¥| |1 Unidirectional u |  [x16 -

4 | m

r Link MNaming and Lane Setup

Mame Clock Source Master Lane  Lane Reversal
E PCle-0035
PCle-005 P [E| off = |
Internal
External 2
External 3
External 4

Internal — selects an internal clock source. You should select Internal if the data rate is in the
range of 2.5 Gbps or 5 Gbps +/-50 ppm. Note that there is no input clock in this mode.

External 1/2/3/4 — selects an external clock source. You should select External if the device
under test uses SSC or the data rate is in the range of 2.5 Gbps +/-300 ppm (+0% / -0.5% if
using SSC). The clock rate for external mode should be between 100 MHz +/-300 ppm (+0% /
-0.5% if using SSC).

Some important points about external reference clock selection

If you plan to use an external clock source, then you must ensure that the reference clock from
the DUT is available when you:

select External as the Clock Source in the Setup dialog and apply the selection by clicking
Apply or OK.

or load a configuration file that specifies the use of the external clock source.

If the reference clock from the DUT is not available to Analyzer when you apply the external
clock source selection, the Analyzer’s internal PLL may not be able to attain the initial lock with
the DUT’s reference clock resulting in an erratic behavior. Just making the DUT’s reference
clock available at this point does not establish the lock with the reference clock. In such a
situation, you can re-establish the lock with the DUT’s reference clock by performing the
following steps:

i Ensure that the reference clock of the DUT is available.
i Then select Internal as the Clock Source in the Setup dialog and click Apply.
iii Finally, select External as the Clock Source in the Setup dialog and click Apply.
Once the initial lock is established, it is maintained. You need not re-establish the lock with the

reference clock on subsequent availability/unavailability of the reference clock in the event of
DUT power off/on or on any further changes to the Setup dialog except for Clock Source or Link
Type.
7 Select the master lane. You can select any lane as the master lane from the lanes displayed in the
Master Lane listbox. The lanes are displayed as per the selected link width. The lane that you
select as the master lane is considered the lane for capturing the ordered sets.
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Connection Setup | Capture Setup i Phy Tuning I
r Module

Link(s) Footprint Link Type Link Width

@ PCle-005 [U4322A Unidirection v| (1 Unidirectionaluy »| [x16 =] |

| m

r Link Naming and Lane Setup
Name Clock Source  Master Lane Lane Reversal

2 All PCl-Express Links
= PCle-005
lofi x]  [Auwe

PCle-005 External 1 =

8 Specify whether lane reversal is on or off.

Connection Setup | Capture Setup I Phy Tuning |

~Module

Linkis) Footprint Link Type Link Wi

@ PCle-005 |U4322A Unidirection ¥| |1 Unidirectional uj | [x16

4 | 1

r Link Maming and Lane Setup

Mame Clock Source Master Lane  Lane Reversal
= PCle-005
PCle-005 |External 1 | (3 +| Off ~ |
Cn

9 Specify any lane polarity inversion:
a Click Auto or Manual to toggle between the types of polarity inversion specification.

When Auto is selected, the polarity of the lanes is set automatically during the initial link
training.
b When manual selection is chosen, select the lanes that are inverted.
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Connection Setup [Clmsmapt Phy Tuning |

rModule

Link{s} Footprint Link Type

Link Width Help

@ rae00s |ue3z2aUnidirection »|  [1Unidirectionaluy »|  [x16 |  [TicConnection diogl U430:

Link Naming and Lane Setup

= All PCl-Express Links
= PCle-005

MNams Clock Source  Master Lane  Lane Reversal

10 The Lane Ordering option lets you perform the ordering of the physical lanes of the link with the
logical lanes. You can either retain the Default lane ordering which means Lane O of the link maps
to logical Lane 0 and so on. If you want to map Lane O of the link to some other Lane, then select
Custom option from Lane Ordering and click Specify to display the Custom Lane Ordering dialog
box. In this dialog box, select the lane with which you want to map Lane 0. The number of lanes

displayed for lane ordering depend on the selected link width. For example, if the link width is
selected as x4, then the Lane O, 1, 2, and 3 are available for lane ordering.
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o
Connection Setup | Capture Setup | Py Tuning |
~Madule
[ Linkis) Foctprint Link Type Link Width Help Type  Chasss
© Fuie00s 43224 Uniinection 7| |1 Unidieectionaluy v V4301 PCleGen3 & 0
vl m
Link Marming and Lane Setup
Name Clotk Source  Master Lane  Lane Reversal Lane Polurity Inversion Lane Ordering
S Al PC-Express Links _ —
B pCleds | g B
AERE B | ane Reordering Mote | Cstom]spect
@ Simple (Recommended) © Advanced
Lane 0 maps to Lane g =
Lane 1 maps to Lane 1 =
I..anﬂmupnulme
Lane 3 maps toLane 3 +
I..anedmapsw!.me
msmmm
msm:pmm
Lane 7 maps to Lane 7 =
| [Lox ] [ Hep |
| Rnasrre Akl Fobele Diedets Foloe

Keysight U4301 PCle Gen3 Analyzer User’s Guide



3

28

Specifying the Connection Setup

Keysight U4301 PCle Gen3 Analyzer User’s Guide



KEYSIGHT

TECHNOLOGIES

Keysight U4301 PCle Gen3 Analyzer
User’s Guide

Setting the Capture Options

The Capture Setup tab in the PCle Gen3 analyzer's Setup dialog lets you set basic capture options.

1 Inthe Keysight Logic and Protocol Analyzer application's Overview window, from the PCle Gen3
analyzer module's drop-down menu, select Setup>Setup....

ogic -

@Eile Edit View Setup Tools Markers Bun/Stop Overview Window Help
eS| M hd  MTH QRN |4 %

| o]

Modules | Windows
Slots
B Fcie-005 ‘ oo
5 Viewer-1
== oEe
" | g Mew Probe bl
Mew Tool »
Mew Window »
Disable... \Trig Trigger...
Rename...
Figure 1 Setup > Setup

2 Click the Capture Setup tab.
3 Inthe Capture Setup tab, select the appropriate options.



Setting the Capture Options

i sep =
[ Connection Setup | Capture Setup | Phy Tuning |
el Al PCl-Express Links | - Caphure Setup
Ple-005 R
Capture Memory Depth {1M8 x

Capture Link Speed Genl O Gen2 O Gen3 ® Auto (Gen3-> |Genl ¥/ has priasity) [3]

=ioii=

Descrambler (Genl / Gend) @ Enabled () Disabled
L0s Testing " Enabled @ Disabled

Ctris Click to select more than one link. Lapply | [ ok | [concel| | Hetp

Figure 2 Capture Setup

Field Description

Capture Memory Depth Lets you select the trace memory depth. Deeper traces capture more activity but take longer to save and
process.
Capture Link Speed Lets you specify the link speed of the data to be captured:

Gen 1 — select this when capturing data on 2.5 Gbps links.
Gen 2 — select this when capturing data on 5 Gbps links.
Gen 3 — select this when capturing data on 8 Gbps links.
Auto - select this option when testing link speed switching scenarios. On selecting this option,
analyzer automatically detects the link speed change and accordingly starts capturing data based
on the changed link speed. The Auto option also has a drop-down listbox displayed with it. From
this listbox, you can select either Gen1 or Gen2. If you select Gen1 from this listbox, then analyzer
prioritizes and captures the Gen 1 ordered sets while switching speed from Gen 3. If you select
Gen2 from this listbox, then analyzer prioritizes and captures the Gen 2 ordered sets while
switching speed from Gen 3.
Based on the selected link speed, the speed LED of the Analyzer pod on which the logical Lane 0 is
present will glow. The following color coding is used to interpret the status of the speed LED.
= Off - This means that the system is not configured.
= Red - This means that the link speed is not detected or not configured.
= Yellow - This means that the link speed is 2.5 Gb/s.
= Green - This means that the link speed is 5 Gb/s.
= Blue - This means that the link speed is 8 Gb/s.
If you selected a fixed speed (Gen1, Gen2, or Gen3), then the speed LED will glow according to the
selected speed. If you selected the Auto speed option, then the speed LED will glow according to the
detected speed.

Descrambler (Gen1 / Gen2) Tells the analyzer whether the descrambler algorithm is necessary:

Enabled — activates the descrambler algorithm. This algorithm generates the descrambled packet
stream from an incoming scrambled packet stream.
Disabled — deactivates the descrambler algorithm. Select this option when the DUT is
transmitting the non-scrambled data.

Garbage data is displayed if this is set incorrectly.

LOs Testing Lets you select whether or not the U4301A/B module will capture packets in the LOs state.

= Enabled - When you enable the LOs Testing option, the U4301A/B module captures packets in the
LOs state and the power management testing capabilities are enabled and enhanced in terms of :
improvement in locking time
faster data capture while coming out of the electrical idle
= Disabled - When you disable the LOs Testing option, the power management testing capabilities are
available but not enhanced

30
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When testing LOs/L1, ensure that you:
NOTE g ! y
- set manual lane polarity.

- select a fixed capture link speed instead of the Auto speed.
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Tuning the Analyzer for a Specific DUT

PCle Gen3 Tuning Overview

34

What is Tuning

Tuning is the process of adjusting Keysight's probing system to remove the effects of different driving
silicon, termination silicon (or other termination schemes), imperfect transmission paths, and the fact
that the probes may not be in the "ideal" location for receiving a high-speed signal (that is, at the end
of the transmission path).

Furthermore, a PCle Gen3 system will negotiate its own TX Linear Equalization, and you would like to
have the largest eye possible. Tuning does not affect either the transmitter or the receiver; it is used
only to increase the eye as seen by the U4301 Analyzer module. This process involves getting the
system/device-under-test to a stable PCle Gen3 transmission state which the analyzer then
optimizes its own equalizations settings for.

How Tuning Works

For tuning, you:
either use a predefined physical layer tuning (.ptu) file with default tuning values appropriate for
your probing and connection setup.
or create a physical layer tuning (.ptu) file..

The .ptu file contains the information necessary to adjust the probing system for a specific
device-under-test (DUT). At the 8 Gbps speed, you then need to load this .ptu file into the U4301
Analyzer module’s software to have the best possible eye at the Analyzer.

It is recommended that you first use a predefined .ptu file with default tuning values. If the default
tuning values do not provide robust and clean tracing results, you should consider creating your own
.ptu file.

From this release of the Keysight PCle Gen3 software, you can create or fine tune a .ptu file using the
Keysight Logic and Protocol Analyzer GUI.

When to Perform Tuning

You should only perform tuning when all of the following conditions are met:

Poor trace quality which may include red packets, triggers on “Loss of Sync” or “Channel
Bonding”.

No Recovery cycles (that is, cannot Trigger on “Any TS”) on the target.
When no existing .ptu files are able to provide robust tracing.

Default and User Defined .ptu Files

A set of default tuning (.ptu) files are provided with the Keysight Logic and Protocol Analyzer
software. These tuning files contain the probe defaults to compensate for the signal impairments
associated with the probe. These files are named on the basis of the probe type for which these are
created. Based on the probe type you are using, one of these files is used and if the trace quality is
clean, you do not need to tune further by creating your own .ptu file. These default .ptu files work fine
and support robust tracing in situations where the targets have margin. The following screen displays
the location of these default ptu files.
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Tuning the Analyzer for a Specific DUT

MName

5

default_143214_SlotInkerpaser_R¥_2Card.pru
default_1143214_SlotInterposer_Tk_2Card. pu
default_43224 Midbus_Bi_Full.ptu
default_U4322a8_Midbus_Uni_Full pu
default_43224_Midbus_ni_Full_Reversed.ptu

default_IU43244_Flving_Lead_Probe,ptu

However, if the default .ptu file does not serve the purpose and you find the trace quality to be poor,
you can create your own .ptu file with your specific parameters and use it in the Logic and Protocol
Analyzer GUI to perform tuning. You can create a .ptu file using the Logic and Protocol Analyzer GUI.

Tuning - Broad steps

The following picture illustrates the broad steps involved in the tuning flow.
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In the Logic and Protocol
Use the probe’s default L Analyzer GUI, select
tuning values defaulttuning values

4

Check the trace guality

End
{Tuning not nesded)

Prepare the system for

tuning
¥
Selectam existing .ptu file
or create a .ptu file for —— Using the Logicand Protocol Analyzer
tuning Ul

:

Check the trace guality after
tuning

Using the Logicand Protocol Analyzer
Fine tune the ptu file — U]

End

All these steps are described in detail in the topics that follow.

Tuning Method

While creating a .ptu file using the Logic and Protocol Analyzer GUI, the AnalogTune tuning method
is used. This method minimizes the deviations of the observed Vertical Eye characteristics versus the
desired Vertical Eye characteristics. From the DUT participation perspective, this method only
requires that the DUT must not have transitions to or from Electrical Idle at 8Gbps.
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Preparing the U4301A/B Module and DUT for Tuning

Perform these steps to prepare the setup for tuning:

1 Connect the U4301A/B Analyzer module to the DUT. Refer to the PCI Express Gen3 Hardware
and Probing Guide to know how to connect Analyzer to the DUT based on your specific probing
Situation.

The following Keysight probing options are supported for use with the Analyzer module.

U4321A solid slot interposer.

Note that there are four connections on this interposer; the upper two are for the "To
Upstream" path (assuming that the card plugged into the top connector of the interposer is
the downstream side). The lower two connectors are for the "to Downstream" direction.

U4322A soft touch midbus 3.0 probe.

Note that there are several supported footprints that define what lanes are at specific physical
connections.

U4324A PCle Gen3 flying lead probe.

Each of these probes provides support for probing one to four channels of a PCle link making it
a total of 16 channels probing support for a set of four probes.

2 If the Resource Bus connector is connecting two Analyzer modules together (the connector at
the left of the modules), remove the Resource Bus Connector and do the tuning of one module at
atime.

After you have tuned, you can reconnect the Resource Bus Connector without affecting the
tuning.

3 Your DUT must enter LO at Gen3 speed (8 Gbps).
The DUT must not transition to or from Electrical Idle at 8Gbps and its TXEQ should have
stabilized before tuning. If the DUT is experiencing Recovery cycles, it is likely that it will change
its TXEQ to achieve stability.

5 Ensure that the connection settings such as the number of lanes in use and the lanes inverted by
the transmitter are correctly set up in the Connection Setup tab of the U4301A/B module’s Setup

dialog box before starting the tuning. These settings are used in the tuning process and incorrect
settings can result in incorrect tuning.
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Creating a Physical Layer Tuning File

After you have prepared your system for tuning and configured the connection setup for the
U4301A/B module, you can create a physical layer tuning (.ptu) file. This file stores the information
about the test setup (lane inversions, number of lanes, etc) and the tuning parameters that were
discovered during tuning. You use this file in the PCle Analyzer setup in the Logic and Protocol
Analyzer GUI to tune the system.

To create a physical layer tuning file

Perform these steps on the host PC that is physically connected to the U4301 Analyzer module.
1 Exit the Keysight Logic and Protocol Analyzer application if it is currently active.
2 Start the Keysight Logic and Protocol Analyzer application.

This is done to ensure that all the default settings in the analyzer software are used."*

3 Inthe Logic and Protocol Analyzer GUI's Overview window, select Setup>Setup.... from the PCle
analyzer module's drop-down menu to access its Setup dialog box.

egic ac - -
@Eile Edit View Setup Tools Markers Bun/Stop Overview Window Help

DEEE (M had |« TH|QR | [z E |
J_ -tuuz=—|

Maodules Windows

S Protocol 1

2 Viewer-1

DR -‘ () _Stow_]

‘ Mew Probe L
Mew Tool L4
Mew Window

Tria Tri
Disable... |Iig Trigger

Rename...

Slot 5

b

4 Click the Phy Tuning tab of the Setup dialog box.
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Connection Setup | Capture Setup | Phy Tuning |

| |'\l'!!! H.

~Tuning File 5election
1 Use Default Tuning values
@ Use Specified Tuning File

~Select PCI Express Phy Tuning file {.ptu) to use

E [E:-Phﬂun?rgﬁle; speuﬁed ii-‘:_equ;réd_fﬁr_ﬁéns speedsl[ kg |j [HewTum...J
{Des:ﬂpﬂnn

[Tuning Specification

5 The left pane of the Phy Tuning tab displays a list of the currently available PCle Analyzer
modules. From this list, select the module which you want to tune.

6 Select the Use Specified Tuning File option from the Tuning File Selection section.
7 Click the New Tune... button to open the Tuning File Creation dialog box.
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Tuning File Creation

-Tuning Setup

Before tuning, DUT must be in stable LO at 8.0 GT/s (no transitions to or frc

Standard Tune j

Tuning Mode
Output PTU File

Perform Tune

Tuning Progress

Current Test Progress |

Tuning Log

Ok Cancel | E

8 Select one of the following two options from the Tuning Mode listbox.

Standard Tune - This option performs an Analog Tune followed by a fine tune. In this option, the
number of iterations for a tuning test completion are more than the number of iterations in the
Quick Tune option. Standard Tune, therefore takes more time than Quick Tune.

Quick Tune - This option also performs an Analog Tune followed by a fine tune. However, the
number of iterations for a test are lesser making this option suitable for performing tuning
quickly.

The third option - Fine Tune Previous Results in the Tuning Mode listbox is meant
for fine tuning a previously created .ptu file.

9 Click the J| icon displayed with the Output PTU File field to browse and specify the name and
location for the .ptu file.
10 Click Perform Tune.

The tuning process starts. The Tuning Log section displays the results of the tuning process run
operation. If the tuning process completes successfully, the specified .ptu file gets created. A
tuning log file is also created with the same name and location as the tuning file.
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Tuning File Creation

5

- Tuning Setup

Tuning Mode  |EellElnRITNE ~

Cancel |

Tuning Progress || {INENNRRNERRNRRERRRERRNRRNRRRERIRRRRRIRININ

Current Test Progress [(NENEEEEEEENNENRNNENNNNNENEE

Before tuning, DUT must be in stable L0 at 8.0 GT/s (no transitions to or from electric

Output PTU File  E:\Tuning'x16uni_StandardTune.ptu |

-Tuning Log

Writing lcg teo E:M\Tuninghxléuni StandardTune.log a|
Creating ph}rsical tuning file E:"\Tun:i_ng"-.,:-clGuni_StandardTune.p'l
Initial tuning file C:\Program Files‘Keysight Technologiesilogic
Enzlcg Tune started

Loading FEGA

FPER loaded

Initial Perfcrmance Test completed

Starting Glokal Search Phase

Lans o | &3 | 3 32 5 &3 S | met 1.24
Lans 1 | &3 | 3 32 5 &3 S | met 1.27
Lans 2 | &3 ] 3 32 5 &3 S | met 1.22
Lans 2| &3 ] 5 32 5 &3 S | met 1.25
Lans 4 | & ] 5 32 5 & S | met 1.6
Lans S 1 & ] 5 32 5 & S | met 1.68
Lgne= & | B3 ] 5 32 5 &3 S | met 1.62 hd
q | >
Ok Cancel | Help
g
11 Click OK to close the Tuning File Creation dialog box.
The newly created tuning file is now loaded for use in the Phy Tuning tab.
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& Setup

Connection Setup

PCIe-103:Up
PCle-102:Doven

Capture Sstup Phy Tuning

- Tuning File Selection
' Use Default Tuning values

& Use specified Tuning File

- Select PCI Exprass Phy Tuning file {.ptu) to use

EX\Tuningh x16Uni_StandardTune.ptu MNew Tune..,

-Description

Tuning file generated by Tuning GUI

-Tuning Specification
Date of Tuning: 30-0ct-2012 16:39 -
Probe Type: U4321A Slotinterposer RX_2Card
Lane Width: 16
Frame: mfg
Slot: O
Serial Number: defaultTune

Le

LEDs display during BER Based Tuning

42

The U4301 Analyzer module has 16 channel LEDs and four speed LEDs. The following table lists the

interpretation of these LEDs display during BER-based tuning.

Channel LEDs

Green Indicates no bit errors on that lane.

Yellow Indicates loss of sync or “OK”/”"ERROR” is toggling quickly. You get “shades of yellow”,
usually, when there are frequent bit errors.

Red Indicates bit error on that lane.

Blinking Red / Off Indicates input FIFO overflow.

Speed LEDs

Off Indicates an Idle state.

Blue Indicates that the data is being taken.

For a general description of the channel and speed LEDs, refer to the PCI Express Gen3 Hardware
and Probing guide. You can download this guide from www.keysight.com.
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Loading a Tuning File in the Logic and Protocol Analyzer GUI

The Phy Tuning tab lets you load a user-created physical tuning (.ptu) file or the default tuning values
from a predefined tuning file.

To load a specified tuning file or default tuning values

1

In the Keysight Logic and Protocol Analyzer application's Overview window, select Setup>Setup...
from the PCle Gen3 analyzer module's drop-down menu.
Click the Phy Tuning tab.

The left pane of the Phy Tuning tab displays a list of the currently available PCle Analyzer
modules. From this list, select the module for which you want to select a tuning file.

To load default tuning values:

a Select the Use Default Tuning Values option from the Tuning File Selection section. On selecting
this option, the software automatically uses the default tuning values from the predefined .ptu
file applicable for your probing and connection setup. This is the default and recommended
option for an initial run. If the default tuning values do not produce robust and clean tracing
results, you should load a user-specified PTU file for tuning (described in the next step).

To load a user-specified tuning file:

a Select the Use Specified Tuning File option to load a user-specified tuning file.

b Click the " icon displayed with the Select PCI Express PHY Tuning File (.ptu) to use section to
browse and navigate to the tuning file that you want to load.

¢ Select the tuning file and click Open in the Open dialog box.
The tuning file is now loaded for use.
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i Setup

Connection Setup

Capture Setup Phy Tuning

PCIe-105:Up
PCIe-102: Down

- Tuning File Selection
" Use Default Tuning values

& Use Specified Tuning File

- Select PCI Exprass Phy Tuning file {.ptu) to use

EXATuning'X16Uni_Midbus _StandardTune.ptu

—Description

- Tuning Specification
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Click Apply or OK.

Apply | ok |  cancel
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Tuning a Bidirectional Setup

A single U4301A/B module can support a x1 to x8 bidirectional configuration. To tune a U4301A/B
module in a x1 to x8 bidirectional configuration, you just need to tune once. A single tuning file is
used to perform tuning for both directions.

However, for a x16 bidirectional configuration, you need two U4301A/B modules. Therefore, for such

a configuration, you need two separate tuning files, one for each module. Each module is tuned
separately using its tuning file.
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5 Tuning the Analyzer for a Specific DUT

Fine Tuning a .ptu File

If the .ptu file that you created does not produce robust and clean tracing, then you can fine tune the
.ptu file to get the desired results from tuning.

Fine Tuning Flow

The following picture illustrates the fine tuning flow.

Tune the system using the In the Logic and Protocol
.ptufilecreated in the initial |  Analyzer GUI, select the
tuning run appropriate tuning file

h

Check the trace guality

End
(Fine Tuning not nesded)

Using the Logic and

Finetune the ptufile  |—— o o Analyzer GUI

Y

1 End l

In the Setup dialog box of the U4301A/B Analyzer module, click the Phy Tuning tab.

2 Ensure that the Use Specified Tuning File option is selected and the .ptu file that you want to fine
tune is selected in the Select PCI Express Phy Tuning File (.ptu) to use section. If no .ptu file is selected,
then the default predefined .ptu file applicable for your probe and connection setup is used for
fine tuning.

3 Click New Tune....

4 Select Fine Tune Previous Results from the Tuning Method listbox in the Tuning File Creation dialog box.

To fine tune a .ptu file

5 Click the J| icon displayed with the Output PTU File field to browse and specify the path and
location of the tuning file that will be generated after the fine tuning process.

6 Click Perform Tune.
The fine tuning process starts and the fine tuning progress is displayed with a progress bar.
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Tuning File Creation E

-Tuning Setup

Before tuning, DUT must be in stable L0 at 8.0 GT/s (no transitions to or from electric

Tuning Mode |Fine Tune Previous Results j

Output PTU File  E:\Tuning\X16Uni_x8LW_FineTune_001.ptu |

Cancel |

Tuning Progress || IINENNRRNERRNRRERRRERRNRRNNRRERRIRRARNARIRININ

Current Test Progress (NEEEEENEEEEENEEREREEENERNEE

-Tuning Log

Creating physical tuning file E:%Tuning XléUni =x8ILW FineTune00]
Initial tuning file E:“Tuning' X16Uni x8LW StandardTune.ptu
Fines Tuns started

Loading FPCGA

FPEL loaded

Writing log to E:'Tuning'X1léUni =BLW FineTune00l.log j

Running Leong test 1

Lans o: &3 19 o 23 o 47 a

Lans 1: &3 3 11 37 0 8 3

Lans 2: &3 9 7 10 0 45 a

Lans 2: 83 1l 2 29 0 55 a

Lans 4d: &3 3 12 30 0 36 5

Lans S: &3 12 2 29 4 5% 10

Lans 6: &3 11 T 29 1 &3 1

Lans T: B3 g o 50 0 &3 L&

Complete after 1177 iteraticns.

Timespan 00:02:1%9.6356000 =
T —— Mo TTmrr Demms= Tlmmaa | = =2

d | "_IJ

7 When fine tuning completes, click OK to close the Tuning File Creation dialog box.

On successful completion, the fine-tuned PTU file is created at the specified location along with a
tuning log with the same name as the fine-tuned PTU file.
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6  Manually Adjusting the Equal-
izing Snoop Probe (ESP) Set-
tings

The Probe Setup tab in the PCle Gen3 analyzer's Setup dialog lets you manually adjust the
equalizing snoop probe (ESP) settings.

To enable the Probe Setup tab in the PCle Gen3 analyzer's Setup dialog, you must check the
NOTE Enable Advanced Probe Settings (ASP) option in the Options dialog. See "Options Dialog" (in the

online help).

1 Inthe Keysight Logic Analyzer application's Overview window, from the PCle Gen3 analyzer
module's drop-down menu, select Setup>Setup....

egic o - -
@Eile Edit View Setup Tools Markers Run/Stop Overview Window Help

NEHS A RS | CTH QRS [ 5 |
J_ -touz=—|

Modules Windows

Slots

B Pcie-00s ‘ B Protocol i

" Viewer-1
LHEER [¢][_show |

] ‘ Mew Probe »
Mew Tool k
Mew Window r

Trig Tri
Disable... I3 Trigger

Rename...
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6 Manually Adjusting the Equalizing Snoop Probe (ESP) Settings

2 Click the Probe Setup tab.
3 Inthe Probe Setup tab, select the appropriate options.

For each lane in the links, you can adjust the boost and bandwith settings. Click Reset -> to
restore the original settings.
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/ Setting Up Triggers

Setting Up Simple Triggers / 52
Setting Up Advanced Triggers / 55
Setting General Trigger Options / 58

The U4301A/B PCle Gen3 analyzer lets you set up triggers (events that specify when to capture a
trace) with simple or advanced dialogs.
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7 Setting Up Triggers

Setting Up Simple Triggers

1 Inthe Keysight Logic Analyzer application's Overview window, from the PCle analyzer module's
drop-down menu, select Setup>Trigger....

i File Edit Wiew 5etup Tools Markers Run/Stop Overview Window Help
DS (A RS WTH|QAR | | |%

| o - — |
Modules Windows
Slots
B Pcie-005 ‘ B Protocol ]
& | Wiewer-1
LHEEL e
| gg MNew Probe C
Mew Tool L
Mew Window »

Disable...
Rename...

s Setup...

Civerview E Protocol Viewer-1 I

2 Inthe Trigger dialog:
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B Trigger

| a0l PCT-Express Links X |

Applies to | All PCI-Express Links

= | Trigger Position 50%

~ @ Simple Trigger

Advanced Trigger |F|wrj|:e Triggers i] |ﬁ|

Setting Up Triggers

SR

Search
Favorites (Currently empty)
Anything (Any speed)
= Ordered Sets
Any Ordered Set (Any spead)
Skap Ordered Set (SKP OF) (Any speed)
speed)

Electncal Idle Exit Ordered Set (EIECQS) (Ar
= Ordered Sets (Genl.2)
[ Ordered Sets (Gend)
Packets
Ary TLP ar DLLP Packet (Any speed])
# Packets (Any speed)
= Packets (Genl.2)
= Packets (Gen3)
Framing Tokens (Gen3)
End Data Stream (EDS) Token
= Physical Layer Triggers
Channel Bonding
Electrical Idie
Loss of Sync
= Arming
Arm o fram
- m | "

M

F-

-

2 Trigger on Packets or Ordered Sets

Trigger Mode
[ Trigger when Stop butten pressed

Global Filter

Store everything including Logical Idles

Enabled @ Disabled [Recomme

| Filter Off / Store Everything

-]

Select the Trigger(s) to use

Tngger on any of these events
| = Any Ordered Set (Any speed

While ignoring any of these events
*® Skip Ordered Set (SKP O5) [Any

¥ Flectrical lolle Qrgered Sat (F1IOC

a Select the Simple Trigger option.

. J-h:lp

Select the Trigger on Packets or Ordered Sets Trigger Mode option.

7

(The Trigger when Stop button is pressed Trigger Mode option can be useful, for example, to see
the events that lead up to a stop, halt, etc.)

c From the Global Filter listbox, select the following two options:

i Select whether you want to enable or disable the storage of all types of ordered sets and
packets including the logical idles in the capture memory.

i If you disable the storage of everything including the logical idles, then this drop-down

list is activated. From this list, you can select the types of ordered sets and TLP/DLLP

packets that you want to filter out from getting stored in analyzer memory. The options

selected from this list act as the storage qualifiers. The selected types of ordered sets and

packets are acquired but are not qualified to be stored in the analyzer's memory. If you
select the Filter Everything option from this list, then none of the acquired samples will
qualify to be stored in the analyzer memory. As a result, analyzer will keep running and
you need to stop it manually because analyzer keeps acquiring data until the memory
depth is full. If you do not select any option from the list, then the filtering is considered

Off and all the acquired data is stored in memory when the trigger condition is met.

¢ Drag events you would like to trigger on from the left-side pane to the Trigger on any of these

events box.

The left-side pane contains an event hierarchy that can be expanded or collapsed.

To edit events in the trigger box, click the underlined event name.
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7 Setting Up Triggers

To remove events from the trigger box, click the "X" to the left of the event name.
d Drag events you'd like to exclude from the trigger to the While ignoring any of these events box.
e Click Apply or OK.

See Also - “Toselect which links the trigger is for" on page 58
“To set the trigger position" on page 58
“To save/recall favorite triggers" on page 58
“To clear the current trigger" on page 59
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Setting Up Advanced Triggers

1 Inthe Keysight Logic Analyzer application's Overview window, from the PCle analyzer module's
drop-down menu, select Setup>Trigger....

| File Edit View 5etup Tools Markers Bun/Stop Overview Window Help
FHS A RS | HTH|QAR | |1 |
-m-=—|

—

Maodules Windows

Slot 5

. PCle-005 ‘ S Protocol |

Viewer-1
I Tr. .’e | Show

T . Mew Probe L4
Mew Tool L4
Mew Window

—— i

Rename...

Overview  |EE  Protocol Viewer-1 |

2 Inthe Trigger dialog:
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| All PCI-Express Links X |+ |

Apglies to | All PCI-Express Links

v| Trigger Posiion 50% N, 50%

- [ Simple Trigger @ Advanced Trigger |Favorite Tiggers¥| |Clear

Global Filter

IEc-ﬁ-':.'r p - E
- Store ing inchudi : LE @ Disabled
. o pe—— " . everything i ing Logical Idles () Enabled (Recommended)
I An:,*thi;?s[,i;:yspted:l | Filtering: Any Initialization Fiow Contral, Any Update Flow Contrel, Any ACK, Any NAK = |
Any Ordered Set (Any speed)
Slap Ordered Set (SKP OS] (Any speed) rSelect the Tnggen(s) to use
Fast Training Sequence (FTS) (Any spee: -
Electrical Idle Ordered Set (EICIS) (Any 5 Advancad I Then 1
Electrical ldle Exit Ordered Set (EIE0S) |
i Ordered Sets (Genl.2) E —
% Ordered Sets (Gen3) [ | (achetr] [ [Fest Training Sequence (FTS) (Any speed)| on |Ett
= Packets H ¥
Any TLP or DLLP Pacloet (Any speed) =
- Packets (Any speed) E i @ @I @ E
¥ Packets (Genl.2)
= F?amlng Tnl[::‘a {t].l"mnsl Step 28 iy
End Data Stream (EDS) Token B
= Physical Layer Triggers J | [= =] [skip Ordered Set sKP 05) (any speed)| o0 |PC'H
Channe! Bonding I
i—Ebectrical Idle
Loss of Syne i EI :I EJ
= Timers, Counters & Flags -
] m |

S Advanced If Then I
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a Select the Advanced Trigger option.
b From the Global Filter listbox, select the following two options:

Select whether you want to enable or disable the storage of all types of ordered sets and
packets including the logical idles in the capture memory.

If you disable the storage of everything including the logical idles, then this drop-down
list is activated. From this list, you can select the types of ordered sets and TLP/DLLP
packets that you want to filter out from getting stored in analyzer memory. The options
selected from this list act as the storage qualifiers. The selected types of ordered sets and
packets are acquired but are not qualified to be stored in the analyzer's memory. If you
select the Filter Everything option from this list, then none of the acquired samples will
qualify to be stored in the analyzer memory. As a result, analyzer will keep running and
you need to stop it manually because analyzer keeps acquiring data until the memory
depth is full. If you do not select any option from the list, then the filtering is considered
Off and all the acquired data is stored in memory when the trigger condition is met.

¢ Drag events you'd like to trigger on from the left-side pane to sequence steps in the Select the
Trigger(s) to use box.
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Setting Up Triggers 7

The left-side pane contains an event hierarchy that can be expanded or collapsed. (This is the
same event hierarchy displayed in the simple trigger dialog.)

To edit events in the trigger box, click the event button.

To remove events from the trigger box, click the sequence step buttons.

d In the Select the Trigger(s) to use box, click buttons, make drop-down selections, and enter
values in fields to edit the steps in the trigger sequence:

The Step buttons let you insert or delete steps.
The If/Else if buttons let you insert or delete "if" clauses.
The event chevron buttons let you insert, delete, or logically group (or negate) events.

The direction drop-down listbox is displayed if you configured the U4301A/B module's
connection setup as a bidirectional setup. It lets you select the direction (upstream or
downstream) applicable for the trigger sequence. For a unidirectional data capture setup,
this listbox is not displayed.

The action chevron buttons let you insert or delete actions.

Use the Comment fields to document your advanced triggers.
e Click Apply or OK.

See Also - “Toselect which links the trigger is for" on page 58
“To set the trigger position" on page 58
“To save/recall favorite triggers" on page 58
“To clear the current trigger" on page 59
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7 Setting Up Triggers

Setting General Trigger Options

The top part of the Trigger dialog contains general options that apply to both simple and advanced
triggers.

“To select which links the trigger is for" on page 58
“To set the trigger position" on page 58

“To save/recall favorite triggers" on page 58

“To clear the current trigger" on page 59

To select which links the trigger is for

The top of the Trigger dialog has tabs that let you set up separate triggers for different links. You can
add tabs for separate triggers and apply them to the links that are set up in the Connection Setup
dialog (see “Specifying the Connection Setup”).

& Trigger
| All PCl-Express Links % [+ |

Appliestn!.ﬁ.li PCI-Express Links 'I Trigger Posttion  50% / 0%

[ Simple Trigger © Advanced Trigger |Favorite Triggers 8| |Clear|

To set the trigger position

The top of the Trigger dialog has a slider for setting the trigger position within the capture memory.

Note that the pre-trigger portion of the capture memory is filled before searching for the trigger.

.Trig‘gu
| All PCI-Express Links % | 4 |

Applies to | All PCl-Express Links 'I Trigger Position  50% / 50%

[ Simple Trigger © Advanced Trigger |Favorite Triggers ¥ | Clear|

To save/recall favorite triggers

The top of the Trigger dialog has a Favorite Triggers drop-down menu for saving trigger setups and
recalling previously saved trigger setups.

Do not confuse these "favorite" triggers with the favorites that appear in the left-side pane (which are
added using the Event Editor dialog).
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All PCI-Express Links % | 4+

To clear the current trigger

The top of the Trigger dialog has a Clear button for erasing the current trigger setup and restoring the
default trigger setup.

All PCI-Express Links ¥ | +

&
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8 Running/Stopping Captures

Running and stopping the U4301A/B PCle Gen3 analyzer is just like running and stopping any other
analyzer. See "Running/Stopping Measurements" (in the online help).
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8 Running/Stopping Captures
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9  Viewing PCle Gen3 Packets
and Traffic Overview

Viewing the Captured PCle Traffic Statistics / 65
Navigating through the captured PCle packets / 67
Viewing a Traffic Overview Chart / 69

Exporting Captured PCle Datato a.csv File / 73

You can view the data captured by the U4301A/B PCle Gen3 analyzer using the Protocol Viewer
window. See “Analyzing Packet Data” (in the Keysight Logic and Protocol Analyzer online help). A
Protocol Viewer is automatically added for a U4301A/B PCle Gen3 analyzer module in the Logic
Analyzer GUI.

I Keysight Logic and Protocel Analyzer (LPA) - Unnamed Configuration - [Overview]

@Eile Edit View Setup Tools Markers Run/Stop Overview Window Help
D&M< | & & |

E
g
=
=
[
il

Modules Windows

B rFcie-00s Protocol

Viewer-1

[¥] s ]

.JE' Orverview E Protocal Viewer-1 ]

The Protocol Viewer window displays the summarized and detailed packet information at the same
time within two panes. The upper pane lists the packets. On selecting a packet, the details of that
packet are displayed in the lower pane.

The following screen displays a sample view of the captured PCle data in the Protocol Viewer
window. In this screen, the Lanes tab of the Protocol Viewer window is displayed. The Lanes viewer
displays not just the selected packet data across lanes but also the post packet data represented by
colors matching the selected packet color in the upper pane.
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9 Viewing PCle Gen3 Packets

o cramds | <] = = P EBRBEEER =

' hﬂdﬂﬂﬂJ

|
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Viewing PCle Gen3 Packets 9

Viewing the Captured PCle Traffic Statistics

You can use the Traffic Overview tab in the lower pane of Protocol Viewer to get an overview of the
PCle traffic that is displayed in the upper pane of Protocol Viewer. This tab provides a count of
various PCle packet types captured and displayed in the upper pane. The count of packets is
categorized on the basis of packet types.

For each packet type, the count of packets is further segregated based on the direction (upstream or
downstream). The following screen displays the traffic statistics in the lower pane. Notice that for
each packet type, the count of packets is displayed for upstream as well as downstream direction
along with a sum of packets in both directions.

* Details | Header | Fayload | Lanes ' Traffic Overview | LTSSM Overview | Transaction Decode |
Data Range Mavigation

(Beginning Of Data _ + | to: [End Of Data -| E
Packets PCle-102-Up  PCle-102:Down = Total
Insupported Completion Request (UR) 0 41 411

Skip Ordered Set (SKP 03) (Gend) 11 12 23

Ack (Gen3) 1108 1431 2540
UpdateFC-P (Gen3) 3 309 32
UpdateFC-MP (Gen3) 3 677 630
UpdateFC-Cpl (Gen3) 669 3 672
Memory Read 32b (Gen3) 133 0 133
Memory Read 64b (Gen3) 132 0 132
Memory Read Lock 32b (Gen3) 133 0 133
Memory Read Lock Gdb (Gen3) 133 0 133
Memory Write 32b (Gen3) 133 0 133

You can specify the data range based on which the traffic statistics get computed in the Traffic
Overview tab. For instance, you might want to view the traffic statistics only for the PCle packets
between the markers M1 and M2. In such a situation, you can select M1 as the start point and M2 as
the end point in the Data Range group box and then click Compute. Then Protocol Viewer displays the
traffic statistics of only the packets that fall in the specified data range and not for all the PCle
packets displayed in the upper pane. The following screen displays the traffic statistics for the data
range starting from M1 and ending at M2 markers.

" Details | Header | Payload | Lanes ' Traffic Overview | LTSSM Overview | Transaction Decode
Uata Range Mavigation
(M1 v to: (M2 - E
Packets FCle-102:Up  PCle-102:Down  Total
Unsupported Completion Request (UR) 1] 33 33
Skip Ordered Set (SKP O8) (Gen3) 1 1 2
Ack (Gen3) a0 115 205
UpdateFC-P (Gen3) 0 24 24
UpdateFC-NP (Gen3) 0 53 53
UpdateFC-Cpl (Gen3) 51 0 51
Memory Read 32b (Gen3) 11 0 11
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Viewing PCle Gen3 Packets

Compute This and Compute All are the two options available with the Compute button.

- Compute All allows you to compute traffic overview statistics, decoded transactions, offline
performance summary, and LTSSM states (in their respective tabs) for the captured packets
by a single click of this button.

- Compute This allows you to compute only traffic overview statistics from the captured
packets. When you click Compute, then also only traffic overview statistics s computed.

The Compute button is disabled when U4301A/B PCle Analyzer module is capturing data. It
becomes enabled when the capture has stopped.

If you want to compute traffic overview statistics in background while the U4301 module is
capturing PCle data, then select the Compute All on Run check box in the Protocol Viewer
and click the Run toolbar button. This allows you to perform a compute for all the relevant
tabs in Protocol Viewer automatically after the data capture is complete. It thereby helps you

perform a faster compute than performing a compute for each tab individually after the data
is captured.

nl ul |-'-| L| T| LlTu ||'-| Mg C5F Favorite Layouts ¥ | /] Compute All on Run
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Viewing PCle Gen3 Packets 9

Navigating through the captured PCle packets

From the displayed traffic overview statistics, you can select a particular packet type and then
navigate through the packets displayed in the upper pane for that packet type. For instance, there
are total 2540 packets of the type Ack in upstream and downstream directions and you want to view
the details of the 45th Ack packet out of these 2540 Ack packets. To go directly to the 45th Ack
packet out of these 2540 Ack packets, you can select this packet type in the Traffic Overview results
and then type 45 in the Navigation text box and click Go. This takes you directly to the 45th Ack
packet in the upper pane of Protocol Viewer.

Packets |
Sample Number |Time PCI-Expregs Packe |Link Speed Directicn Sequence Humber |Tag
58 399 ns UpdateFC-NP Gen3 PCIe-102 :Down
LR 905 ns Ack Gen3 PCIe-102:Up 978
59 919 n3 Ack Gen3 PCIe-102:Down 6AA
54 927 n3 UpdateFC-Cpl Gen3 BCIe-102:Up
(1] 936 ns Ack Gen3 PCIe-102:Down 6AB
||55 937 ns Ack Gen3 PCIe-102:TUp 979 S 45th Ack
Packet
8l 963 na Ack Gen3 PCIe-102:Down &&D
62 967 ns UpdateFC-NP Gen3 ECIe-102 :Down
Up

56 977 ns Ack Gen3 PCIe-102: 378

2 i 4 i

Details | Header | Payload | Lanes ' zl.'lalﬁt:(hewit:urLTSSM Overview | Transaction Decode | Performance Overview | Compare 1 |

Data Range MNavigation Event
(Beginning 07 Data_+ | to: [End Of Data - ¢ Go 45 [+ out of 2540 events Ack (Gen3)

Packets PCle-102:Up  PCle-102:Dow | Total
Unsupported Completion 0 411 411
Skip Ordered Set (SKP C 11 12 23
|Ack (Gen3) | 1109 1431 2540
UpdateFC-P (Gen3) 3 309 312
UpdateFC-NP (Gen3) 3 677 680
UpdateFC-Cpl (Gen3) 669 3 672

You can also navigate through the PCle packets of a particular direction (upstream or downstream).
To do this, select the count of packets displayed for a particular packet type in the traffic statistics in
the required direction. Then specify the packet number in the Navigation text box and click Ge to
reach directly to that packet.
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9 Viewing PCle Gen3 Packets

’backels
Sample Number |Time PCI-Express Packe |Link Speed |Direction Sequence Number | Tag
a02 10.921_ UpdateFC-Cpl Gen3 PCIe-102 :Down
805 10.923.. Ack Gen3 PCIe-102:Up R34

803 10.932.. Ack Gen3 PCIe-102:Down 7BO

10.953.. UpdateFC-Cpl

a06 10.983._. UpdateFC-NP Gen3 PCIe-102 :Down
4 | I

“Details | Header | Payload | Lanes ' Traffic Overview | LTSSM Overview | Transaction Decode | Performance Overview | Compare 1 |

Data Range Mavigation Event
(Beginning Of Data = | to: |End Of Dats )  Go 1 outhBES euents UpdateFCH

Packets PCle-102:Up PCle-102:Dow  Total

Unzsupported Completion 0 411 411
Skip Ordered Set (SKP C 11 12 23
Ack (Gen3) 1109 1431 2540
UpdateFC-P (Gen3) 3 309 2
UpdateFC-NP {Gen3) 3 677 680
UpdateFC-Cpl (Gen3) 3 672
Memory Read 32b {Gen: 133 0 133
Memory Read 64b {Gen: 132 0 132
Memory Read Lock 32b i 133 0 133

You can also select multiple packet types in the Traffic Overview tab by clicking a packet type and
then dragging the mouse over to the other packet types that you want to select. When you select
multiple packet types, the Navigation section displays the total packet count for all the selected

packet types.
~ Details | Header | Payload | Lanes ' Traffic Overview | LTSSM Overview | Transaction Decode | Performance Overview | Compare 1 |
Diatz Range Mavigation
(M1 “ o (M2 - (’ Go 189 uutufSEdeverﬂsE
Packets PCle-102:Up  PCle-102:Down  Total I
Unsupported Completion Request (UR) 0 i3 33
Skip Ordered Set (SKP 08) (Gen3) 1 1 2
Ack (Gen3) a0 115 205
UpdateFC-P (Gen3)} 0 24 24
UpdateFC-NP (Gen3) 0 53 53
UpdateFC-Cpl (Gen3) 51 0 51
Memory Read 32b (Gen3) 11 0 11
pms— {Gen3) = = =
Memory Read Lock 32b (Gen3) 10 0 10
Memory Read Lock 64b (Gen3) 10 0 10
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Viewing a Traffic Overview Chart

You can view the computed traffic overview statistics as a band chart in the Traffic Overview tab.

To display a traffic overview chart

Details = Header | Payload | Lanes ' Traffic Overview | LTSSM Overview | T

Data Range

1

After you have computed traffic overview statistics, click the Chart checkbox from the Options
groupbox in the Traffic Overview tab.

Options
| Chart| [¥] Y s [Setup..|

A band chart is displayed for the packet types found in the computed traffic overview statistics.
The following screen displays a traffic overview band chart.

(M1

= | to: [M2

e
MISMOry HEead 040 (aens:
Memory Read Lock 32b |
Memory Read Lock 64b |
Memory Write 32b (Gen2
Memory Write 6db (Gen2
/0 Read (Gen3)

110 Wirite (Gen3)

Config Read Type 0 (Ger
Config Write Type O (Ger
Completion without Data
Completion with Data (Ge
Message Request withou
Message Request with d:
End Data Stream (EDS)

Y]
10
10
10
10
11
11
2
11
0
0
11
11
1

ion Decode | Per QOwverview | Compare 1
MNavigation Event Options
=) [Compute |~ @ @ o ‘IHEE|0UtQ{2DSev&nts@| Ack (Gen3) ¥ Chart 9] Y hodis (Setup..|
u
0
0
0
0
0
0
0
0
54
a1
0
0
1

Understanding the Displayed Traffic Overview Chart

In the traffic overview chart, color coding is used to differentiate packet types based on directions.
For instance, in the above screen, blue and orange colors are used to represent packet types in
the upstream and downstream directions respectively.

For each packet type found in trace, there is a grid row in the chart. A grid row is used to plot the
number of packets of that type for upstream as well as downstream directions. The number of
packets for a packet type are plotted over the period of time as X-axis. The Y-Axis of the chart
displays the applicable packet types.

The traffic overview chart is always aligned with the packet types list on the left to allow you to
easily map the band rows with the packet types.

Customizing the traffic overview chart

Keysight U4301 PCle Gen3 Analyzer User’s Guide

If required, you can customize the traffic overview chart in terms of:

the color coding used in the chart for packets in upstream and downstream directions and color
coding to represent packets with errors.

the packets types which you want to display in the traffic overview statistics and chart.
hiding or displaying the Y-axis of the chart.
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To customize the traffic overview chart
1 Click the Setup button from the Options groupbox in the Traffic Overview tab.
The Traffic Overview Setup dialog box is displayed.

E Traffic Owerview Setup EI@

Select Packets to Display. Deselected Packets are Filtered,

4 PCI-Express
4 Ordered Sets
I [¥] Ordered Sets (Genl.2)
I [¥] Ordered Sets (Gen3)
4 Packets
I [¥] Packets (Genl,2)
I [¥] Packets (Gen2)
4 Framing Tokens (Gen3)
End Data Stream (EDS) Token

I Errors
Channel Packet Color Error Color
PCle-102:Down || [l ~ | I -
pcle-102Up [N ~ | I -
Actions
() All Packets @ Only Selected Packets
[ Apply l I OK | [ Cancel

2 Select the packet colors and packet types to display.
3 Click OK.

The changes are reflected in the traffic overview chart.

To hide the Y-axis of the traffic overview chart
1 Deselect the Y Axis checkbox from the Options groupbox in the Traffic Overview tab.

Options

Zooming In/Out the Traffic Overview Chart

You can zoom in or zoom out a defined area in the chart or the complete chart.

To zoom X-Axis for a defined area in the chart

1 Click the Zoom X-Axis option from the combo box displayed in the Pan and Zoom section of the
chart pane to make it active.

2 Move the mouse pointer to the traffic overview chart location from which you want to begin
zooming.

3 Left-click at this location and while keeping the left mouse button pressed, drag the mouse to the
chart location till which you want to zoom the display. As you move the mouse, the zooming
extent is defined in chart and highlighted with gray.

When you release the left mouse button, the defined X-axis area is zoomed for the displayed chart.
Following screen displays a zoomed in traffic overview chart.
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Event Options Pan and Zoom Markers

Ack (Gend) | Chart [¥] Y Axis Setup...| E|E| @|@| Zoom X-fods v| =] Show [+| Cent

‘ out of 205 events | [

You can also zoom in or zoom out the complete chart. To do this, use the following buttons in the Pan
and Zoom section of the chart pane.

@| - Zoom In magnifies the center 50% of the chart to the full width of the chart.
Ql. Zoom Qut reverts the magnification in the chart.

@l | - Zoom Out Full displays the entire range of Computed data across the full width of the
chart.

You can undo and redo zooms by clicking the E| and E| buttons in the Pan and Zoom
section of the charts pane.

Placing markers in the traffic overview chart

You can place markers in the traffic overview chart and use these markers to navigate to the PCle
packet associated with the chart location at which you placed a marker. This helps you navigate to
the exact trace position that corresponds to that chart location. Markers placed in the chart are
correlated to markers displayed in the trace data in the upper pane of the Protocol Viewer.
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Packets |
b1 %Sample Number Time PCI-Express Packet Link Speed Direction Sequenc
) 2159 39.946 us Msg Gen3 PCIe-102:Up LBE
2167 39.952 us Ack Gen3 BPCIe-102 :Down RB2
2160 39.954 us MsgD Gen3 PCIe-102:Up LBF
M2 139.970 us {PCIe-102:Up

2162 39.934 us UpdateFC-Cpl Gen3 ECIe-102:Up

4 {111

“Details | Header | Payload | Lanes ' Traffic Ovenview | LTSSM Ovenview | Transaction Decode | Performance Overview | Compare 1 |

Datz Range Mavigation
(Beginning Of Data v | to: [End Of Data = 135 outof312 euents

Packets

Event

Insupported Completion
Skip Ordered Set (SKF C
bk (Gen3)

JpdateFC-P (Gen3)
JpdateFC-NP (Gen3)
JpdateFC-Cpl (Gen3)
Vemaory Read 32b (GenZ
Memory Read G4b (GenZ

To place a marker in the traffic overview chart

1 Double-click the location in the chart at which you want to place a marker. A new marker is
added to that chart location as a yellow vertical line and at the corresponding trace location in
the upper pane.

Alternatively, right-click the chart location where you want to place a marker. Then select Place >
New Marker or select an existing marker to place that marker at the current location.

To navigate to a particular marker placed in the chart

In situations when you have placed multiple markers in the chart, you may want to navigate to a
particular marker and its associated trace position in the upper pane. To do so, right-click anywhere
in the chart, select Go To and then select the marker to which you want to navigate.

On doing so, the chart display moves to the point at which the selected marker is located. Also, the
trace position corresponding to the selected marker is highlighted in the upper pane.

If the markers are not displayed in the chart, click the Show Markers button at the top of the
NOTE chart pane.
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Exporting Captured PCle Data to a .csv File

You can export the captured PCle packet information from the Protocol Viewer window to a specified
.csv file and use it later in other analysis tools. You do this by clicking the &%¥ toolbar button in the
Protocol Viewer window. On clicking this toolbar button, the Protocol Export dialog box is displayed
in which you can specify the details of export such as the range of packet data that you want to
export and the delimiter that you want to use to delimit the exported data in the specified .csv file.

For details on how to export data to a .csv file, click the Help button in the Protocol Export dialog
box.
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The U4301A/B PCle Gen3 analyzer lets you view LTSSM states, state transitions, and equalization
summary as detected in the data captured in a trace. Using this data, you can test or debug the
DUT’s LTSSM functions.

This chapter describes how you can view these LTSSM states and equalization summary data.

KEYSIGHT
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Viewing LTSSM States and State Transitions

LTSSM Overview

Details | Header | P

Link Training and Status State Machine (LTSSM) drives and controls the link initialization and
training process for a PCle device to enable the normal data exchange between the two PCle devices
over the link. LTSSM operates at the physical layer level and transits through various states and
substates during link initialization, training, and management. During each of these states,
appropriate physical layer packets (training sequences) are exchanged between the link partners to
initialize, train, and manage the link.

To begin communication with a PCle device, the link training process must complete successfully.
This makes link training one of the most crucial process in testing and validating a DUT. The
participation in the equalization procedure at Gen 3 speed makes this process more challenging to
test and validate.

The LTSSM Overview pane in the Protocol Viewer window of the Logic Analyzer GUI helps you in
verifying the link training process and finding out reasons for any failure in this process. This pane
provides an overview of the link training process by displaying:

a sequential list of the LTSSM states and their transitions.
equalization summary in terms of the number and values of equalization transmitter coefficients
exchanged in TS frames found in the trace.

To display these states, transitions and equalization summary, the software analyzes a user-specified
data range or the entire data captured in a trace and presents the list of transitions/states/EQ data,
from that trace.

a=d | Lanes | Traffic Overview ' LTSSM Overview | Transaction Decade | Performance Overview -CornEre1 |

76

Data Range Compute EQ MNavigation Setup
@ [Beginning Of Data - ] to: [End Of Data - ] = 1 ou1 of 0 events Organize by: @ Transitions
PCle-102:Up PCle-102-Down Transitions PCle-102:Down = PCle-102:Up = Total
— Polling Start of Trace ->= Polling 1 1 2
el Polling > Config. L\ Start 1 ] 2
CarpiEE IR Config L/ Start -+ Config LW.Accept 1 12
Config L. Accept Config. L/ Accept -> Config. LN W/ait 1 1 2
Config LM \w/ait Config LW Accept Config LM \wait -= Config LM Accept 1 1 2
Config. LMN.A t-= Config C lete 1 1 2
Config.LN Accept Config LH wiait = e S TS
Cenfig. Complete -= Config.Idle 1 1 2
Confia Complete | o |—CorfigtilAccent | Config ldle -> Revr RevrLock 1 e
Config Idle Revr RowrLock -» Rovr. Speed 1 1 2
g CerEEEARE Revr Speed -> Rer RevrLock 1 [z
Revr.RevrLock -» Revr.EG-Phasel 1 1 2
Config_Idle Revr.EQ-Phasel -» Rowr EG-Phase? 1 1 2
Reur.Speed
Revr.RevrLock
Revr RevrLock Revr.Speed
Revr.EQ-Phasel Gen3 Revr.RevrLock
Rowr EQ-Phasel Gen3
Reowr EG-Phasze?
Reowr EQ-Phase2

The LTSSM Overview pane can display LTSSM transition, state and EQ data, for both upstream as
well as downstream link directions. However, this display depends on how you configured the
direction of data capture (upstream, downstream, or bidirectional) in the Connection Setup tab of the
Setup dialog box of the U4301A/B module. For instance, if you configured a bidirectional data
capture using U4301A/B, then LTSSM states are displayed for both directions.
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& Setup

Connection Sebup | Capture S=tup " Phy Tuning

~Module
Linkis) Footprint Link Type
(@ | Pcle-101  |U4321A Slot Interpaser Both Dir x8 v | [1 Bidirectional up to xEjagl

< >

~ Link Maming and Lane Sstup 3
Mame Clock Source Master Lane | Lane Reversal Lan
= All PCI-Express Links
= PCI=-101

PCle-101:Up [eemaliv]  [09] of | (o Jc
PCle-101:Down [intemal | [0/~ Off I | [ Auto ][

| PCle-101:Dawn ,___Lq_ PCle-101:Up _|7LTS SM States listing for upstrean

0 direction
Lo LTSSM States lizhing for dowvnztream
Reowr Revrlock Genl direction
=l Gend
Fevr.Speed Revr RevrLock
Rovr.Speed
Fewr. RevrLock Revr. RevrLock
Fowr. RewnCfg
Revr.RewrCig Fevr.ldle
B ldle
LD
LD
Rewr RevrLock
Gl Rt RoviLock
Revr. RevClg Genl Rcvr. RewrCig Genl
Fevr.ldle
Reur.ldle
LD LD
Fewr RevrLock

Using the LTSSM Overview pane, you can view the LTSSM transitions, states and EQ, during events
such as:

Link initialization and configuration to bring the link to an operational state.

Link recovery or retraining in situations such as speed changes, power management, or
recovering from a link error.

Downgrading or upgrading the link speed in response to a link speed change request.

Performing the Equalization procedure before reaching the Gen3 (8.0 GT/s) speed during the link
training or retraining.
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Prerequisites

Before you can view LTSSM transitions, states and EQ, you need to ensure that:

You have the appropriate node/server software license available and installed for the LTSSM
Overview feature.

You have set up the U4301A/B analyzer module and captured the PCle data for the required
direction(s).

You have configured the LTSSM setup to get the data display in the LTSSM overview pane
according to your requirements. (Described in the next section)

78 Keysight U4301 PCle Gen3 Analyzer User’s Guide



Viewing LTSSM States and State Transitions 10

Configuring and Computing LTSSM States and Equalization Summary

To view LTSSM data in the LTSSM Overview pane, you need to configure the pane settings and
initiate computation of the LTSSM data display based on these settings.

Access the captured data along with the U4301A/B setup details in the Logic Analyzer GUI.

2 Click the Protocol Viewer node connected to the U4301A/B module in the Overview window of the
Logic Analyzer GULI.

3 Click the LTSSM Overview tab in the lower pane of the Protocol Viewer window.

Configure the LTSSM setup to get a display of LTSSM States/Transition/EQ as per your
requirements.

a To configure how the computed LTSSM data should be organized in the LTSSM Overview pane,
select the appropriate Organize By mode - By Transitions, By States, or By EQ from the Setup
groupbox.

Transitions displays the LTSSM states transitions in the results for navigating through the
occurrences of the state transition events in the analyzed data.

States displays the LTSSM states in the results for navigating through the occurrences of
the state entry events in the analyzed data.

EQ displays the equalization coefficients in the results for navigating through the states
and TS frames in which these coefficients are exchanged and negotiated

Setup
Organize by: @ Transitions () States () EQ

b In the Data Range groupbox, specify the start and end range for the captured data in the trace
for which you want to display the LTSSM data. Only the specified range of data is analyzed to
detect the LTSSM states and equalization summary. The default selections in the Data Range
group box ensure that the LTSSM data is displayed for the entire trace. However, you can set
markers in the packets listing in the upper pane and then specify the data range using these
markers so that LTSSM data is displayed only for that specific range of packets.

Data Range i

[Beginning Of Data - ] to: [End Of Data - J

¢ Select the Compute EQ checkbox if you want to compute the equalization summary data along
with computing the LTSSM states and transitions. If you do not select this checkbox, then only
LTSSM states and transitions are computed.

P LT‘SSMOUBWIBM| Transaction Decode | Performance Overview | Compare 1 |
Compute EG| Navigation

.] [Curnpute |vl [E‘ (’ Ga 1 —+outcf2€vents@

5 Click the Compute button displayed with the Data Range fields. There are following two options
available as a drop-down menu with this Compute button.

Compute All allows you to compute traffic overview statistics, decoded transactions, offline
performance summary, and LTSSM data (in their respective tabs) for the captured packets by a
single click of this button.

Compute This allows you to compute only LTSSM data from the captured packets. When you
click Compute, then also only LTSSM data is computed.
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If you want to compute LTSSM data in background while the U4301 module is capturing PCle
data, then select the Compute All on Run check box in the Protocol Viewer and click the Run
toolbar button. This allows you to perform a compute for all the relevant tabs in Protocol
Viewer automatically after the data capture is complete. It thereby helps you perform a faster
compute than performing a compute for each tab individually after the data is captured.

Eg cEv Favorite Layouts % | /| Compute All on Run

|1-| Ill I"l L| T| L|TB|I"I

The LTSSM data is computed and displayed for the specified data range and configured link
direction. Refer to the next sections to view how the LTSSM states, transitions, and equalization
summary data is displayed.

You need to recompute the LTSSM states display results if you want to change:
- the data range for which results are to be displayed.

- the LTSSM navigation mode for the navigation pane.

- the link direction for which results are to be displayed.

You can hide or display the LTSSM Overview pane using the |I| toolbar button in the upper
pane of the Protocol Viewer window.
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The screen below displays the results of a compute operation for LTSSM states followed by a

description of these results.

Fackets
hd2 : Sample MNumbher Tinme PCI-Express Packet Link Speed Direction Gec
. 54436 120,.312709 ns T332 Geni FCIe-101:TUp
54437 120.312728 ns EIOG Feni FCIe-101:Tp
IS-’-l-’-lES 120.576324 ms T3l Fenl : PCTIe-101:Dowm
4466 120,.5763658 ns T3l Genl FCTIe-101:Dowm
54467 120.576452 ns T3l Fenl PCIe-101:Dowm
o |
Details | Header | Payload T Lanes | Traffic Overvien A ESSMD g Facket exchanoed during the selected state
Setiings Data Range Nawigation

Setup...| [Beginning Of Data

-v:é to: Eru:I'Z‘ff -Ij;ta

) (M@ ][ DFoeeo

PCle-101:Down I FCle-101:Up LTSSM from Beginning Of Dab: PCle-101:Down PCle-1071:1;
LD | | Start of Trace > LO 1 1
LD
Revr.Revrlock Gen3 Gerd L0 -= Revr.RewrLock 8 2
Fovr Speed Bovr Revrlock Revr. RevrLock -» Rovr. Speed 4 4
Fewr Speed Revr Speed -= Rowr. RovrLock 4 4
Revr.Revrlock Revr.RevrLock Revr. RevrLock - Reovr. RevrCig g 8
Revr.RewrCig Revr RewrCfg - Bevr ldle S 8
Revr.RevrCig Reur.ldle Revr Idie = L0 8 g
Revr ldle
LO
LD s
ﬂ Overview . % Pratocal Viewer-1 J

LTS5H States List Digplay section

LTS5M States/Transitions Mavigation section

The LTSSM states results are described in the following two sections, as highlighted in the pane in

the above screen.
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LTSSM State Results Description

LTSSM States List Display section This section displays a list of the LTSSM states in the sequence in which these occurred in the trace or the specified part of
the trace. The states are grouped and listed for a link direction. In the above screen, LTSSM states are displayed for both
upstream and downstream directions.

For each state in this list, the applicable link speed during the state is also displayed. Clicking a speed in this list highlights
the packet representing the transition to that speed in the upper pane of the Protocol Viewer.

When you click a state in the list, the packet that is exchanged as the first packet for that state occurrence is highlighted in
the upper pane of the Protocol Viewer. This provides you a quick start point for viewing and navigating through the packets
exchanged during a particular state.

Moving the mouse pointer to a state presents a tool tip with useful information about the state such as the time tag for the
state and the packet exchanged at the state change.

LTSSM States/Transitions Navigation ~ This section displays a list of the applicable LTSSM states or state transition names. The display of states or transitions in
section this section depends on whether you selected Transitions or States organization mode in the Setup groupbox. In the above
screen, the display and organization in the navigation section is as per the Transitions mode.
For each of these states/transitions, the section displays the number of events representing the number of occurrences of
these states or transitions in the analyzed data. For instance, in the above screen, the transition from Revr.Idle to LO state
occurred 8 times in each upstream and downstream direction making the total occurrences of this transition 16.
Using this section, you can easily navigate through these occurrences of LTSSM states or transitions and the packets
exchanged during these occurrences.
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Viewing LTSSM States and State Transitions 10

The screen below displays the equalization summary results of a compute operation in the LTSSM
Overview tab (when the Compute EQ checkbox is selected).

In the following screen, EQ has been selected in the Setup groupbox to display the computed

equalization summary data.

ime PCI-Express Packet Link Speed Direction Sequence Number Tag
79.183 us EIDS Genl BCIe-102:Up
.100 us T51 Gen3 PCIe-102:Up
.117 us T51 Gen3 BCIe-102:Up
.133 us T51 Gen3 PCIe-102:Up
.149 us T51 Gen3 BCIe-102:Up
.165 us T51 Gen3 PCIe-102:Up
.182 us T51 Gen3 BCIe-102:Up

s | Traffic Overview " L TSSM Overview | Transaction Decode | Performance Cverview | Compare 1 |

Computs EQ Mavigation Sefup
X [Erid Of Data - l Compute |+ 1 out of 1 events Organize by: () Transitions () States @ EQ
PCle-102:Down - [|EQ Gj1]12|3 |4|5|6|7 File
g LA I || Transmitter P@sd Hint_PCle-102Up 1 1 1 T 1 1 11 Inde LTSSM State # of TS | Direction
Revr Preset Hint_PCle-102:Up 1 1 1 11 1 1 1
sonfig. LN Wait Full Swing (F5)_PCle-102:Up 121 11111
nfig.LN. Accept | ILow Frequency (LF)_PCle-102:Up 121 11111
Eail Post-Cursor Cosf_PCle-102:Up 2 2 2 333 2 2 @ Rcvr.5peed 78 PCle-182:U)
onfig. Complate Pre-Cursor Coef_PCle-102-Down 2 2 6 5 6 2 4 8
(Cursor Coef_PCle-102:Down 2 2 6 & 6 2 4 B
Config ldle PDEt—CL.IISCI-r Coef_PCle-102:Down 2 2 2 2 6 2 2 4 1 Rcvr.EQ-Phasel 1 PCIe-182:U)
E || lIFull Swing (F5)_PCle-102:Down 121 11211
tovr.Rovrlock
Low Frequency (LF)_PCle-102:Dawn 1 2 1 111 2 1 1
Rewr Speed Pre-Cursor Cosf_PCle-102:Up 422 33333 2 Revr.EQ-Phasel 1 PCIe-182:U)
(Cursor Coef_PCle-102:Up 2 22 3 3 3 3 3
fevr RewrLock Reject Coef_PCle-102:Up 000 11100
owr.EG-Phasel | Gend Reject Coef_PCle-102:Down 000 0200 1
' — A KOWrE.FU Nese | 4 Flie-1kA000
owr.EQ-Phase2 SR m | vl 4 m
LTSSM States List Equalization Coefficients Equalization changes summary
Display Section Exchanged on Each Lane as per LTSSM States Sequence

The equalization summary results highlighted in the screen above are described as follows.
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Equalization Summary Description

Results

LTSSM States List Display This section displays a list of the LTSSM states in the sequence in which these occurred in the trace or the specified part of
section the trace. The states are grouped and listed for a link direction.
For each state in this list, the applicable link speed during the state is also displayed. Clicking a speed in this list highlights
the packet representing the transition to that speed in the upper pane of the Protocol Viewer.
When you click a state in the list, the packet that is exchanged as the first packet for that state occurrence is highlighted in
the upper pane of the Protocol Viewer. This provides you a quick start point for viewing and navigating through the packets
exchanged during a particular state.
Moving the mouse pointer to a state presents a tool tip with useful information about the state such as the time tag for the
state and the packet exchanged at the state change.

Equalization Coefficients This section displays a list of Equalization Transmitter coefficients. For each of these coefficients, the section displays the
Exchanged on each Lane number of events representing the number of times that coefficient has been exchanged in TS frames on each of the
configured lane. For instance, in the above screen, the Cursor coefficient has been transmitted six times on lane 2 in the
downstream direction.
In this section, you can double-click a particular coefficient occurrence number and then use the Navigation bar to easily
navigate to the packet and LTSSM state associated to that coefficient occurrence.
The number of lanes displayed in this section depend on the number of lanes that you configured in the Connection Setup for

data capture.
Equalization Changes This section displays a summary of the equalization changes and negotiations found in the trace. This summary is organized
Summary as per LTSSM as per the equalization-specific LTSSM states in the sequence in which these states occurred in the trace. With each of these
States Sequence states, the following equalization related data is shown:

= #0f TS: The number of TS frames exchanged for that specific LTSSM state.

= Equalization coefficient values communicated in TS frames on each configured lane. If you see a ** value for FS or LF
coefficients, then it indicates that these values are not available in the trace.

= Reject - Indicate the acceptance or rejection of the coefficient negotiation by the link partner. Displays 0 for acceptance
and 1 for rejection.

= Absolute time - This time is calculated based on the absolute time of the first packet associated to the selected LTSSM
state.

= Delta time - The time difference between the first and last packet captured for the selected LTSSM state.

Inde LTSSM State 7, # of TS | Directic 4, Rcvr Preset Hint Full Swing (F5) Pre-Cursor
Trans Preset Low Frequency {LF)} Cursor

Post-Cursor

8 Rcvr.5peed 78 PCIe-102:Up @0 80 00 00 @8 03
@7 87 a7 o7 a7 a7

1 Rcvr.EQ-Phasel 1 PCIe-1@2:Up P R R S R O g b e s |- B
B8 14 A8 =% =* ¥x *=x x x x= =% 10 19

08 fe 00 10 10

2 Rcvr.EQ-Phasel 1 PCIe-182:Up 2461 24 FE- FECFEEE R R REORE 0 R
B8 14 @8 =% =% ** *= % *x %= =x 19 19

@ 2@ o2& 1a 12

In this section, you can click a particular row to easily navigate to the packet and LTSSM state associated to that row of
equalization data.

Exporting Equalization Summary Data to an Excel File

You can export the computed equalization summary data to an Excel file by performing the following
steps.

1 In the LTSSM Overview tab, click the File option displayed in the right most section.
2 Select the Export as XLSX To File... option.
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LTSSM Overview | Transaction Decode | Performance Qverview | Compare 1 |

[#] Compute EQ Mavigation Setup
- .- 1 outhDevents Organize by: () Transitions () States @ EQ
2/3 |4|5|86 m
Cursor Coef_PCle-102:Down 2 2 6 B & 2 4 Export as XLSX To File.. Directic Rcvr Preset Hint
Cursor Coef_PCle-102:Up 2 22 333 3|, Trans Preset
Full Swing (FS)_PCle-102:Daown 1 2 1 11 2 1|
Full Swing (F5)_PCle-102:Up 121 11 11
Low Frequency (LFLPCle102Down 1 2 1 1 1 2 1 @ Recvr.Speed 78 PCI=-182:Up 0O 00 00 @0 @0 B0

3 Inthe Save As dialog box, specify the name and location for the .xlsx file to which you want to
export the data and then click Save.

The displayed data is exported to the specified xlsx file. A sample xlsx file is displayed below.

A B 5 D E F G H
1 Index LTSSM State #of TSDirection  Recwr Preset Hint Full Swing (FS) Pre-Cursor Reject
2 Trans Preset Low Frequency (LF) Cursor
3 Post-Cursor
4 0 Revr.Speed 78 PCle-102:Up 00, 00, 00, 00, 00, 00, C
5 07,07,07,07, 07,07,
6
7 1 Revr.EQ-Phasel 1 PCle-102:Up 24,61, 24, , ., ., . ¢ »10,10,10,20,0,0,1,1,1,0,0
2 08,14, 08, , , , ., .« . 10,10, 10, 30, 30
9 00, 00, 00, 10, 10, 10, 00, DO
10 2 Revr.EQ-Phasel 1 PCle-102:Up 24,61, 24, , ., ., . ¢ »10,10,10,€0,0,0,1,1,1,0,0
11 08,14, 08, , , , ., .« . 10,10, 10, 30, 30

Customizing the Display in the Equalization Summary Section

You can configure and choose the fields you want to include in the equalization summary section. By
default, all the available fields are added in this section. As per your specific requirements, you can
choose to hide or display specific fields. You can perform this task before or after computing
equalization data.

1 Inthe LTSSM Overview tab, click the Field Chooser button displayed under File in the right most
pane.

1 LTSSM Overview | Transaction Decode | Performance Qverview | Compare 1 |

Compute EQ Mavigation Setup
- 1 outhDevents Organize by: () Transitions () States @ EQ
1 EQ 0 |1]2/|kea
Cursor Coef_PCle-102:Down 2 2 8 Index # of TS5 Directic Rcvr Preset Hint
Cursor Coef_PCle-102:Up 2 2 2 Trans Preset Low Freguency (LF
Full Swing (FS)_PCle-102:Daown 1 2 1
Full Swing (FS)_PCle-102:Up 1 2| 1
Low Frequency (LF)_PCle-102Down 1 2 1 e 78 PCle-182:Up @0 @0 B0 00 02 00
Low Frequency (LF) PCle-102:Up 1.2 1 07 @7 @7 o7 a7 97
The Field Chooser dialog box is displayed with all the available fields for the equalization summary

data.
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Field Chooser

=l
e

EQSummaryEntry

-

EENEEEEONEO0EE @& |«

#of TS

Absolute Time
Cursor

Celta Time
Direction

Full Swing (FS)
Index

Low Frequency (LF)
LTS5M State
Post-Cursor
Pre-Cursor

Rcvr Preset Hint
Reject

Trans Preset
Transmitter Presets

Use Presets

2 Select/deselect fields are per your requirements.

The equalization summary pane is changed instantly as per your selections.

The fields that you chose to hide from display can be displayed back anytime along with their
computed equalization data by simply selecting these fields again in the Field Chooser dialog

box.
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Navigating Through the LTSSM Transitions/States/EQ occurrences

You can use the Navigation groupbox in the LTSSM Overview tab to navigate through LTSSM
transitions/states /equalization occurrences.
Mavigation

1 To navigate through the occurrences of a state for both the directions, select the particular
transition/state/equalization occurrence in the navigation section. To navigate through the
occurrences of a state for a specific direction, select the number of events displayed for that
direction in front of the transition/state name in the navigation section.

2 Either type the number of occurrence to which you want to navigate in the Navigation groupbox
and click Go or click the + or - buttons in the groupbox to sequentially move to next or previous
occurrence of the transition/state/ EQ.

The specified occurrence of the selected state/transition/EQ is highlighted in the state list display
and the associated packet is highlighted in the upper pane of the Protocol Viewer window. For
instance, in the following screen, the third occurrence of the transition from LO to Revr.RevrLock
is highlighted in the states list along with the TS1 packet representing the beginning of the third
occurrence of Revr.RevrLock state.

b2 Sample Num Tine PCI-Express Packet Link 3peed Direction Sequenc_':‘_
55965 123.685845]1 n=s SKEP 05 Genl FCIe-101:Tp =1
| I559?8 123.69246]1 ns T3l Genl PCIe-101:Dowm
554978 123.692525 ns T51 Genl FCIe-101:Dowm
! l:qinﬂn 1”;"2 £O97C0R0 mT T Ran 1 PPTe—1M1 =Tintm ¢ ?
Details | Header | Fayload | Lanes | Traffic Overview  LTSSM Cwerview - X
Settings Data Range Navigation
[Setup...] |E-eginring Of Data v| to: |End f Data vl [Compum] outof 16 e
[ PCle-101:Dawn PCle-101:Up LTSSM from Beginning Of Datz PCle-101:Down! PCle-101:Up ~#
L0 B A Start of Trace -> L0 1 1
[ Ferfonss | — 1 : .
Revr RewiCig Genl Rewr RewrCfg Genl Revr RevrLock -» Rovr Speed 4 4 N
Reovr |dle Revr Speed -» Revr. RevrLock 4 4
Rovr Idle Fevr. RovrLock -» Rovr. RowrCig g 2
Lo La | Revr.RewCig -> Rewrldle g 2 =
< B & 3

3 Click toolbar button to navigate to the first packet of the first occurrence of the selected
state/transition.

4 Click toolbar button to navigate to the packet representing the transition to the last
occurrence of the selected state/transition.

You can also double-click a state, transition, or an EQ entry to quickly navigate to its
NOTE associated packet in the upper pane.
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Interpreting LTSSM States and Transition Results

Following are some important points about interpreting the states and transitions displayed in the
LTSSM Overview tab:

Errored LTSSM states - If an LTSSM state is listed in red colored text, it indicates an erroneous state
transition. Following is an example of an erroneous state transition from Detect to
Config.LW.Accept. There should have been a transition to the Polling state after Detect.

Detect
Caonfig. LW Accept

Config.LM Wait
Config LN Accept
The following background color coding is used to represent the three speed in the speed column
of the states listing.

- Yellow - Gen1 (2.5 Gbps)

Green - Gen2 (5 Gbps)
Blue - Gen3 (8 Gbps)

The pane displays LTSSM states as detected from the trace. If some events are not represented in
the captured data in the trace, then these events will not be part of the LTSSM state transitions
list in the LTSSM Overview pane.

Except for the Configuration and Recovery states, the substates are not displayed for any other
state. For instance, the substates of Polling such as Polling.Active, Polling.Compliance and
Polling.Configuration are not displayed. Only the Polling state is listed in the pane.

The LTSSM state diagram highlights which states have been entered in a given trace. This
diagrammatic representation can help you quickly assess whether or not the states occurred as
expected and required.

.
Detect ';‘

N
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The U4301A/B Analyzer module can decode storage protocols over PCI Express such as NVMe and
AHCI to display decoded transactions from the captured PCle data. This chapter describes how you
can compute and view these decoded transactions.
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I Computing and Viewing Decoded Transactions

Transaction Decoding - Overview

The Transaction Decode tab in the Protocol Viewer window allows you to compute and view
transactions decoded from the captured PCle traffic. The decoding and display of transactions is
done as per the relevant storage protocol specifications to help you easily correlate the decoded
data to the protocol specifications and evaluate DUT’s compliance to these specifications.

Types of Protocols Supported

In this release, decoding of NVMe, AHCI, and PCle transactions are supported.

Transaction Decode Tab

You use the Transaction Decode tab displayed in the lower pane of the Protocol Viewer to compute

and view decoded transactions.

Header | Fayload | Lanes | Traffic Overview | Image View | LTS5M Overview ' Transachion Decode  Compare 1
Settings Data Range N Overview Properties
’SBUJD...] |Begin Of Paired Data v| ta: |End Of Paired Data v| [ Compute ] [ Organize by:
ID Device | Transaction Type |Reguestor ID | Completer ID * || MVMe/ Directions-> PCle-102:Down| PCle-102:Up! Tot
|| 584 | 003:00:0 NVMe CC (W) 000:00:0 000:00:0 Message Request with data (Ger 8 0
D Device Transaction Type Requestor ID  Completer Config Read Type 0 (Gen1.2) 430 0 4
|| 585 | 003:00:0 | NVMe CAP(31:0) (R) 000:02:2 Q03:00: Config Write Type 0 (Gen12) 188 0o1E
lﬁ' Transaction Type  Reguestor ID I Completer ID MSI-X Table 1 0
586 [ 003:00:0 NYVMe CSTS (R) 000:02:2 003:00:0 Memory Write 32 (Gen1.2) o
D Device Transaction Type Requestor ID Complete NVMe CAP(1:0) (R) 0
587 | 003:00:0 | NvMe CAP(63:32) (R) 000:02:2 003:00 .
: NVMe CAP(E3:32) (R) 35 oz
This tab consist of two panes. The left pane displays a list of transactions. The right pane displays the
number of occurrences of these transactions.
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Configuring and Computing Decoded Transactions

Before you Start

You should have purchased and installed the U4301 Transaction Decoder license for computing
decoded transactions.

On purchasing the license, you receive an entitlement certificate. Follow the instructions in this
certificate to install the license.

Ensure that the data in the required direction(s) is already captured and available in the Logic and
Protocol Analyzer GUI for transaction decoding. You may save the captured data in a Logic
Analyzer configuration (.ala) file and access this data offline for transaction decoding.

It is recommended that you capture the device’s complete boot process data so that the required
device setup details such as AHCI base address and port addresses in case of an AHCI device are
available for decoding transactions accurately.

Computing Transactions from the Captured Data

Click the Transaction Decode tab in the Protocol Viewer window.

2 In the Data Range groupbox, specify the start and end points of the captured PCle data for which
you want to compute decoded transactions. Only the specified range of data is analyzed to
compute transactions. Following options are available for setting the data range.

Beginning and End of data - This data range selection ensures that transactions are computed for
the entire trace.

- Trigger - Selecting Trigger in the data range ensures that transactions are computed from the
point where the U4301 module’s trigger condition was met.

Markers - Selecting markers in the data range ensures that transactions are computed for the
specific portion of PCle traffic defined by markers. Refer to “Defining Markers for Setting the
Computation Range" on page 92 to know more.

Data Range

Beginning Of Data w | to: |End Of Data L

3 Click the Compute button displayed with the Data Range fields.

Compute This and Compute All are the two options available with the Compute button.

- Compute All allows you to compute traffic overview statistics, decoded transactions, offline
performance summary, and LTSSM states (in their respective tabs) for the captured packets
by a single click of this button.

- Compute This allows you to compute only decoded transactions from the captured packets.
When you click Compute, then also only decoded transactions are computed.
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NOTE If you want to compute decoded transactions in background while the U4301 module is

capturing PCle data, then select the Compute All on Run check box in the Protocol Viewer
and click the Run toolbar button. This allows you to perform a compute for all the relevant
tabs in Protocol Viewer automatically after the data capture is complete. It thereby helps you
perform a faster compute than performing a compute for each tab individually after the data
is captured.

’Dl:T-Il:-Pl L | 5T |ﬁ |t'i|{ CEY Favorite Layouts i] | Compute All on Run

Transactions are computed and displayed for the specified data range.

Header | Payload | Lanes | Traffic Overview | Image View | LTSSM Overview ' Transachon Decode  Compare 1

Setiings Data Range NT Overview Properties
[SBU..IFI...] |Begin Of Paired Data v| to: |End (Of Paired Data v| [ Compute ] [ Organize by
ID Device | Transaction Type |Reguestor ID |Completer ID * | MVMe/ Directions-> PCle-102:Down | PCle-102:Up| Tot
|| 584 || 003:00:0 NVMe CC (W) 000:00:0 000:00:0 Message Request with data (Ger 8 0
1D Device Transaction Type Requestor ID Completer Config Read Type 0 (Gen1.2) 480 0 4f
| 585 | | 003:00:0 | | NvMe CAP(31:0) (R) || 000:02:2 003:00: | Config Write Type 0 (Gen1.2) 188 0 1
Plﬁl Transaction Type || Requestor ID | Completer ID MSI-X Table 0
586 | 003:00:0 NVMe CSTS (R) I 000:02:2 I 003:00:0 Memory Write 325 (Gen1.2) 0
5| oogvie, | FnmiengecianType | \REGUGrID] (ComBEE | e carro m :
) MWMe CAP(E3:32) (R) 35 o =z
I0 || Device | [\ iransaction Type .| |'RequestoriD’ \COmPpIEE || wvme cc w) 3 0
NOTE You need to recompute the decoded transaction results if you want to change:
- the data range for which transactions are to be displayed.

- the storage protocol for which transactions are to be displayed.
- the device setup such as base address, size, or the number of queues.

Defining Markers for Setting the Computation Range

If the captured PCie traffic is too large and you want to view decoded transactions from a specific
portion of this traffic, then you can limit the computation range by defining start and end markers in
the PCle traffic.

To define markers

1 From the upper pane of the Protocol Viewer, right-click the row in the captured PCle traffic that
should act as the starting point for transaction decode.

2 Select Place Marker from the displayed context menu and then select an existing marker or click
New Marker to define a new marker at this point.

Once markers are defined, these are available for selection in the Data Range group box of the
Transaction Decode tab.
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Settings Data Range

Defining / Verifying the Device Setup

While computing decoded transactions, the Logic and Protocol Analyzer software automatically
discovers the required device details such as device 1D, type, and base address from the captured
data. You can view this device related data in the Transaction Decode Setup dialog box.

At times, the required device details are not available in the captured data and therefore
cannot be autodiscovered from the captured data. In such situations, it becomes mandatory
for you to specify these details. To avoid such a situation, you can ensure that device details
are available by capturing the device’s complete boot process.

There may also be situations when you want to rectify the autodiscovered device details or add
details of multiple devices or queues (in case of NVMe).

It is recommended that you verify and modify device details (if needed) for accurate
transaction decode computation.

You use the Transaction Decode Setup dialog box to define/modify/verify the information about the
device being tested. The types of information displayed in this dialog box differ based on the storage
protocol decode applicable for the device.

To verify/modify device details

1 Click Setup in the Transaction Decode tab of the Protocol Viewer.

The Transaction Decode Setup dialog box is displayed with the autodiscovered device details from
the captured PCle data.

i

w Transaction Decode Setup E@

Eile

Device ID Decode Basze Address
ge3:e8:8 NVMe pogooessDacesans

Actions

OK | [ Cancel | [ Help

2 Modify Device ID and Base Address, if needed.
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3 You can also add a new device details by clicking Add Device and then selecting the appropriate

device type applicable for the DUT.
To delete the setup details of an existing device, click Remove Device.

Double-click the device row to view/edit its details. Alternatively, select the device row and click
Edit Details...

The Device Setup dialog box is displayed. The tabs and fields in this dialog box differ based on the
storage protocol decode applicable for the device. The following steps describe these
device-type specific fields.

To view/edit details of an NVMe device

All device details such as its submission and completion queues and namespaces are autodiscovered
while computing decoded transactions. If needed, you can add, remove, or edit these details of an
NVMe device in the Device Setup dialog box.

I

E Device Setup EI@

Memory Page Size 4006 W |~

Doorbell Stride 1 ™|A

MNVMe General | Completion Queues | Submission Queues | Mamespaces | MSI/ MSI-X | MSI-X Table |

oK I [ Cancel ] [ Help

1

94

The Memory Page Size field indicates the size of the physical memory page configured by the host
software. The Memory Page Size value is a part of the controller configurations that the host can
set and modify. This value is used to set the size of PRP entries.

The Doorbell Stride field indicates the number of bytes to be used in memory space to separate
doorbell registers. This value is a part of the controller capabilities.

Click the Completion Queue tab. The details of Admin and I/0 completion queue(s) autodiscovered
by the software from the captured data are displayed. If these are not autodiscovered, you can
add a new queue by clicking Add Queue and specifying its ID, size, base address, and the unique
MSI-X vector that the controller allocated to this queue to respond back.
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&8 Device Setup
|__GET_E|I| Completion Queuss | Submission Queues || Mamespaces |
Queuss/ Addressss Queus ID Siza Address Int Vector
= Admin Queue 0 127 | 0|
Address | w7|[v)[y) eceeceee7srsiece

= /0 Queue 1 71[3 1023 |70|
s m@ 00600007 SFEEE20

Bl /O Queue 2 —Z‘E] 1023 |—1
PRP 1 | i3 [a 008880807SFD3098

Ackions

|;a.dd Q1.|aue.] lREmmre Quese Add Address

[ ok | Cancel | [ Help ]

4 Click the Submission Queue tab. The details of Admin and I/0 submission queue(s) autodiscovered
by the software from the captured data are displayed. The completion queue associated with a
submission queue is also displayed. A queue ID is used to display this association. If a queue’s
details are not autodiscovered, you can add a new queue by clicking Add Queue and specifying its
ID, size, and base PRP address(es).

5 Ifa queue is physically non-contiguous, multiple PRP addresses are displayed for the queue
representing multiple memory chunks. For a non-contiguous queue, you can add multiple PRP
addresses by selecting a PRP address entry of the queue and clicking Add Address.
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‘ Device Setup
|Index Address Message Data | Wector Confral |
0 Ox00000000FEEQOOOD  OxDDOX4090  CorDOO00000D '
1 OxD0000000FEEQI000  OxDDOO4050  CocDOO00000D

2 OxD0O000000FEEDZO00  OxDOOR4050  OxO00000000

3 Ox0D0000000FEEQ3000  OxDDOX4090  CorD0O00000

4 OxDOO000DDFEEQ4000  Ox0DDOO4050  CocDOO00000

5 Ox0D0000000FEEQSO00  OxDDOO4090  CocDOO00000

& OxD0D00000DFEEQGO00  OxDDOO4090  CocDOO00000

7 OxD0000000FEEDZ000  OxDOOR4050  Ox00000000

8 OxD0000000FEEQE000  OxDDOO4090  CocDOO00000 b |
9 OxD0O000000FEEDSDOD  OxDOOB4050  Ox00000000

10 Ox00000000FEEQADOD  OxODODO@4090  Coc00O000000
11 OxDO000000FEEOBO00  OxDDOO4050  CocDOO00000
12 OxDOO000DDFEEQCDO0  OxDDOO4090  CocDOO000000
13 Ox00000000FEEQDODD  OxODDO@4090  CorD0O00000
14 OxDOO000DDFEEQEOOD  OxDDOO4090  CocDOO00000
15 Ox00000000FEEOFOO0  OxODODO@4050  Coc00O000000
15 OxD0000000FEEQOODD  OxDDOO4080  CocDOO00000D
17 OxD0000000FEEQOODD  OxDDOO4050  CocDOO00000D
18 Ox00000000FEEQOODD  OxODDO@4090  CocDOO00000
15 OxD0000000FEEQOODD  OxDDOO4090  CocDOO00000
20 OxDOO000DDFEEQOODD  OxDDOO4050  CocDOO00000
21 Ox0D0000000FEEQOODD  OxDDO@4090  CocD0O00000D
22 OxD0000000FEEQOODD  OxDDOE4050  CocDOO00000D
23 Ox0D0000000FEEQOOOD  OxODDO@4090  CocD0O00000
24 Ox00000000FEEQOOOD  OxODDO@4090  CorD0O00000

6 Click the Namespaces tab. The details of the controller's namespace(s) autodiscovered by the
software from the captured data are displayed. If these are not autodiscovered, you can add a
new namespace by clicking Add Namespace and specifying the following details.

LBA Size - The Logical Block Address (LBA) data size (in bytes) that the namespace supports.
Metadata Size - The number of metadata bytes provided per LBA.

Metadata Transfer Mode - The metadata may be transferred either as part of the LBA by creating
an extended LBA or as a separate contiguous buffer of data. When this field is set to End of data
LBA, it indicates that the metadata is transferred at the end of the data LBA. When this field is
set to Separate Buffer, it indicates that all the metadata for a command is transferred as a
separate contiguous buffer of data.

i : Device Setup

Genera Completion Queues Submission Queues MNamespaces MSI / MSI-X | MSI-X Table
| ! b

Namespace ID LBA Size Metadata Size Metadata Size

ElE] I:’ Separate Buffer

ok ] [ cnd | [ e |

7 Click the MSI/MSI-X tab to view/modify the MSI / MSI-X capabilities that were discovered for the
NVMe device.
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8 Click the MSI-X tab to view/add/modify the MSI-X table entries that were discovered for the
NVMe device.

9 Click OK to confirm and apply these settings.

To view/edit details of an AHCI device

An AHCI device’s details such as the ports that it supports are autodiscovered while computing
decoded transactions. If needed, you can add, remove, or edit these details of an AHCI device in the
Device Setup dialog box.

E Device Setup
AHCI Port | MSI S/ MEIL-X | MSI-X Table

P Command List Address FIS Address

ort
0 EB goeeaBedIEc40e80 206860863 E6404808

1 u eobeabes3Ecdiean eobeeoea3EcdB4a8

Actions

Add AHCI Port Entry

(8]9 | [ Cancel ] [ Help

1 In the AHCI Port tab, click the Add AHCI Port Entry button if you want to add an AHCI port that the
device supports. This tab displays the autodiscovered ports of the AHCI device.

In the Port field, view/modify the port number.
In the Command List Address field, view/modify the base physical address of the Command List of
the selected AHCI port. A command list refers to the list of commands that the HBA fetches from

the command list base address to execute. The base address of the command list is as per the
PxFB and PxFBU port registers.

4 In the FIS Address field, view/modify the base address of the FISes (Frame Information Structure)
received for the selected AHCI port. An FIS refers to the frame of information exchanged between
the host and device. The base address of the FIS is as per the PxFB and PxFBU port registers.

5 Click the MSI/MSI-X tab to view/modify the MSI / MSI-X capabilities that were discovered for the
AHCI device.

6 Click the MSI-X tab to view/add/modify the MSI-X table entries that were discovered for the AHCI
device.

7 Click OK to confirm and apply these settings.

Saving the Device Setup Details

You can save the device, its queues, and namespace details (specified using the Transaction Decode
Setup dialog box) in a Transaction decode (.tdprop) file. Once saved, you can open this file later in
the Transaction Decode Setup dialog box to quickly access and set up the device details for a
transaction decode computation.
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To save device details

1 Click Setup in the Transaction Decode tab of the Protocol Viewer.

The Transaction Decode Setup dialog box is displayed. Modify the device details as needed.
2 Click File > Save As...
3 Specify a name for the Transaction Decode setup file and click Save.

To open a previously saved setup file for transaction computation

1 Click Setup in the Transaction Decode tab.
The Transaction Decode Setup dialog box is displayed.

2 Click File > Open.

3 Inthe Open dialog box, select the Transaction decode (.tdprop) file that contains the device setup
details.

4 Click Open.

You can edit a saved .tdprop file by opening it in an XML Editor or the Transaction Decode Setup
dialog box.

Viewing the Configuration Space of a DUT

While computing decoded transactions, the Logic and Protocol Analyzer software automatically
discovers and reads details from various PCle configuration registers in the DUT’s configuration
space. It displays register values for DUT’s capabilities such as PCI, PCle, Power Management, MSI,
MSI-X, Advanced Error Reporting, and any Vendor-specific capabilities.

To view the configuration space of a DUT

1 Compute decoded transactions in the Transaction Decode tab.
2 Click the Config Space Summary button displayed in the top panel of the Transaction Decode tab.

1 Transaction Decode | Compare 1 |

Synchronize - - Mavigation Event Config Space

= 14 =[] out of 17 &venl;s PCI [Cap. Pointerl] DWW 13 [Coﬂﬁg Space Summary.

The configuration space summary of the DUT is displayed.
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‘ Configuration Space Summary E’@
Eile
Field Value Width Bit(s)
. - ConfigSpace
Device 002:00:0
PCT {0w00)
= PM (0xC0)
Power Management Capabilities 00003 16
Mext PTR OxCB 8
Capability ID Ox01 8
Data Register 000 8
Bridge Support Extensicn 000 8
PM Status/Control 00000 16
MSI PVI(64) (0xCE)
MSI-X (0xEQ)
= PCle (0x70)
=l PCI Express Capabilities 00002 16
Reserved 0x0 2 15.14
Interrupt Message Number 0x00 5 13.9
Slot Implemented O 1 8
Device/Part Type PCI Express Endpeint (0x0) 4 7.4
Capability Version 02 4 3.0
Mext PTR Oxd 8 o=

Configuring Timestamps Displayed in the Computed Transactions

Each computed transaction has a timestamp displayed for it. You can configure:
where you want the timestamp field to be located for the computed transactions.
the base to be used for the calculation of timestamps of transactions.

To configure timestamp settings

1 Right-click the Timestamp field displayed for a computed transaction.
2 Select Timestamp Base from the context-menu.

e e e

Transaction Type i PI AHCI PxCl (W)
| 545611 M 006:00:0 || Down |
— GotoD... AHCI IS (R)
D Devica Dir Tim
| 545612 | | 006:00:0 | | Down | | 59.221 Go To Packet AHCI PxIS (R)
ID Device Dir Tim Visualize Transaction... Ctrl+LeftMouse AL S
. AHCI PxSERR (R)
|| 545613 || 006:00:0 | | Down || 59.22] Clear Transaction Data... A S
ID Devica Dir Tim
| 545614 | | 006:00:0 | | Down | | 59.22] I m [
D Devica Dir Tim i . .
| 545615 | | 006:00:0 | | Down | | 59.221 Timestamp Location r Relative
ID Devica Dir Timestamp Transaction Type PI = Relative Marker ,

3 From the displayed submenu, you can select:

Absolute - Timestamp for a transaction is calculated on the basis of the absolute time of the
first PCle packet applicable for that transaction. This is the default selection.

Relative - Timestamp for a transaction is calculated relative to the time of the first packet
applicable for the previous transaction in the list.
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Relative Marker - Timestamps are calculated relative to the marker that you select from the
displayed submenu.

Changing the timestamp base recalculates the displayed timestamps based on the selected
base.

4 Right-click the Timestamp field displayed for a computed transaction and then select Timestamp
Location from the context-menu.

5 By default, timestamps are displayed in the front of transactions data. If required, you can move
the display of timestamps to the back of transactions data.

Saving the Computed Transaction Data

Once you computed the transaction data, you can save it in a logic analyzer .ala configuration file.
The transaction data is saved along with the captured PCle traffic, device setup details, and any
other configurations that you made in the Protocol Viewer window.

NOTE You do not need the Transaction Decoder software license to view the saved transaction data.

However, if you want to recompute transactions from the saved PCle trace, then you need the
Transaction Decoder software license.

To save the computed transaction data
Click File > Save as.
In the Save As dialog box, specify the name of the file.

Ensure that the Standard Configuration (*.ala) option is selected as the file type and All Data and Setup
is selected in the File Options group box.

4 Click Save.

To access and view previously saved transaction data

Click File > Open.

2 In the Open dialog box, navigate to the Standard Configuration (*.ala) file in which you saved the
transaction data.

3 Click Open.

Clearing the Computed Transaction Data

You can clear the computed transaction data displayed in the Transaction Decode tab.
1 Right-click a transaction displayed in the Transaction Decode tab.
2 Click Clear Transaction Data... from the right-click context menu.

Transaction Type | Port | Command Issue

141788 s |

Go to ID...
Payload
| Mem L ez e * ||| 0x00000005 |
Visualize Transaction... Ctrl+LefthMouse Payload
| Mem Clear Transaction Data... | | Ox00EABDZY |
T T re T T " —— Fimealmm A

3 Click Yes to confirm.
The computed transactions display is cleared.
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If the transactions data was previously saved in an .ala file, then reloading the .ala file redisplays
the transactions data after it has been cleared. If the transactions data was not previously saved,
you can specify the data range and then click Compute again to redisplay the transactions data.
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Interpreting and Navigating Through the Transaction Decode Results

Transactions are decoded and computed from a set of captured PCle packets that contain the
storage protocol information associated with that transaction.

Decoded transactions are displayed in the Transaction Decode tab in an order based on the
timestamp of the first packet associated with a transaction. One or many PCle packets may be
associated with a transaction.

Transaction Details Pane

In the left pane of the Transaction Decode tab, transactions with their details are displayed. In this
pane, a transaction is uniquely identified by a Transaction ID.

The details displayed for transactions vary based on their type and the applicable storage protocol.
Moving the mouse pointer to a field of a transaction presents a tool tip with information about that

field.

1D Device Transaction Type Requestor ID Completar ID  SQT Timeastamp

1004 | 001:00:0 Q:3 || NWMe I[/O Sub Queus Tall DB (W) 000:00:0 000:00:0 13 14912789557 5 ||
i Transaction Type  Requestor ID  Completer ID CID PS[}T FUSE OPC  NSID MF

1005 B 001:00:0 Q:3 NVMe Read 001:00:0 000:00:0 Normal || Read 1 0x0000000

D Device Transaction Type Requestor ID Completer ID  Cnj Field
1006 | 001:00:0 Q:3 | NVMe I/O Comp Queus Entry 001:00:0 000:00:0 | | E Fused Operation (0} -

D Device Transaction Type Requestor ID Completer ID  1st BE Ad Ej;:dalh e ?
1007 || 001:00:0 Q:3 MSI-X Interrupt 001:00:0 000:00:0 0xF OxFE Fused Op, 2nd Cmd 3

D Device Transaction Type Requestor ID Completer 10 Reserved 3
1008 | 001:00:0 Q:3 | NVMe I/O Comp Queus Tail DB (W) 000:00:0 000:00:0 13 14.912859042 = |

A color coding scheme is used to clearly indicate transactions of different types. Errored transactions
are displayed in red.

o Device Transaction Type Requestor ID Completer ID 5qQT1 Timestamp

438 125:00:0 NWMe Admin Sub Queus Tzil DB (W) 000 30:0 000 00:0 =3 20.399457053 5 ||

o Device Transaction Type Reguestor ID Completer ID CID PEDT FUSE apC

439 129:00:0 NvMe Creats I/O C{:ump Queue 129:00:0 000:31:1 5 [+] MNormal Create I/0 Completion
D Device Cammand Specific | D}
440 129:00:0 NWMe Admin C::-mp JQueue Entry [UC) 179:00:0 000:00:0

I Device Transaction Type Requestor I Completer ID 1st BE Addrass Payload Timest
441 129:00:0 Memory Write 32b (Genl.2) 12%:00:0 000 00:0 OxF 0= FEECDOCO I:le:IUEI'EMUE-I} 20.395949

Unsuccessful Completion response in the Admin
Completion quene

If you are displaying data captured from multiple U4301A/B modules in a single Protocol Viewer
NOTE instance, then transactions from these multiple modules will be interleaved based on the
timestamp of the first packet in the transaction.

To display transactions for each module separately, you can add a Protocol Viewer instance to
each module in the Overview pane of the Logic and Protocol Analyzer GUI.

Refer to the topic “Viewing NVMe Transactions" on page 111 and “Viewing AHCI Transactions" on
page 120 to get an understanding of how NVMe and AHCI transactions are decoded and displayed.
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Transaction Overview Pane

The right pane of the Transaction Decode tab displays statistics for the computed transactions. This
pane lists the transaction types applicable for the computed transaction data and the number of
events/occurrences for each transaction type in the computed data.

1T Owverview Properties
COrganize by: | By Directions w

: NWMe / Directions-= PCle-102:Down | PCle-102:Up' Total i
Config Read Type 0 (Genl.Z) 593 0 555 i
: Config Write Type 0 (Gen1.2) 262 262

| MSI-X Table

Memory Wnite 32b (Genl.2)

 NVMe CAP(31:0) (R)

NVMe CAP(63:32) (R) 1
 NVMe CC (R)

 NVMe AQA (W)

: NWMe ASQ (W)

: NVMe ACQ (W)

 NVMe CC (W)

: NVMe CSTS (R)

MyWMe Admin Sub Queue Tail DE ( 32
MNWMe Admin Comp Queue Head [ 32

Fd — 1 4 1 o a pd s —
[ R o R o Y o R e R e e R o e I e N e |
Bl — . 4 1 1 1 R e

In this pane, you can organize the number of transaction occurrences/events on the basis of the
organization types described below:

Directions: Transaction occurrences are organized on the basis of the Uplink and Downlink
directions in the captured data.

If the captured data is unidirectional, then this view displays occurrences for one direction only.

Configuration Space: Selecting this option displays the number of occurrences of only PCle config
space transactions organized on the basis of reads and writes to PCle configuration registers in
the DUT’s configuration space.
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Cwerview Properties

Crganize by [Cu:unﬁguration Space v] [i}_U}j_[,‘l,U,’;[[ v]—DE‘fifEm

PCle f Rfw-= Read wiite Total
PCI [Status, Command]] DWW 1 48 37 85
PCI [BIST, HT, LT, CLS]] D'w 3 385 4 389
PCI [Max Lat, Min Gnt, Intr Pin, Intr Line]] DWW/ 15 14 19 33
PCle [Dev Status, Dev Control] D 2 7 4 11
PCle [Link Status, Link Control] D 4 g 3 12
PM [PMC, Mext Cap, Cap ID] DWW/ 0 3 0 9
i PM [Data Reg. PMCSR_BSE, PMCSR] D/ 1 3 2 11
| MS1(32) [Message Control, Wext Cap, Cap (D] 0w/ 0 8 3 11
PCI [Dev 1D, Vend ID]] DWW O 783 1 734
PCI [Class Code, Rev ID]] Dw 2 B3 0 53
PCI [Cap. Pointer]] D/ 13 13 0 13
PCI [BAR O] Diwf 4 20 3 29
PCI[BAR 1]] D/ 5 20 3 25
PCI [BAR 2]] D\wf 6 20 3 29
PCI [BAR 3] Dwwf 7 20 3 25

Queues (Applicable only for NVMe decoded transactions): Transaction occurrences are organized on the
basis of the NVMe submission/completion queues applicable for transactions. Ensure that you
select By Queues in the Organize by field to organize occurrences by queues. The field next to
Organize by listbox displays the device ID for which the displayed queues are applicable. If
multiple devices are involved, then this field provides you multiple options representing device IDs
of multiple devices. The following screen displays organization by five queues (0 to 4) of the
device with device ID (001:00:0).
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Oroanize by |B:.-' Queues v| |UE'1:DD:EI v|

.
 NVMe / Queues-> 01123 |4] Total
 MSI-X Table 100 0 0 1
 NVMe CAP(31:0) (R) 2 00 0 0 2
| NVMe CAP(£3:32) (R) 1M 00 0 0 11
 NVMe CC (R) 100 00 1
 NVMe AQA (W) 100 00 1
| NVMe ASQ (W) 100 00 1
| NVMe ACQ (W) 100 0 0 1
 NVMe CC (W) 100 00 1
 NVMe CSTS (R) 2 00 0 0 2
' NVMe Admin Sub Queue T2l DB(W) 32 00 0 0 32
 NVMe Identify 2 00 00 2
ENVME Admin Comp Queue Entry 32 00 0 0 32
: MSIX Intermupt 46 08 128 25 207
EN‘-."ME Admin Comp QueveHead DE(W) 32 00 O 0 32

- Devige 1D for which queues are displayed
Queues of the selected device ID

i

Ports (Applicable only for AHCI decoded transactions): Selecting this option displays the number of
occurrences of only AHCI port-specific register transactions organized on the basis of reads and

writes to AHCI port registers of the DUT.

The field next to Organize by listbox displays the AHCI device ID for which the displayed ports are
applicable. If multiple devices are involved, then this field provides you multiple options
representing device IDs of multiple devices. The following screen displays organization by two
ports (0 and 1) of the device with device ID (006:00:0).
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- Overview Properies
Organize by: [F"curts - ] [[H]':i 00:0 }—‘7 Device IDfor which portsare displayed
AhCl/ Ports-> 0 1 Total AHCI ports supported by the
AHCI PxSACT (R) 0 1795 1795  device
AHCI PxCI(R) 205 1302 2007
AHCI PCl 0w 0 606 605
AHCI PxIS (R) 206 606 a2
: AHCI Pxls () 1 602 603
| AHCI PxSERR R 206 &1 a0e
AHCI PxTFD (R) 205 B13 818
AHCI PxSACT (W) 0 k87 hE7
AHCI PxCLE () 1 1 2
AHCI PxCLBU () 1 1 2
AHCI PxFB (W) 1 1 2
AHCI PxFBU (W) 1 1 2
AHCI PxIE (R) 1 L7 G
AHCI PxCMD (R) 308 15 323

Navigating Through Transactions

You can easily navigate through the occurrences of a particular type of transaction in the computed

transaction data.

1 From the Transaction Overview pane on the lower-right, select a transaction type whose
occurrences you want to navigate and view.
The navigation bar in the Transaction Decode tab now displays the total number of occurrences
found for the selected transaction type.

Mawvigation Event Cwerniew Properties
(1][@ = 1[EE) outof 2 evens [ i) Wt fdmin Sub Quenel iy o0
MNSSRO SHST CF5 RDY Timestamp 2| MVMe / Queuss->
| 0 || Normaloperation || 0 || 0O || 12.350936542s | NvWMe CC (R)
MSSRO SHS5T CF5 RDY Timestamp MNWVMe AQA (W)
| 0 || Normal Dperatiun || 0 || 1 | 12.363402179 5 | NVMe ASQ (1)
000:00:0 12. 3?91}{]3311 ] NVMe CC ()
- IPSDT! [TFUSEN [WOPCT [NSIDI IEMPTRINEE | \yMecsTs (R)
0 || 0 || Normal || Identify || O || Ox00000000000000( _
Cumpleter jinj I:ml:l Spc SQID SQHD DNR M sSCT .
LATR TR RN R TR RE | 1 11 1 1 N ol senane — NVMe |dEI'ItIf‘}.I'
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2 To view the first occurrence of that transaction type in the computed data, click I4 button in

the navigation bar. Click @ to go to the last occurrence of the selected transaction type.

3 To sequentially move through the occurrences of a transaction type, use the B buttons in

the navigation bar.

4 To go to a specific occurrence of a transaction type, specify the event/occurrence number in the
text box displayed in the navigation bar and click Ge.

You can also double-click a particular occurrence number in the right pane to navigate to the first
transaction mapped to that occurrence number. For instance, in the following screen, the first
occurrence of an NVMe Read transaction for Queue 4 is highlighted on double-clicking its
occurrence number in the right pane.

Mavigation [1- Owerview Properties

EINJZ |EndD‘fPaired Data v|[ Compute ] @ c) Ga Bﬂutoflievﬂnts Organize by: |B3-' Queues v| |ﬂ'D1:DD:CI v

Transaction Type Reguestor ID Completer ID CQH Times ™ || NVMs/ Queues-> 0 1 /213 14

Ae I/O Comp Queue Tail DB (W) 000:00:0 000:00:0 1 12.8955 NVMe Create /O CompQuess & 00 0 0O

Transaction Type Requestor ID  Completer ID  SQT Timesta NVMe Create /O SubQueue & 00 0 O

Ae I!O Sub Queue Tail DB {W:] 000:00:0 000:00:0 1 12.909413 - NWMe Delete 10 Sub Queue 4 00 0o

nsaction Type Reguestor ID  Completer ID  CID  PSDT FUSE QPC ~ | NVMe Delete 110 CompQueuse 4 00 0 0

{WMe Read ! 001:00:0 ! 000:00:0 ! 0 ! 0 ! Mormal ! Read ! NVMe /O Sub Queve Tail DB 0 14 8 128 25

Transaction Type Requestor ID Completer ID Cmd Spc SQID 5 MNVMe Read 0147 111

Ae I/O Comp Queue Entry 001:00:0 000:00:0 4] 4

— WvMe /O Comp Queue Entry 0 14 8 128 25

Navigating Between Transactions and their Associated Packets

From a transaction listed in the Transaction Decode tab, you can quickly navigate to the PCle
packet(s) exchanged for that particular transaction. To accomplish this, you need to double-click a
transaction in the Transaction Decode tab. Doing so, highlights the packet exchanged as the first
cket for that transaction in the upper pane of the Protocol Viewer. You can also use the Synchronize
i‘ Lbutton in the Transaction Decode tab to synchronize the display of packets data with the
selected transaction.

In the following screen, double-clicking the transaction for modifying controller settings highlights
the memory write packet for this modification.
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F

ZJample Numnber ' Tine PCI-Express Packet Link Speed Directior

fPEE el H A

| =

.
L)
[+]

Transaction Type | Reques
NVMe CC (W)

NOTE You can also quickly navigate from a PCle packet displayed in the upper pane to its applicable

transaction in the Transaction Decode tab. To accomplish this, you select the packet and then
click the Synchronize 3 button displayed in the Transaction Decode tab. This synchronizes
the display of transactions with the selected packet.

Navigating to a specific packet of a transaction
A transaction may have multiple packets associated with it. For such transactions, you can directly
navigate to any packet of the transaction. To do this,
1 Right-click a transaction.
2 Select Go To.
A list of packets applicable for that transaction are displayed in a sequential order.

865 0 001:00:0 Q:1 NVMe Read 001:00:0 Qo0:00:0 1 0 Mormal | R
1D Device Transackic — ME""':"‘*'_Read_ 32b (Gen1,2) md Spc S0
866 | | 001:00:0 Q:1 | NVMe I/O Comp  Visuslize PRP... Completion with Data (Gen1,2) 0 [l 1
1D Device Transaction Type  Regquestor ID Cn |35 Payl
867 | | 001:00:0 | | MSI-X Interrupt || 001:00:0 || ( Memory Write 32b (Gan1,2) 000 | | Ox000
D Device Transaction Type Memory Write 32b (Genl,2) 'D COH
868 | 001:00:0 Q:1  NVMe I/O Comp Queue Tail DB (W  Memary Write 32b (Gen1,2) [ 1 |]1

3 Select a packet from this list. The packet that you selected gets highlighted in the upper pane of
the Protocol Viewer.
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Illﬂg Sample Number Time

Visualizing a Transaction Set (Super Transaction)

PCI-Express Packet Link Speed

Direction

At times, you may want to visualize a decoded transaction as a super transaction with all its related
transactions forming a complete set. This provides a visual sequential flow of transactions that were
related to a particular transaction.

To visualize a transaction set

1 Right-click a decoded transaction.

2 Select Visualize Transaction... from the context menu.

For instance, in the following screen, the NVMe Identify transaction has been visualized as a

complete set of transactions.

I 607: NVMe Identify

Address Type  #PCle TLPs Size
= NVMe Identify MYMe 1 4096
0x00000000D0C01000  SQDE 1
0x000000023ED4F000  PRP 1 32 4096
0:000000023ED42010 CQ 1
0x00000000FEEQOOO0  MSI-X 1
0x00000000D0C01004  CQDB 1

1

n

| »

PRP Payload |DWeord v | [4 Columns + | [Little Endian ~ |

2a3aa083:
2a200813:
2380823
28220233
28380243
2a28aaa:
28200863 :
2380873
2380853 :

5D7as088
[ageagaa
falataleyalelsls]
aaagaeea
2aagaeea
aaagagaa
[ageagaa
[lataleyalelsls]
@3a9808a

aeaaeaoa
aeaaeaca
aeaaeaoa
aeaagaee
aeaaeaen
deaaeaca
aeaaeaca
aeaaeaoa
a3a%e00s

SD7aEe80
a3laa38e
aaeades
aaeaaeae
aaeadese
aaeaaeae
paeadeae
aaeadese
aaeCaese

2ea28a88
2ea2ealFr
aeageaes
2Aea2e288
aladalealslstc]
2eagaaes
Aea2ea88
2ea28a88
2aealeases

PCle Packets [Nﬁted {Time Ordered) "] Show Completions

ID
SQDB

Packet
Memaory Write 32b (Genl,2)

Timestamp Delta

0s 0s

I PRP 1.1 Memory Write 8db (Genl,2) 19.286us 18.8(
PRP 1.2 Memory Write 84b (Genl,2) 19362 us 7O ns

PRP 1.3 Memory Write 84b (Genl,2) 19438 us 76 n=

PRP 14 Memory Write 84b (Genl,2) 19514 us 76 n=

PRP 15 Memory Write 84b (Genl,2) 19590 us 76 ns

PRP 1.6 Memory Write 84b (Genl,2) 19666 us 76 n=

PRP 1.7 Memory Write 84b (Genl,2) 19742 us 76 n=

PRP 1.2 Memory Write 84b (Genl,2) 19818 us 76 n=

PRP 19 Memory Write 84b (Genl,2) 19894 us 76 n=

PRP 110 Memery Write 84b (Genl,2) 19970us 76 n=

In the above screen, the transaction set for the NVMe Identify transaction:
begins with the SQDB (Submission Queue Doorbell) transaction.

followed by the SQ (memory read and completion with data) transaction and then the PRP entries
used for the Identify command.

then the Command Completion entry to the Completion Queue (CQ) transaction.

then the MSI-X interrupt generation transaction.
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finally the CQDB (Completion Queue Doorbell) transaction.

For each of these related transactions in a set, you can view:
the associated raw payload in the lower pane.
the applicable PCle packet(s) in the right pane.

NOTE Clicking a super transaction displays the combined payload for the complete set of

transactions.

PCle Packets applicable for a Transaction Set

In the right pane of the Visualize Transaction dialog box, by default, PCle packets are listed as per the
Nested (Time Ordered) option. This means packets are listed in a time based sequence with the
completion packets nested within the applicable Read packets. If required, you can change this

display to:
list the packets in a logical sequence instead of time based sequence - Logical (Not Time
Ordered) option.
list the packets without nesting the completions within the read packets - Packets (Time
Ordered) option.
PCle Packets)| Packet (Time Crdered) "J [4] Show Completions Acks
1D f:-lested {Time.{]n:lered]l Timestamp Delta Time
| P51 M | ogical (Not Time Ordered) s 0s
CmdList " 379 ns 379 ns

For each of the listed packets, the following time related fields are displayed:

Timestamp - This field is relative to the timestamp of the first packet displayed for the transaction
set. (The first packet timestamp is taken as 0s.).

Delta Time - This field displays the difference between the timestamp of the currently selected
packet and the previous packet in the list of packets for the transaction set.

PCle Packets |Logical (Not Time Ordered) ¥ | [¥] Show Completions [¥] Acks
D Packet Timestamp Delta Time
PxCI Memory Write 32b (Genl,2) 0= 0s
CmdList Memory Read 64b (Genl,2) 379 ns 379 ns
Cmdlist  Completion with Data (Genl,2§ 635 ns 256 ns
CFIS  Memory Read 64b (Genl,2) 1.047 us 412 ns
CFIS  Completion with Data (Gen1,2y 1324 us 277 ns

You can enable or disable the display of Completions and Acks packets from the packets list in the
right pane using the Show Completions and Acks checkboxes respectively.

To get visualize transaction information specific to storage protocols, refer to “Viewing a Complete
Set of Transactions for a Command Submission and Completion" on page 114 and “Visualizing a
Complete Set of AHCI Transactions" on page 124.
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Viewing NVMe Transactions

Previous help topics described how you can configure and compute transactions in the Transaction
Decode tab. This topic is specific to NVMe transactions and provides examples of how you can
interpret NVMe transactions that are computed and displayed in the Transaction Decode tab.

The decoded NVMe transactions provide you a sequential view of the communication cycle between
the host software and NVMe controller for various requests placed by the host software in queues.
You can check how the NVMe controller responds to and completes these requests. At the

administrative management level, you can verify how the NVMe controller handles admin requests
such as queue management requests.

For NVMe, the Transaction Decode tab displays transactions for:
NVMe controller initialization such as Admin queue configuration
NVMe Admin and I/0 commands submission and their responses (completions).
MSI-X interrupts initiations by controller

NVMe I/0 submission and completion queues management

Viewing Transactions for NVMe Controller Initialization

The following screen displays a set of transactions for NVMe controller initialization. The AQA, ASQ,
and ACQ registers are modified to define the Admin Submission Queue and its corresponding Admin
Completion Queue. The transactions display the Admin queue attributes in terms of size (128 entries)

and the base address (64-bit physical address) to be used for Admin submission queue and
completion queue.

Header | Payload | Lanes | Traffic Overview | Image View | LTSSM Cverview  Transachion Decode . Compare 1
Settings Data Range Nawigation
[SEUJp...] \Begin Of Paired Data w | to: | End Of Paired Data  ~ | | Compute | F] |c" Go 1 B out
D Device Transaction Type Requestor ID Completer ID |ACQS  ASQS Timestamp
589 003:00:0 NWMe AQA (W) 000:00:0 oooQ:00:0[ 1| 127 127 64.18%07079¢
D Device Transaction Type Reguestor ID Completer ID ASQB Tirr
590 003:00:0 MNWMe AS0 (W) 000:00:0 000:00:0| ¢ OxO00000023ED40000 | 64.18
D Device Transaction Type Reqguestor ID Completer ID ACQB Tirr
591 003:00:0 MNWMe ACQ (W) 000:00:0 000:00:0 Ox000000023ED42000 | 64.18
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Viewing Admin Command Transactions

The following screen displays transactions related to the Identify command submission and
completion to return capabilities and status of a specific namespace.

Requestor ID Completer ID  SQT Tir
Qoo:00:0 000:00:0 2 || 64.2]

ID Device Transaction Type
1112 | 003:00:0 |~ NVMe Admin Sub Queue Tail DB (W) | |

000:00:0 0 | Identii

Requestor ID Completer ID Cmd Spc SQIC
003:00:0 Q00000 Q 0

003:00:0 MyWMe Identify

D Device Transaction Type
1114 | 003:00:0(/[ NWMe Admin Comp Queus Entry | |

003:00:0

Host writes to NV Me Admin submission quene 0 request namespace capabhilities

Controller returns the namspace data structure in multiple me mory writes to PRP
entries

You can further view the namespace capabilities returned by the Identify command by right-clicking
the NVMe Identify transaction and selecting Decode Payload.

112

(8 Decode Payload (o] O]
Eile
Field Description Value
= Identify Namespace Response 4
MSZE Mamespace Size Ox0000000050708000
MCAP Mamespace Capacity Ox0000000050708000 |2
MUSE Mamespace Utilization :0000000000000000
MSFEAT Mamespace Features 0
MLEAF Mumber of LBA Formats 3
FLBAS Formatted LBA Size (w10
MC Metadata Capabilities 003
DeEC Endtoend Data Protection Capabilities 0=1F
DPs Endtoend Data Protection Type Settings (00
MMIC Mamespace Multipath IO and Mamespace 5k 000
RESCAP Reservation Capabilities 000
Reservedl ReservedBlockl 88 Bytes
EUIS4 IEEE Extended Unique Identifier (x0000000000000000
LbaFormatDescriptors LBA Format Descriptors
= LBAFD LBA Format 0 Support
RP Relative Perfarmance 0x3
| LEADS LEA Data Size |9 h
4 LI

You can also visualize how the data returned by the Identify command is stored in specific PRP
entries by right-clicking the transaction and selecting Visualize Transaction... (see page 116 for

details).
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2 607: NVMe Identify

Address Type #PCleTlPs Size PCle Packets | Mested (Time Ordered) "l Show Completions Ac
= NWMe Identify MY Me 1 4096
0x0000000000C01000 SQDE 1 ID Packet Timestamp Delta Time
0x000000023ED40040 S0 1 PRP 11 Memory Write 64b (Genl 2) 19.286 us 18.802 us
0x000000023ED4F000 PRP 1 324096 PRP 1.2 Memory Write 64b (Genl,2) 19362us 76 ns
(e000000023ED42010 CQ 1 .
0x00000000FEEDODOD  MSI-X 1 PRP 1.3 Memory Write 84b (Genl,2) 19438 us 76 ns
0x0000000000C01004 CQDB 1 PRP 1.4 Memory Write 84b (Genl,2) 19514 us 76 ns
PRP 1.5 Memory Write 84b (Genl,2) 19520 us 76 ns
PRP 1.6 Memory Write 84b (Genl,2) 19.666us 76 ns
PRP 1.7 Memory Write 84b (Genl,2) 19742 us 76 ns
F E PRP 1.8 Memory Write 84b (Genl,2) 19.818us 76ns
PRP Payload |DWord ¥ | [4 Columns v | [Little Endian ~ PRP 1.9 Memory Write 64b (Gen12) 19894 us 76 ns
20900908: 50705900 02090893 SD7OEG09 DOABEREE . PRP 110 Memary Write 64b (Gen1,2) 19.970us 76ns
fEE0OR10: ARERARED BREEROGE B31A8300 GEAPERLF ;
GADE0G20: GADEOGDE HAADE0GD DAGADEDE BOAGABEE PRPL11 Memory Write 64b (Genl.2) 20046us 76 ns
POSEOR3E: AOOCORED AROEGORE DABESGER DRABEEGA PRP 112 Memary Write 64b (Gen1,2) 20122 us 76ns
f0900R40: GDOOORED ABDERORE BABEERAR DEABEERA ;
POAGERSH: GARCARAD DEAZGOSE 0OSRPRIE PBIGRARA B e e e SLiie oo
QO00RG0: AOR0ORED R0EGORE DAGERGOR DBABEREA PRP 114 Memary Write 64b (Genl,2) 20.274us 76ns
PEE00RTE: AREOORED GROE0ORE PAGEE0OR DEAGEEEA PRP 115 Memony Write 64b (Genl.2) 20350 us 76 ns

Viewing NVMe I/0 Command Transactions

The following screen displays an NVMe Read transaction to read data from the starting LBA specified
in the Read command.
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ple Num (Time PCI-Expresz Pack Direction Address, Register Number

{PCIe-10Z2:Up  [Address=78FL 0000

Wi s v

leader | Payload | Lanes | Traffic Overview | Image View | LTSSM Overview ' im,uauim Decode PCle Peformatce O

tings Data Range Mawvigation
etup..| |Begin Of Paired Data w | to: |End Of Paired Data | [ Compute | @](’* Gn 1E]u

Device Transaction Typs Requestor ID | Completer ID  SQT Time
001:00:0 Q:1 | | NVMe I/O Sub Queue Tail DB (W) | 000:00:0 | 000:00:0 | 1 || 13.862

MNyWMe Read

001:00:0 Q:1 001:00:0 Memory Read 32b (Gen1,2)
Device Transaction Type Rl  Visuglize PRP... — Completion with Data (Genl,2)
001:00:0Q:1 | NVMe I/O Comp Queue Entry || 00LT00°0 77 0 Memory Write 32b (Gen1,2)

Deavice Transaction Type  Requestor ID  Completer ID  1st Memaory Write 32b (Gani,2)
001:00:0 || MSI-X Interrupt || 001:00:0 || 000:00:0 || Ox  Memary Write 32b (Geni,2)

Device Transaction Type Requestor ID ~ Memory Write 32b (Gen1,2)
001:00:0 Q:1 | | NVWMe I/O Comp Queue Tail DB (W)} | 000:00:0 | 000:00:0 | 1 []12.8i

For this transaction, the controller:

first performs a Memory Read to read the request entry from the base address of submission
queue 1.

then fetches the requested data from system memory
then performs multiple Memory Writes to write this data to the applicable PRP entries for data
transfer to host.

In the transaction following the NVMe Read transaction, the controller updates the completion
queue 1 with the status of the Read command completion.
Viewing a Complete Set of Transactions for a Command Submission and Completion

The following screen displays a complete set of NVMe transactions between the host and controller.
This set of five transactions represents the steps involved in the NVMe Write command submission
and completion process.
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ID Device
1000 | 001:00:0 Q:
ID Device
1001 | | 001:00:0 Q:
ID Deavice
1002 | | 001:00:0 Q:
ID Device
1003 | 001:00:0 Q:

001:00:0 Q:3

Computing and Viewing Decoded Transactions 11

Transaction Type Requestor ID | Completer ID | SQT
NYMe I/O Sub Queue Tail DB (W 000:00:0 000:00:0

Requestor I Completer ID CID  PSDT FUSE
001:00:0 000:00:0 | 12 || O || Normal '

Requestor I Completer ID Cmd Spc S

Transaction Type
NVMe Write

3 o .
Transaction Type

3| NVMe I/O Comp Queue Entry || 001:00:0 | 000:00:0 || 0
Transaction Type  Requestor ID  Completer ID 1st BE Address
3| MSI-X Interrupt | | 001:00:0 000:00:0 0xF | | OxFEE04000 | C

Requestor I Completer ID CQH
Q00:00:0 000:00:0 12

Transaction Type
3| | NVMe IJO Comp Queue Tail DB (W) | |

The following list describes the set of five transactions displayed above.

1
2
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The first transaction indicates to the controller that a command is submitted for processing.

The second transaction represents the NVMe Write command that the host created in the
submission queue. The controller reads this command from the submission queue for execution
and executes the command.

The third transaction represents the command completion entry that the controller writes to the
completion queue.

The fourth transaction represents the MSI-X interrupt generated by the controller to indicate that
a completion entry has been added to the completion queue.

The fifth transaction indicates to the controller that the host has processed the completion entry
that the controller added to the completion queue.

You can also visualize a complete set of related transactions (as a super transaction) by
right-clicking the transaction and selecting Visualize Transaction.... See page 109 for details on
this feature. The following is an example of how the set of transactions for an NVMe Read
command has been sequentially visualized.

&2 5819: NVMe Read

Addrezs Type #PClaTLPs Size PCle Packets | Nested {Time Ordered) ¥
=l NVMe Read MV Me 1 512
0x00000000D0C01008 SQDB 1 D Packet
I 0x000000023EDTEOOD SO 1 SQDB  Memory Write 32b (Genl,2)
0x000000023ED45560 PRP 1 4 512 | 5Q Memory Read 64b (Genl,2)
0x000000023E08E000 CQ 1 ——
0x00000000FEEO1000 MSI-X 1 i plekiouithtictadises
0x0000000000C0100C CQDE 1 PRPLL Memory Write 84b (Genl,2)
PRP 1.2 Memory Write 84b (Genl,2)
PRP 1.3 Memory Write 64b (Genl,2)
SQ Payload |DWerd ~| [4 Columns =/ [Little Endian = PRP 14 Memory Write 64b (Genl.2)
PBOEARE: GAEAEAGAI AEAPEARL BAREORAR PEARADEA CQ Memary Write 64b (Gen12)
PBOEABL: GAAEAGAD ABAGEABA 3ED4SSEE PEARADEZ _
8O0E6020: GODEOEHD DRODGERD 2OPBIGEE DEORBIGE MSI-X  Memory Write 32b (Genl,2)
PBAEEE39: GAPEAEEY AEAPEARE BARAPEER PBERAREA CQDE  Memory Write 32b (Genl,2)
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Viewing Decoded Payload for NVMe Commands

For NVMe commands that retrieve information from NVMe registers in a specific data structure
format, you can view the returned data structure in the same format as defined in the NVMe protocol
specifications. For instance, the Identify command or the Get Features command returns information
in a specific data structure format defined in NVMe specifications. The Transaction Decode tab
displays the decoded payload for such commands to present the data structure for such commands
as per the defined format.

To view the decoded payload of an NVMe command
1 Right-click the transaction displayed for the command in the Transaction Decode tab.

2 Select Decode Payload...

The Decode Payload dialog box is displayed with the payload fields matching the fields specified in
NVMe specifications.

The following screen displays the payload details of the NVMe Get Features command. The feature
for which the information is retrieved is LBA Range Type. The displayed payload is as per the data
structure format defined for LBA Range Type in NVMe specifications.

ﬁ Decode Payload EI\EI

Eile

Field Description Value

=

| B LBA Range Type Entry D
Type Type 0
Attributes Attributes 0
Reserved? ReservedBlock 12 Bytes
SLEA Starting LEA (0x0000000000000000
NLE Mumber of Logical Blocks 000000000507 08000
GUIC_U Unique [dentifier Upper 0 0000000000000000
GUID_L Unique Identifier Lower 0x0000000000000000
Reserved3 ReservedBlock 16 Bytes

Viewing Decoded PRPs for NVMe Commands

Physical Region Page (PRP) entries are used in read/write transactions to indicate the physical
memory locations in system memory. These memory locations are used by controller for data
transfers to and from system memory. For a Read request, the PRP entry indicates the memory
location where the controller should transfer the data read from system memory. For a Write
request, the PRP entry indicates the memory location from where the controller has to gather the
data to be written to the system memory.

These addresses can be directly a memory location or a pointer to a location that provides a set of
addresses of contiguous memory to perform large read/write operations.

In the Transaction Decode tab, you can view the PRP entries associated with a command that utilizes
PRP entries such as an NVMe Read or Write command.

To view the decoded PRPs of an NVMe command

1 Right-click the transaction displayed for the command in the Transaction Decode tab.
2 Select Visualize Transaction...

A dialog box is displayed with PRPs and other related transactions associated with the command.
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22 1279: NVMe Read

Address Type #PCleTLPs  Size PCle Packets | Nested (Time Ordered) "] Show Completions
= NVMe Read MV Me 1 512
0x00000000D0C01008 SQDE 1 D Packet Timestamp Delta Timr
Qu000000023EDTEZB0 S0 1 SQDE  Memory Write 32b (Genl,2) 0s 0s
0w 000000023E570DCO PRP 1 4 512 5Q Memory Read 64b (Genl,2) 280 ns 280 ns
Qxc000000023EDBEDAD COQ 1 . .

C etion with Data (G 484 204
0x00000000FEEO0000  MSI-X 1 3Q  Completion (Genl2) = =
0x0000000000C0100C CQDE 1 PRP 11 Memory Write 64b (Genl,2) 6.686 us  6.202 us

——M  PRP 12 Memory Write 64b (Genl2) 6762us  Thns

] m

| | v PRP 1.3 Memory Write 64b (Genl,2) 6.838us  Tons
PRP Payload [DWord '] [4 Columns 'l [Littie Endian '] l‘ PRP 1.4 Memory Write 64b (Genl,2) 6914us  76ns
DA2E00A0: 20000080 D2DADADE DA0BERAD DBAGE0BD 4 cQ Memory Write 64b (Genl,2) 7876 us 962 ns
22220010: 20020000 22022208 DADB2DAD DBARRDBA - ’
PRAAER2A: GDMOAGDD AGOPDAGE DAGEPDAA POAREREA |= MSI-X Memory Write 32b (Genl,2) 8664us 788 ns
2A200830: 20000980 02020208 CQ2E2RAY DERSRIBRA CQDB  Memory Write 32b (Genl,2) 10.200 us 1536 us
22200240 20080080 J2020008 BA0A2RA2 DBOSEIA b
2A2E0850: 20000080 D2DO0ODE BADE2RAE DBRGRDEA
2200060 20000080 J2020908 BA0A2RAR DERSRIA
DA2BEGT70: 20000080 D2DODADE BADB2RAE DBOGRIBA
2200050 20000000 D2D20008 DADB2DAD DOOGRIBA
DE289298: 28282280 2028228 BA2E2028 28I2B28A
PA2000AD: 20020980 02020928 CQ0R2RAY D002EI8a -

In this dialog box, you can find the following PRP related information.

Component displayed Description

PRPs applicable for the NVMe command

Raw payload for each PRP entry

Packets associated with each PRP entry

The displayed PRPs include:
= aPRP entry representing an actual physical memory page.
= aPRP representing a pointer to a page that defines a PRP List. For such a PRP, a set of PRP entries in a single

page of contiguous memory are also displayed underneath.
= multiple PRP lists for commands that require multiple PRP Lists for larger read/writes. The last PRP entry in

the first list points to the next PRP list used.

Clicking a PRP entry in the left displays the raw payload for that PRP entry in the lower pane of the dialog box.

Clicking a PRP entry in the left displays a list of its associated PCle packets in the right pane of the dialog box.
You can click a packet from this list to navigate directly to that specific packet in the upper pane of Protocol
Viewer. This can help you view the complete address range associated with a PRP entry.

Viewing Decoded MSI-X Table

To view index entries of the MSI-X table

1

MSI-X Table transaction type from the right pane.
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From the decoded MSI-X Table transaction, you can view the index entries of the MSI-X table in a
decoded readable format.
In the Transaction Decode tab, navigate to the MSI-X Table transaction by double-clicking the

2 Right-click the highlighted MSI-X Table transaction in the left pane of the Transaction Decode tab
and then select Decode MSI-X Table.
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Transaction Type  Reguestor ID | Completer ID Address

0:0 0xD0OC02000

003:00:0 MSI-X Table
D Device Transaction Go i ' Completer ID  1st BE Address
[| 5373 || i i || Memory Write 32b || 000:00:0 || OxF || 0xDOCD28

The decoded MSI-X Table is displayed.

#2 mMsi-X Table === E=l ===

|Iru:|e.x Address Message Deta Vector Control

xD0O00DOOFEEODOOD  OxOOOO40590  ChaDOOO0000
Ox00000000FEEDLO00  OxOOOO4090 (00000000
Ox00000000FEEQ2000 OxOOOO4090  Coo000O00000
Ox0D00O00000FEED3000  OxOOO040590  Chol0OO00000
(x0D0000000FEEG4000  OxDOO0M050  Chol0OOO0000
x0D0000000FEEOS000  OxOOOOM090  ChoDOOO0000
x0D0000000FEEORO00  OxOOOOM090  Chol0OOO0000
xD0000000FEED7000  OxOOOO4090  Chol0OOO0000
x0D0000000FEEDB000  OxOOO040590  ChaD0OOO0000
xD00O00DOOFEEDR000  OxOOOD40590  Chal0OOO0000
10 xD00O00DOOFEEOAQDD  OxDOO040590  ChaD0OOO0000
11 Ox00000000FEEOBOOD  OxOOOO4090 (00000000
12 Ox0D0000000FEEDCOO0  OxOOO0040590  Cool0OO00000
13 Ox0D0000000FEEODOOD  OxDOO04050  Chol0OO00000
14 (x0D0000000FEEOEQOD  OxOOOOM050  Chol0OOO0000
15 x0D0000000FEEORDOD  OxOOO0090  Chol0OOO0000
15 x0D0000000FEEODOO0  OxOOO04080  Chol0OOO0000
17 x0D0000000FEEODO00 OxOOO040590  Chol0OOO0000
18 Ox0D0000000FEEODO00  OxOOO04050  Chal0OOO0000
19 xD00O00DOOFEEODOOD  OxOOOO40590  ChaD0OO0000
20 xD00O00DOOFEEODOOD  OxOOO040590  ChaD0OOO0000
21 Ox00000000FEEODOOD  OxOOOO4090 (00000000
22 Ox0D0000000FEEODOO0  OxDOO040590  Chol0OO00000
23 (x0D0000000FEEDD000  OxDOO0050  Chol0OOO0000
24 (x0D0000000FEEDD000  OxDOO0050  Chol0OOO0000
25 x0D0000000FEEODOO00  OxOOO0M090  Chol0OOO0000
25 x00000000FEEODO00  OxOOO040590  Chol0OOO0000
27 Ox00000000FEEODO00  OxOOOD4050  ChaDOOO0000
28 Ox00000000FEEODO00  OxOOOD4050  ChaDOOO0000
25 xD0O00DOOFEEODOOD  OxDOOO40590  ChaDOOO0000
30 Ox00000000FEEODOOD  OxOOOO4090 (00000000
31 Ox00000000FEEODOOD  OxOOOO4090 (00000000
32 Ox0D0000000FEEODOO0  OxOOO004050  Chol0OO00000 w

an [ FEEAARRT F A AR P UL

V=l I R [ S AU R =

An MSI-X index entry is associated to a completion queue at the time of creation of the queue. You
can view details about the MSI-X index entry associated to a completion queue in the Completion
Queues tab of the Setup dialog box.
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11

: Device Setup
Completion Queues [ Submission Queues " Mamespaces
Queuss/Addresses Queue ID Size Address Int Vector
[= Admin Queus 127 I:IB
Address PEEEAREETIFS1008
= 1/0 Queue 1 1023 |:|B
" PEEEARERTSFEEARA
- = -
o PEEEAREATSFD3008
Actions
ladd Queus] lRemwe Queue Add Address

Help ]

Each MSI-X index entry in the MSI-X table has a base address associated to it. This is the address at
which the controller writes the MSI-X interrupt for the associated completion queue.

The following screen displays one such MSI-X Interrupt transaction for the completion queue 1.

| [Eahe |Bagin Cé Paices! Dt = |4 [End 0f Faiced Dt 7 || Cormpute | [ﬂ]'{fsﬂ
e et — | ——

- Evert
zlﬂﬂmﬁm[ﬂ

 TransactinTyps  RequestoriD Completer D CmdSpc SQID SQHD DNR M s
245064 | 001:00:0 || NVMe Admin Comp Queue Entry || D1:00:0 || 000000 (| o [ @ || 1 | o (o]

e
¢ Transaction Type || Requestor ID |} Completer 1D ) 23t BE || Address [
245085 [ 001:00:0 | M51-% Interrupt |  001:00:0 00000

Paylcad Thmestamp
OxF B OxFEECOO00 B 0x00004040 B 33.7T486169]1 =

Basze address of the MSI-X index

entry associated to the completion
queus
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Viewing AHCI Transactions

This topic is specific to AHCI transactions and provides examples of how you can interpret AHCI
transactions that are computed and displayed in the Transaction Decode tab. To get information on
how you can configure and compute AHCI transactions in the Transaction Decode tab, refer to the
following previous topics in this chapter.

“Transaction Decoding - Overview" on page 90

“Configuring and Computing Decoded Transactions" on page 91

“Defining / Verifying the Device Setup" on page 93

“Interpreting and Navigating Through the Transaction Decode Results" on page 102

For AHCI, the Transaction Decode tab displays transactions for:
PCle Config space registers
Generic host control registers
Port specific registers
SATA commands

The following sections provide examples of these decoded AHCI transactions.

PCle Configuration Space Registers Transactions - Examples

These transactions are PCle Config Read and Write requests to various configurations registers in
the DUT’s config space. You can view the PCI Header and PCI Capabilities for an AHCI device in
these transactions. Some examples of the registers that these transactions map to are:

PCI Header registers such as Identifier (Device ID), Class Codes, AHCI Base Address <BAR5>, and
Capabilities Pointer (CAP).

PCI Power Management Capability registers such as PMCAP
Message Signaled Interrupt Capability registers such as MSICAP

Transaction Type Requestor ID | Completer ID | 1st BE || Reg Num | Reg Offset | Cap Type | Base Address 5 Payload
Config WHE Type 0 (Genl,2 000:03:2 006:00:0 OxF 9 0x0024 PCI 0xD1C10000 0xD1C10000

Class Code Base Class Sub Class
Conﬁg Read Type 0 (Genl,2 000:03:2 006:00:0 0xF 2 0x0008 PCI Mass Storage Controller || SATA Controller/AHCI 1
Field Value
g Power Management 0x0003
Capabilities
PME Support 0x00
D2 Support Ox0
D1 Support Ox0
Aux Current O
Device Specific Initialization =~ 0x0
(DS}
PME Clock Ox0
Version 0x3
Power Management Capabilities [ Next P’
Conﬁg Read Type 0 (Genl,2 000:03:2 006:00:0 OxF 30 0x0078 PM 0x0003 0x8C

| pavinad |

0x00007805

Message Control Capabilities
0x0000

Conﬁg Read Type 0 (Genl,2 000:03:2 006:00:0 0x0050 MSI(32)
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The decoded transactions are a mix of PCle Config, generic host control, port-specific and SATA
commands transactions. If you are looking for specific PCle config space transactions, you may
want to use the Overview pane on the right. In this pane, you can choose to organize the registers
listing by Configuration Space. Doing so, displays the list of PCle configuration space registers in
this pane. You can then double-click the desired register from this list to navigate to the
transaction for this register in the left pane.

PCle config space registers are not displayed in the Overview pane if you have organized this pane
by Directions or Ports.

Crverview Properties

Organize by: [Cl:unﬁguratiun Space = | [{1]]3;0_[1’;{[ v {—Device D

PCle f Rw-= Read Write Total
PCI [Status, Command]] O 1 43 37 a5
PCI[BIST, HT, LT, CLS]] D\W' 3 385 4 389
PCI [Max Lat. Min Gnt, Intr Pin, Intr Line]] DWW 15 14 19 33
PCle [Dev Status, Dev Control] D/ 2 7 4 11
PCle [Link Status, Link Control] D 4 9 3 12
PM [FMC, Next Cap, Cap |D] Diw/' 0 | ] 9
| PM [Data Reg, PMCSR_BSE, FMCSR] 0w 1 | 2 1
| M5I{32) [Message Control, Meot Cap, Cap D] DWW/ 0 8 3 11
PCI[Dev 1D, Vend ID]] D/ O 783 1 784
PCl [Class Code, Rev 1D]] Diw 2 53 ] 53
PCI[Cap. Pointer]] D/ 13 13 ] 13
PCI[BAR O] D'w 4 20 9 29
PCI[BAR 1] DWW & 20 3 29

Generic Host Control Registers Transactions - Examples

Generic host control registers such as AHCI CAP (Host Capabilities) and GHC (Global Host Control)
are global HBA registers that are applicable for the entire HBA. The Transaction Decode tab displays
decoded transactions for these registers. The following screen shows some such transactions for
generic host control registers.
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< | m

fiID Device Dir Timestamp  Transaction Type MIR MNR Timestamp
|| 545604 | | 006:00:0 || Down || 1.091us || AHCIVS(R) ||0Ox0001/| I 0x0200 | | 59.221945343 5 |

545605 || 006:00:0 'AHCI”CAP (R)

| ID: || Dewvice || Dir Timestamp  Transaction Type APST NVMP BOH Timestamp

|| 545606 | | 006:00:0 | |Down || 635ns || AHCICAP2(R) || O || O | | 0 | | 59.221946623 5 |

| ID | Device | Dir  Timestamp  Transaction Type AE 'MRSM IE HR Timestamp

|| 545607 | | 006:00:0 | | Down || 625ns || AHCI GHC{R) il o |i 0|| 0||59.221947248 5 |

lieaID Device Dir  Timestamp | Transaction Type! 'AE 'MRSM 'IE 'HR  Timestamp

| 545608 | | 006:00:0 | |Down | 871ns || AHCI GHC {W} [[o]l] o | 0| 1 []|59.221948119 5 ||
D | Device _ Dir Timestamp  Transaction Type AE MRS5M IE HR. Timestamp

I| 545600 | | 006:00:0 | | Down | | 84 ns [| AHCIGHC(R) || 0 || O | | O | | 0 || 59221948203 s |

Port Specific Registers Transactions - Examples

AHCI port specific registers such as PcCLB, PxIS, PxSACT and PxCDM are applicable for each port
supported by an AHCI device. The read and write transactions to these port registers are also
displayed in the Transaction Decode tab. The following screen displays some examples of such ports
register accesses.

Transacktion Type | Port | Command Issue
547898 || D06:00:0 || Down | AHCI PxCI (R) 1 0x00000000 62.812769603 s

ID Device Dir Timestamp  Transaction Type Port Device Status Timestamp

| 547899 | 006:00:0 |Down | 163.84%9 us |  AHCIPxSACT(R) | 1 | Ox00000000 | 62.8129334525 |
I Device Dir Timestamp  Transaction Type Port  Command Issue Timestamp

|| 547900 | | 006:00:0  Down | 632ns | AHCIPxCI(R) | 1 | Ox00000000 @ 62.812534084 s
1 Device Dir Timestamp  Transaction Type  Port  Device Status Timestamp

| 547901 | 006:00:0 || Down || 648ns | | AHCIPxSACT (W) | 1 || Ox00000020 | 62.812934732 5 |
ID Device Dir Timestamp  Transaction Type Port Command Issue Timestamp

| 547902 | 006:00:0 |Down | 451ns || AHCIPxCI(W) | 1 | 0x00000020 | | 62.812935183s5
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The decoded transactions are a mix of PCle Config, generic host control, port-specific and SATA
commands transactions. If you are looking for a particular type of port specific transactions, you
may want to use the Overview pane on the right. In this pane, you can choose to organize the
registers listing by Ports. Doing so, displays the list of port registers in this pane and organize the
transaction occurrences by ports. You can then double-click the desired register from this list to
navigate to the transaction for this register in the left pane.

Port registers are not displayed in the Overview pane if you have organized this pane by
Configuration Space.

Owverview Froperiies
. . T Device I for which ports are displayed
Organize by: [F'l:urts - | [G'DE.DD.EI - —

ARCl/ Ports-= 0 1 Total AHCI ports supported by the
AHCI PxSACT (R) 0 1795 1795  device
AHCI PxCl (R) 205 1802 2007
AHCI PxCl (W) 0 605 605
AHCI PxlS (R) 206 605 812
| BHCI PxIS (W) 1 802 603
| AHCI PxSERR (R) 205 601 806
AHCI PXTFD (R) 205 &13 813
AHCI PxSACT (W) 0 587 587
AHCI PxCLE (W) 1 1 2
AHCI PxCLBU (W) 1 1 2
AHCI PxFE (W) 1 1 2
AHCI PxFBU (W) 1 1 2
AHCI PxIE (R) 1 5 B
| AHCI PxCMD (R) 08 15 323

SATA Commands Transactions - Examples

The decoded AHCI transactions also include transactions for SATA Commands such as Identify
Device, Set Features, Read FPDMA Queued, Write FPDMA Queued, and NOP.

The following screens display some examples of decoded SATA Commands transactions.
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Transaction Type Port | Command Header Address Features Command C.F
AHCI ATA Command SetFeature (R) 1 4 0x13E64EDO0 B Enable write cache || SET FEATURES § 1 || C

Transaction Type Port = Command Header Address Features Command CLR
AHCI ATA Command RDMA NCQ (R 1 28 0x13E64D800 0x00 READ FPDMA QUEUED 1 Q0

Transaction Type Port | Command Header Address Features Command CRRI§RLEF
I AHCI ATA Command Identify (R) 1 1 Ox13E64DE00 0x00 IDENTIFY DEVICE | 1 B O 0

Transaction Type Port | Command Header Address Features Command CIll R
AHCI ATA Command WRMA NCQ (R 1 16 0x13E64D800 0x08 WRITE FFDMA QUEUED 1 0

Visualizing a Complete Set of AHCI Transactions

You can view each AHCI transaction displayed in the Transaction Decode tab as a super transaction
to visualize its complete set of related transactions. To visualize the transaction set for an AHCI
transaction, right-click the transaction and select Visualize Transaction....

NOTE For a SATA command transaction such as Read FPDMA Queued that has a number of related
transactions, the Visualize Transaction feature is particularly useful.
For PCle config space or AHCI (generic/port) register transactions, the Visualize Transaction
feature displays the read/write access transaction to the register.

Example 1 - Visualize the transaction set for a NOP command transaction

&2 545806: AHCI ATA Command NOP (R)

Address Type # PCle TLPs PCle Packets | Mested (Time Crdered) "l Shoy

El AHCI ATA Command NOP (R} AHCI
0x00000000D1C101B8  PxCl i I Pocket L
0x000000013E648000 CmadLlist 1 PxCl  Memory Write 32b (Genl,2) {
0x000000013E648500 AHCI ATA Command NOP (R) 1 CndList Memory Read 64b {Genl,2) 4
Cmdlist  Completion with Data (Genl,2) 7
‘| = | - CFIS Memory Read 64b (Gen12) i
PxCl Payload |DWeord = ] [4 Columns = l [Ijttle Endian = l CFIS  Completion with Data (Gen1,2) 1

2a3ea0es: eadeagal

In the above example, the following transactions are a part of the ATA Command NOP super

transaction.

1 The first transaction is a memory write to the PxCl (Port x Command Issue) register to indicate
that a command has been built in memory for a command slot.

2 The second transaction is a memory read for the added command list entry.
The third transaction is a memory read of the NOP command from the command table.

Example 2 - Visualize the transaction set for a Write FPDMA Queued command transaction
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&2 555537: AHCI ATA Command WRMA_NCQ (R)
Address = PCle TLPs PCle Packets | Mested (Time Ordered)
| = AHCIATA Command WRMA_NCQ (R) AHC - ok
0x00000000D1C10188 PxCI 1 acket
0x000000013E648200 CmdList 1 PxCl Memary Write 32b (Gen!
0x000000013E64D800 AHCI ATA Command WRMANCQ (R) 1 CmdList Memory Read 64b (Genl
0x000000013E648400 DMA Setup FIS 1 Cmdlict Completion with Dat
= 0x000000013E64D880 Physical Region Descriptor Table 1 meLE ompletion wi &l
0xD000D00013CAEAQCD PRDT entry 0 15 CFIS Memory Read 64b (Genl
0x000000012E648458 Set Device Bits FIS 1 CFIS Completion with Data |
. = , DSFIS  Memory Write 84b (Gen!
PRDOT Memory Read 64b (Genl
Complete Payload [DWurd "] [4 Columns Vl [thtle Endian "] PRDT  Completion with Data |
POOBORAR: 52545352 APASEAIE BOGEORDD EBADABEA E
POEBEERLE: PPORICED PEAOLADE BAD1RA3P ABB4BEAL = RRIEr ey BesdlCen
©008028: FFFFFFFF FFFFFFFF FFFFFFFF FRFFFFFF PRO0.1  Completion with Data |
P020AR30: @212F1A4 APAGEARA FFFFEEDL AEA0A2Ea S
@0000040: 0000028 004Q00ED 840000800 ABORAGED PRD0.1 " Completion with Data |
POOBARSE: G0OBOOTE AB4BEA3A C1T1AEGE ABA0A8EA PRD 01  Completion with Data |
POOBORAE: COABODRE APAGRA0A BOGAERDD ABADAGEA PRD 0.2 Memory Read 64b (Genl
P00B0R7E: @212F148 APAGEAGA B212F1A4 ABAGEAEA T
90080258: FFFFFFFF QPO0E020 B0200B02 ABADRBES PRD0.2  Completion with Data |
PAAGARIR: @BS54004F APS30046 G0REAAD2 AEAVAAEA PRD 03 Memory Read 64b (Genl
POORARAR: C0ARO0RE APAGRA0A GOREERNR AEADAAEA T
POOBARER: C0AGO0DE ADAGEA0A BOGEARDD ABADAGEA - PRD 0.3  Completion with Data |

In the above example, the following transactions are a part of the ATA Command Write FPDMA
Queued super transaction.

1

The first transaction is a memory write to the PxCl (Port x Command Issue) register to indicate
that a command has been built in memory for a command slot.

The second transaction is a memory read for the added command list entry.

The third transaction is a memory read of the Write FPDMA Queued command from the
command table.

The fourth transactions is a DMA Setup FIS (DSFIS) memory write to transfer data for the Write
FPDMA Queued command in the appropriate slot.

The fifth transaction is a PRD Table read transaction. This transaction further expands to display
the PRDT entry used for reading the transferred data.

The last transaction in the set is a memory write for updating the Set Device Bits FIS. This
indicates the completion of the Write FPDMA Queued command.

For more information on visualize transaction, refer to “Visualizing a Transaction Set (Super
Transaction)" on page 109.

Viewing Decoded Payload for AHCI Commands

For AHCI ATA IDENTIFY DEVICE and IDENTIFY (PACKET) DEVICE commands that retrieve
information in a specific data structure format, you can view the returned data structure in the same
format as defined in the Serial ATA specifications. The Transaction Decode tab displays the decoded
payload (all 256 words) for these commands to present their data structure as per the defined
format.
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To view the decoded payload of an AHCI ATA IDENTIFY DEVICE command

1 Right-click an AHCI ATA IDENTIFY DEVICE transaction in the Transaction Decode tab.
2 Select Decode Payload...

Transaction Type ' : o eatures Command
15 AHCI ATA Command Identify (R Go toID... 0x00 IDENTIFY DEVICE
tamp Transaction Type Go To Packet r DBA I
77 ms | | AHCI COMMAND TABLE PRDT Decode Payload.. | 0x0000000003F9CBIC | | 0 |
imp Transaction Type Port — : BSY R 1 D R
5 || AHCI PIO Setup FIS W) 11 | Visualize Transaction... Ctrl+LefthMouse 4|l 0 |loll1[1 0]

m Clear Transaction Data...

The Decode Payload dialog box is displayed with the payload fields matching the information structure
specified for the IDENTIFY DEVICE command in Serial ATA specifications.

The following screen displays the payload details of the IDENTIFY DEVICE command.

' Decode Payload EI@
Eile
Field Description Value
= Identify Device -
000 General Configuration D
ool Ohbsclete Ox3FFF
ooz Specific configuration 0xCE37
003 Chbsolete 0x0010
004..005 Retired 0x00000000
006 Obsoclete 0x003F
007..008 Reserved for CompactFlash Association 0=00000000
009 Retired 0x0000
010..019 Serial Mumber 258R9JCBO9BTET
020..021 Retired 040000000
022 Ohbsclete 0x0004
023.026 Firmware revision AZ1IR0020
027.045 Madel number TSO100ML20 4NHM-01M1E
047 Multiple Count
Trusted Computing feature set options Ox4000
=049 Capabilities
49.15-14  Reserved for IDENTIFY PACKET DEVICE O
1 = Standby timer values specified by st Ol
4912 Reserved for IDEMTIFY PACKET DEVICE 0 -
Maps to a word within the IDENTIFY DEVICE Maps to a bit within a word.
command as per the Serial ATA 13th bit of the 49th word in this
specifications. case.

49th word in this case.

Viewing PRDT Entries for an ATA Command

Physical Region Descriptor Table (PRDT) is a table of scatter/gather list. It has zero to many entries.
Each entry has a base address and byte counts in system memory where the device reads or writes
the actual data transfer if the ATA command is a data transfer command.
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In the Transaction Decode tab, you can view the PRDT entries associated to an ATA command that
utilizes PRDT entries such as an AHCI ATA Identify command or AHCI Read FPDMA Queued

command.

To view the decoded PRDT entries of an ATA command

1 Right-click the transaction displayed for the command in the Transaction Decode tab.

2 Select Visualize Transaction...

A dialog box is displayed with applicable PRDT transactions and other related transactions for
the ATA command. In the following example, the three transactions for reading the PRD table for
the Read FPDMA Queued command are highlighted. Clicking one of these PRDT transactions
displays the raw payload for that PRDT Read transaction in the lower pane.

&2 561940: AHCI ATA Command RDMA_NCQ (R)

(=000000013E648458 |

3 transactions for reading the PRD Table

1 |

mn

Address Type # PCle TLPs
= AHCT ATA Command RDMA_NC AHCI

Ooc00000000D1CI01ES PulL 1
Oee0O0000013ES48320 CmdlList 1
(00000001 3E64DE00 AHCI ATA Command RDMAMNCO (R 1
Cee00000013E64A8400 DMA Setup FIS 1
Oec000000013E64DERD Physical Region Descriptor Table 1
0x000000013E640980 Physical Region Descriptor Table 1
00000000 13E64ADADD Physical Region Descriptor Table 1
Set Device Bits FIS 1

L

Physical Region Descriptor Table Payload [DWurd V] [4 Columns "] [Little Endian |

2a3ea0es: 734E4009 aoodeaen
28200018 F3IE5002 aoa2e8ed
28200028 7ESE6EE2 ooa2eoen
208200038 FEIETO02 eoadoaen
@ageaada: FYF1998d aoadoaen
2a3ea058: FIBE998d eoodeaen
2a2ea2ea: F3CEAQE2 aoa2eaed
2a2eae7a: 7EDEGeed aoe2eaen
28200058 F36ECOBY aoaaeden
2a200259a: 734140083 aoo2o808
2a3ea248: TIBEEGED aoodeden

aaeades
aaeaaese
gaealese
aaeaaese
paeadeae
aaeades
aaeaaeae
aaeadese
aaeaaeae
paeadeae
aaeadese

ABaQaFFF
ABBRBFFF
2AB8eBFFF
2AB80aFFF
ABQBFFF
ABaQaFFF
ABBRBFFF
2ABBRBFFF
208QaFFF
ABQBFFF
ABOQEFFF

F

1

PCle Packets | Mested (Time Ordered) =

ID

Packet

PRDT

Memory Read 64b (Genl,2)

PRDT
PRDT
PRD 0.1
FRD 0.2
PRD 0.3
PRD 0.4
PRD 0.5
PRD 0.6
PRD 0.7
PRD 0.8
PRD 0.9
PRD 0.10
PRD 0.11
PRD 0.12
PRD 0.13
PRD 0.14

Completion with Data (Ger

Completion with Data (Ger
Memory Write 32b (Genl,2)
Memery Write 32b (Genl,2)
Memory Write 32b (Genl,2)
Memory Write 32b (Genl,2)
Memeory Write 32b (Genl,2)
Memory Write 32b (Genl,2)
Memory Write 32b (Genl,2)
Memory Write 32b (Genl,2)
Memory Write 32b (Genl,2)
Memory Write 32b (Genl,2)
Memeory Write 32b (Genl,2)
Memory Write 32b (Genl,2)
Memory Write 32b (Genl,2)
Memory Write 32b (Genl,2)

3 Expand each of the displayed PRDT read transactions in the left to view the PRDT entries used for
the data transfer. In the following example, the 16 PRDT entries applicable for the first PRDT read
transaction are highlighted. With each PRDT entry, its base address, bytes count, and the
number of PCle TLPs utilized for data transfer are also displayed.
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Address # PCle TLPs

=l AHCT ATA Command RDMA_NC' AHCT

e i |

4 Clicking a PRDT entry:

it e ime 1t

1D

Packet

PRD 0.1
PRD 0.2
PRD 0.3
PRD 0.4
PRD 0.5
PRD 0.6
PRD 0.7
PRD 0.8
PRD 0.9
PRD 0.10
PRD 0.11
PRD 0.12
PRD 0.13

Memaory Write 32b
Memory Write 32b
Memory Write 32b
Memory Write 32b
Memaory Write 32b
Memory Write 32b
Memory Write 32b
Memory Write 32b
Memory Write 32b
Memory Write 32b
Memaory Write 32b
Memory Write 32b
Memory Write 32b

4 —

displays the raw payload for the data transfer for the memory pointed to by that PRDT entry.
highlights the first PCle packet utilized for data transfer for the memory pointed to by that

PRDT entry.
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I 561940: AHCIATA Command RDMA_NCQ (R)

PCle Packets | Nested (Time Ordere

D
PRD 3.25
PRD 3.26
PRD 3.27
PRD 3.28
PRD 3.29
PRD 3.30
PRD 331
PRD 3.32

Packet
Memory Write 32b (G
Memory Write 32b (G
Memory Write 32b (G
Memory Write 32b (G
Memory Write 32b (G
Memory Write 32b (G
Memory Write 32b (G
Memory Write 32b (G

Address Type #PCle TLPs  Size
= AHCI ATA Command RDMA_NC AHCI .
0x00000000D1C101B8 PxCI 1
0x000000013E648320 Cmdlist 1
0x000000013E64D800 AHCIATA Command RDMANCQ 1 =
0x000000013E648400 DMA Setup FIS 1
= 0x000000013E64D880 Physical Region Descriptor Table 1
0000000007 84E4000 PRET entry O 32 4096
0x00000000782E5000 PRET entry 1 32 4096
0x00000000785E6000 PRDT entry 2 32 4096
0x00000000783E7000 PRET entry 3 32 4096
0000000007 7F13000 PROT entry 4 s—— 32 4095 |
0x0000000078BE2000 PRET entry 5 32 4096
0x0000000078CEAQDO PRET entry & = ACES,
0x00000000780EBO0D0 PRET entry 7 32 4096
0x00000000786ECO00 PRET entry 8 32 4006 ~

b |

PROT entry Payload |DWord ~ | [4 Columns = | [Little Endian ~

2ageaoaa;
2ageaala:
2a980028:
2a98003@:
28200048

539BA@12 3DEFACAD 219A4962 BF995863
177ABB43 @CA24CAT1 6AZDD5383 EAD192D5
CEBB2@A5 FCBCF348 4D5A382D 35CCAF83
BCFBO6AC A21ACCSE 277956EB 52D3359C
ACEDBF3E 948F6cEA4 7A25FBDT 28B04481

PRD 4.1

Memory Write 32b (G

PRD 4.2
PRD 4.3
FRD 44
PRD 4.5
FRD 456
FRD 47

Memory Write 32b (G
Memory Write 32b (G
Memory Write 32b (G
Memory Write 32b (G
Memory Write 32b (G
Memory Write 32b (G

n
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Offline Performance Summary - Overview / 132

Configuring and Computing Offline Performance Summary / 135
Interpreting the Performance Summary Results / 142
Navigating Through the Performance Summary Results / 157
Customizing Charts / 156

In the Protocol Viewer window, you can generate and view the performance summary from a PCle
trace that you captured using the U4301A/B Analyzer module. This chapter describes how you can
compute and view offline performance summary from the captured PCle data.
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12 Viewing Offline Performance Summary

Offline Performance Summary - Overview

The PCle Performance Overview tab in the Protocol Viewer window allows you to perform post
processing on the captured PCle traffic to generate an offline performance summary of bus

utilization. This tab presents statistics for various performance parameters in tabular as well as
charts form.

In this tab, you define the range of captured data for which performance summary is to be generated.
The software decodes transactions from this specified range of data and then computes performance
statistics and charts from the decoded transactions. The specified range of trace data is sampled and
statistics is computed from these samples to generate charts for each performance parameter.

Performance statistics are displayed separately for upstream and downstream link directions.
You do not need connectivity to the U4301 hardware module to generate
NOTE performance summary from a captured PCI
y pture e trace.

PCle Performance Overview Tab

You use the PCle Performance Overview tab displayed in the lower pane of the Protocol Viewer to
compute and view performance summary.

This tab displays the performance data in the following two panes.

Pane Description

Performance Statistics pane This is the left pane that displays a list of categories and the performance parameters for each of the categories for which
statistics will be generated and displayed. For each of the parameters that you select, statistics are displayed based on the
link directions (upstream as well as downstream).

Performance Charts pane This is the right pane and displays a performance chart for selected performance parameters listed under the category.
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Performance Statistics Pane

Performance Chart Pane

If the PCle Performance Overview tab is not visible, click the button displayed at the top
of the Protocol Viewer window.

The Overlay View - At a Glance

The information in the PCle Performance Overview tab is presented using the Overlay view. The
Overlay view allows you to select the series that you want to be displayed in the chart area. You can
select the series by clicking the required performance parameter check box listed under Statistics
tree/table on the left. This view displays graphs for the selected series in a single chart with a black
background. It displays the Band Chart area where you can view the MSI Write, Msg Assert_INT and
Msg Deassert_INT and error packets occurrence plotted in the chart. It also displays multiple Y-axis
which you select in the Setup dialog box. To know more about how to select and interpret multiple
Y-axis, see “Showing/Hiding multiple Y-axis" on page 138. Following screen displays the Overlay view
after you select and compute a range:
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In the above screen, graphs for the Update_FC_P series (represented by dotted lines) in both
directions are displayed. The blue dotted line represents the graph for Update_FC_P series in

upstream, whereas, the red dotted line represents the graph for Update_FC_P series in the
downstream direction.
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Configuring and Computing Offline Performance Summary

Before you Start

You should have purchased and installed the Offline Performance Summary license for computing
performance summary.

On purchasing the license, you receive an entitlement certificate. Follow the instructions in this
certificate to install the license.

Ensure that the data in the required direction(s) is already captured and available in the Logic and
Protocol Analyzer GUI for performance summary computation. You may save the captured data in
a Logic Analyzer configuration (.ala) file and access this data offline for performance summary
computation.

Computing Offline Performance Summary

Click the PCle Performance Overview tab in the Protocol Viewer window.

In the Data Range groupbox, specify the start and end points of the captured PCle data for which

you want to compute performance summary. Only the specified range of data is analyzed to

compute performance. Following options are available for setting this data range.
Beginning and End of data - This data range selection ensures that performance summary is
computed for the entire trace.
Begin Extent and End Extent - This data range selection ensures that performance summary is
computed only for the data that has been marked by extent markers. The software
automatically places extent markers on the beginning and end of the current pan/zoom
extents defined in charts. When you change the pan/zoom extents in charts, the extent
markers are automatically moved to changed extents.
Trigger - Selecting Trigger in the data range ensures that performance summary is computed
from the point where the U4301 module’s trigger condition was met.
Markers - Selecting markers in the data range ensures that performance summary is computed
for the specific portion of PCle traffic defined by markers. Refer to “Defining Markers for Setting the
Computation Range" on page 136 to know more.

Data Range [[] Include Errors ~ [C]]

Beginning Cf Data | to: [End Of Data - |

3 For generating performance statistics, only complete transactions from the captured trace are

used. Select the Assume ACK checkbox to instruct the software to assume ACKs for the
transactions in which only ACK is missing. Assuming ACKs, therefore ensures that the
transactions with missing ACK are considered complete and used in performance summary
computation. You may want to use this Assume ACK option in situations such as when you have
filtered ACKs while data capture to make more memory available to TLPs.

For producing the performance statistics, transaction of only error free packets from the captured
trace are taken into account. The packets containing error are ignored while generating the
performance statistics. Select the Include Errors check-box to let the software include error
packets and compute the performance statistics including these packets. Selecting Include
Errors checkbox increases the computation time of PCle performance Overview. It creates a series
that is displayed in the Band Chart with an element for each packet containing error in the list.

5 Click the Compute button displayed with the Data Range fields.
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Compute This and Compute All are the two options available with the Compute button.

- Compute All allows you to compute traffic overview statistics, decoded transactions, offline
performance summary, and LTSSM states (in their respective tabs) for the captured packets
by a single click of this button.

- Compute This allows you to compute only performance summary from the captured
packets. When you click Compute, then also only performance summary are computed.

If you want to compute performance summary in background while the U4301 module is
capturing PCle data, then select the Compute All on Run check box in the Protocol Viewer
and click the Run toolbar button. This allows you to perform a compute for all the relevant
tabs in Protocol Viewer automatically after the data capture is complete. It thereby helps you
perform a faster compute than performing a compute for each tab individually after the data
is captured.

Ill Hl I"l L| T| LlTﬂll"l

pf ©sw Favorite Layouts ¥ | | Compute All on Run

On clicking Compute, first the transactions are decoded from the specified data range of PCle
trace. Then, statistics and charts are computed from these decoded transactions and results are
displayed.

Defining Markers for Setting the Computation Range

If the captured PCie traffic is too large and you want to view performance summary for a specific
portion of this traffic, then you can limit the computation range by defining start and end markers in
the PCle traffic.

To define markers

1 From the upper pane of the Protocol Viewer, right-click the row in the captured PCle traffic that
should act as the starting point for performance summary computation.

2 Select Place Marker from the displayed context menu and then select an existing marker or click
New Marker to define a new marker at this point.

Once markers are defined, these are available for selection in the Data Range group box of the PCle
Performance Overview tab.

Settings Data Range

Saving the Computed Performance Summary Data

Once you computed the performance summary data, you can save the performance configurations
along with the captured PCle traffic in a logic analyzer .ala configuration file. On saving, the settings
such as zoom, pan, sample rate, markers, chart type, and chart order that you configured in the PCle
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Performance Overview tab are also saved in the .ala file along with the PCle trace data. Loading this
.ala file retrieves these settings and computes and displays performance summary based on the
saved settings.

You do not need the Offline Performance Summary software license to resample charts from
the computed performance summary. However, if you want to recompute performance
summary from the saved PCle trace, then you need the Offline Performance Summary
software license.

To save the performance summary settings

Click File > Save as.
2 In the Save As dialog box, specify the name of the file.

3 Ensure that the Standard Configuration (*.ala) option is selected as the file type and All Data and Setup
is selected in the File Options group box.

4 Click Save.

To access and view previously saved performance summary settings
1 Click File > Open.

2 Inthe Open dialog box, navigate to the Standard Configuration (*.ala) file in which you saved the
data.

3 Click Open.
Defining Chart Settings

You can define settings for the overlay chart in the Setup... tab of the Settings section and change
the appearance of the displayed chart.

To access the Setup dialog box

Click the Setup... button under the Settings section. The Setup dialog box appears as shown below.
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E Performance overview setup |—|
| ¥ Axes

Flow Control Init

Enter InitFC values in Bytes (Credits times 16)

PCle-101:Down PCle-101:Up
InitFC P o 6=+ JE|Rj=j+
InitFC NP [192 |B|= |+ 5192 [N|=|+
InitFC Cpl | JEE  |R[=|+ JE (R|=|+
Use these InitFC values
MSI Interrupts

Minimum (HEX) Maomum (HEX)
71 MSI Addrese  FEEDDO0 FEEFFFFF

7 MSI-X Address 1886026880421020 laaaaef0eadalFFF

Parameter Type Color

PCle-

101:Up Flow ControlUpdateFC_P (Bytes) - Dash Line -

FCle-

101:Down Flow ControlInterrupts . Pyramid Down 1.

PCle-

101:Down Bus Statistics:Bandwidth (GBits/s) . Line v

PCle-

101:Down Bus Statistics:Data Throughput (MBytes/s) . Line ot

Ie-101:Down Bus Statistics:Payload Length (DWerds) || B Line *

L (| {2

n "

Reset | Close Cancel Help

The setup details that you specify in this dialog box helps you change the way series and axes are
displayed in the overlay graph. For example- you can change the graph display type and color of the
displayed series or you can show or hide the Y-axis by selecting or de-selecting the respective Y-axis
checkbox.

The following is the list of tasks that you can do using the Setup dialog box:

Showing/Hiding multiple Y-axis

Select or de-select the Y-axis checkbox to show or hide the Y-axis displayed in the chart.

Keysight U4301 PCle Gen3 Analyzer User’s Guide



Viewing Offline Performance Summary 12

Y Axes

M GBits/s Axis
B e

M DWords Axis
Byte

M TLPs/s

|
M Time in us

Showing or hiding a particular Y-axis does not affect how series are computed or
displayed in the chart.

Specifying InitFC values

You can initially define the maximum flow control credit limits by entering InitFC values for posted,
non-posted, and completion transactions in both directions (Upstream and Downstream).

Flow Control Init

4!

Enter InitFC values in Bytes (Credits times 16)

PCle-101:Down PCle-101:Up
InitFC P |8 | — |+ |8 | — |+
InitFC NP |8 |— |+ |8 |— |+
InitFC Cpl |8 | — |+ |8 | — |+

¥ Use these InitFC values

Click B button displayed with the InitFC_P, InitFC_NP, and InitFC_Cpl fields to open the calculator
and input values. Select the checkbox ‘Use these InitFC values’ to use the InitFC values defined by
you when you are computing and interpreting offline performance summary. In case InitFC values are
not defined or ‘Use these InitFC values’ field is not selected, the minimum and maximum credit levels
for the captured trace is automatically computed and flow control mechanism works on the basis of
those calculated values. The minimum and maximum credit levels varies from one trace to other
depending upon the size of the trace.

InitFC values are applicable only for Flow Control performance statistics

category. You can use InitFC values for posted, non-posted and completions
transactions only when you are computing flow control credits.
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Specifying Min/Max value for MSI and MSI-X Address

You can specify the minimum and maximum values for the Message Signaled Interrupt (MSI/MSI-X)

address in the MSI and MSI-X Address row for which you want Interrupt to be generated and plotted
in the Band Chart.

Selecting this checkbox will generate interrupts for the specified address which you can view in the

Band Chart.
MSI Interrupts
Minimum (HEX) Maximum (HEX)
MSI Addrecs FEEB2286 FEEFFFFF

MSI-X Address  19608200284310680 le6o6e06ea4a81FFF

Understanding Parameter Column

The series which you select by clicking their respective check-box in the Statistics Tree/Table of the
Performance Overview Tab is displayed here in the Parameter column of the Setup dialog box. The

Parameter is the full name of the series and is comprised of the Direction (Up or Down), the Category
name picked from the Performance Statistics tree/table, and the checked Series name.

PCle-101:Up Flow Control:UpdateFC_P (Bytes)

Direction

Category Name FPerformance Parameter

Changing the appearance of the graph

You can change the appearance of the graph representing the respective series listed in the

Parameter column of the Setup dialog box. To do so, click the drop-down in the Type column and
select the graph type you want to change with.
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Changing the color of the Graph Line
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You can also change the color of the graph line by picking color of your choice from the color palette.
To do so, click the Color drop-down to display the color combo box consisting of different colors, and

select the color of your choice.

Color

Once all the settings are defined in the Setup dialog box, click the Close button to apply those
settings and exit from the dialog box.

Click the Reset button to restore the last settings done previously when you opened the Setup

dialog box. This resets the Axis, Types and Colors to their previous state.

Clicking the Cancel button allows you to exit from the dialog box without making any changes.
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Interpreting the Performance Summary Results

Performance Statistics panes

The Performance Statistics pane displays a hierarchical list in which various performance statistics are
categorized in groups and sub-groups.

Clicking a group or category in this pane displays the link-wise statistics for associated performance
parameters. The following table briefly describes the performance statistics displayed for categories.

Category Performance Statistics Displayed

Flow Control Tracks and computes the available flow control credits for a bidirectional data trace and helps in analyzing the flow of data. To
know more refer to the topic “Flow Control.

Bus Statistics = Band width (GBits/s): Shows the number of non- idle symbol bits transferred per second.
= Data Throughput (MBytes/s): Shows the number of TLP payload bytes transferred per second.
= Payload Length (DWords): Shows the minimum, maximum, as well as average payload size for TLPs.
= TLP Count (TLPs/s): Shows the number of TLPs transferred per second.
= Link Efficiency (%): Shows the efficiency of the link. It is calculated as Symbol time for payload / (Symbol time for all DLLP +
Symbol time for all TLP + Symbol time for OS).
= Link Utilization (%): Shows the percentage of non- idle symbols in total number of symbols transferred.
= TLP Utilization (%): Shows the percentage of TLP symbols in total number of symbols transferred.

Transaction Performance = Non- Posted Transactions: Shows the minimum, maximum, and average values of the following performance parameters for
all non- posted transactions.
Response Time (ns): It is same as the duration of the transaction.
Latency (us): It is the time duration between the end of a request transaction and the arrival of its first completion.
Throughput (MBytes/s): It is the length of complete data divided by the response time.
= Posted Transactions: Shows the minimum, maximum, and average values of the following performance parameters for all
posted transactions.
Response Time (ns): It is same as the duration of the transaction.
Throughput (MBytes/s): It is the length of complete data divided by the response time.

Some important points while viewing and interpreting performance summary:

A --.-- value displayed in a statistics tree/table for a performance parameter indicates that the
packet(s) required to generate that statistics is not found in the trace. It signifies ‘no data’ received
for generating the statistics. Consequently, the chart corresponding to such a performance
parameter contains no data and is therefore not displayed in the charts pane. Such a chart gets
displayed only when the required packets are found while computing performance summary to
generate data for the chart.
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" Details | Header | Payload | Lanes | Traffic Overview | LTSSM Overview | Transaction Decode ' PCle Pe

Data Range [ Include Errors Lssume ACK
[Beginning Of Data v] tor [End Of Data v] [ Compute ]
CIe ™ dUrReEsL Iil

(4] Al Bus Statistics (Sampled)
(I:] Bus Statistics (Sampled)
@ Fayload Length (D'*/ords) (Sampled)
Parameter PCle-1071:Down PCle-101:Up

Memary Wite ]
Minimum 1.00 -
Lerage 1.00

Maximum 1.00 -

110 Wite

Minimum - -

Lyerage
Maximum — - -

For calculating the statistics for the Completion parameter, only Completions with Data packets
are included. Any Completions without Data packets found in the trace are ignored for this
parameter’s statistics calculations.

For instance, in the following screen, the Completion with Data packets are used for calculating
the minimum, maximum, and average payload size for Completions. In the absence of
Completion with Data packets in the trace, the Completion statistics is shown --.--.
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Data Range | Include Emors - [ Assume ACK
[Beghnh'lgﬂiﬂan = |to: |End Of Data = || Compute |

(@ Payload Length (DWwords) (Sempled)
Parameter PCle-101:Down PCle-101:Up

Memory Winte
Minimum ——
Averags
Maximum - -
/D) Wirite O
Minemum 1.00 -
Average 1.00
Maimum 1.00 -
Config Wiite
Minimum
Average

Maxmum -
Completion [

Minamwmm E 1.00

Average 1.00
Some performance parameters are displayed in blue color. This indicates that the navigation to
the associated PCle packet is applicable for that performance parameter. To know more, refer to
“From the Performance Statistics pane" on page 154.

Farameter PCle-102:Up PCle-102:Down
UpdateFC_P (Bytes)
Mirimum 0.00 0.00
bverage 4444 51 4571.28
Maximum 771200 T272.00

Charts pane

This pane displays charts for all the selected performance parameters listed in the statistics tree
table.

Viewing Multiple Y-axis in the Chart Pane

The chart pane displays multiple Y-axis if you select multiple Y-axis checkbox in the Setup... dialog
box. To know more, see “Showing/Hiding multiple Y-axis" on page 138.
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Viewing Overlay Charts and defining Color code for graphs

The Chart pane displays Overlay chart for selected performance parameters listed in the categories
pane. You can define different color codes to display the performance data for downstream and
upstream directions in charts. To accomplish this, click the Setup... button under the Settings
section. Then, click the Color drop-down to select the color from the color palette. To know more,
refer “Changing the color of the Graph Line" on page 141.

Viewing Band Chart

The lower section of the Chart pane displays the Band Chart. You can view MSI Write, Msg
Assert_INT and Msg Deassert_INT and error packets in the Band chart area of the Chart pane.
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7] Emor Packet

Deassert INT
Assert INT

M5! Intermuot

Viewing X and Y axes values in a chart

Hovering the mouse over a chart location displays the applicable values of X-axis and Y-axis for that
location.

Flow Control

Flow Control computes and displays the available flow control credits from the data trace that has a
bidirectional traffic. It presents flow control statistics and graphs and helps in analyzing the flow of
data. Flow control credit level is determined by the Writes and Completions in one direction and the
UpdateFC packets in the other direction. The data series created for the flow control charts contain a
point for every packet that is a part of that series. This is in contrast to all other charts which
represent a group of packets in a sample period. Flow control credit levels are represented by
UpdateFC series. The performance parameters for the Flow Control are explained below:

UpdateFC_P (Bytes) - Shows the minimum, maximum, as well as average flow control credit levels
for posted transactions.

UpdateFC_NP (Bytes) - Shows the minimum, maximum, as well as average flow control credit levels
for non-posted transactions.

UpdateFC_Cpl (Bytes) - Shows the minimum, maximum, as well as average flow control credit levels
for Completions data.

Memory Read (Bytes) - Charts the size of Memory Read requests in each direction (X and Y axes).
Memory Write (Bytes) - Maps the size of Memory Write and MsgD packets in each direction.
Memory_CplD (Bytes) - Charts the size of Memory completion with data packets in each direction.

Inst. CplD and Inst. Write (Mbytes/s) - The instantaneous completion with data (Inst. CplD) and
instantaneous write (Inst. Write) show Instantaneous Bandwidth in each direction. Instantaneous
Bandwidth is defined as the number of data bytes (in MegaBytes) in the packet divided by the
time (in seconds) since the end of the previous data carrying packet to the end time of the current
data carrying packet.

Each packet carrying data is represented by a point in these series.
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Interrupts- Shows the location in the graph where MSI Write, Msg Assert_INT and Msg
Deassert_INT occurred. This is displayed in the Band chart area of the chart pane.

Error Packet- Shows the location in the graph where packets with any error occurred. This is
displayed in the Band chart only when the Include Errors checkbox is enabled under Data Range
heading.

Flow Control- Examples

The following examples elaborate the usage of Flow Control feature:

Example-1

The flow control charts represent the computed flow control credit level, which is meant for how
many bytes the receiver is ready to receive. When the data is sent in a higher volume than the
receiving capacity of the receiver, there will be a continuous slow movement of data from transmitter
to receiver. This sometimes also leads to data loss. In such scenarios, you can use the Flow Control
feature to display the credit limits of the data to be sent and the data received by the receiver.

In this example, 4092B (1023 DW) packets of data are being sent in the downstream direction and
the link partner is updating credits in increments of 4096B. In the following screen, a steep decline in
the blue line clearly indicates the situation that FC credit is being updated at higher rate than the
rate at which data is being posted. The blue line represents the computed UpdateFC_P regulating
against the red line representing the corresponding Memory Write packets in the trace.
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The UpdateFC_P Flow Control credit level is reduced by Memory Write packets coming from the root
occurred in the trace. As displayed in the above graph, the Maximum is near the beginning of the
trace and the Flow Control credit level continuously drops down and reaches zero on the right side of
the trace.

This too many credits difference may indicate problem in the credit update behavior of the DUT.

Example-2
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In the following screen, when memory completion data (Memory CplD) is being sent, the
UpdateFC_Cpl performance parameter computes and displays minimum, maximum, as well as
average flow control credit levels for Completions data. The blue and orange Pyramid Up chart line
represents Memory CplD and UpdateFC_Cpl respectively. The UpdateFC_Cpl credit starts from an
initial counter value and keeps on updating its credit limit till all the packets are sent and received.
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As displayed in the above graph, the UpdateFC_Cpl graph line keeps showing the credit fluctuation
regulating against the corresponding Memory Completion packets coming from root that occurred in
the trace. The drop in credit level shows how many packets are left to be transmitted and helps in
regulating the flow of data packets. When all packets are transmitted and received, the FC level
changes to zero counter value. It remains constant till any further credits are added into account.
Once the FC level is incremented with some value, the same mechanism is repeated till all the
packets are transmitted and received and FC level again comes to a zero value.

Example-3

In the start of the DMA buffer transfer, the link credits are quickly exhausted and reaches to zero
counter value because the buffer transfer runs at a higher rate in comparison to the rest of the data
transfer. The quick drop in credit level is caused by the chain of link buffering. In the start, the data
write or completion capacity remains higher than the sink capacity but lower than the link capacity.
The data transfer at higher rate only happens while the link buffering capacity can sustain it.
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Saving the Favorite Overlay Chart

In the PCle Performance Overview tab, the Settings section has a Favorite Charts button which
allows you to save your favorite charts and open the previously saved overlay charts.

Settings

Setup...| || Favorite Charts ¥|

The overlay chart is saved along with all the settings that you made to the graph displayed in the
chart pane of PCle performance tab (such as selecting or deselecting various performance

parameters in the Categories pane, zooming or panning the chart, making changes in the Setup
dialog box etc.).

To save the Overlay Chart

1 Click Favorite Charts button> Save as.

Open...

Save As...

C:\Users\Test.cfv
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2 Inthe Save As dialog box, specify the name of the chart. Ensure that *.cfv (Chart Favorite) option
is selected as the file type.

3 Click Save.

To view previously saved Overlay chart

1 Click Favorite Charts button> Open.
2 Inthe Open dialog box, navigate to the *.cfv file name by which you saved the Overlay chart.
3 Click Open.
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Navigating Through the Performance Summary Results

Navigating Through a Chart

By Using Pan option

To navigate through a chart horizontally, that is X-axis, click the Pan X-Axis button displayed at the

top of the charts pane.

To navigate through a chart horizontally and vertically, that is both axis, click the Pan Both Axis button
displayed at the top of the Charts pane. You can then drag the chart up, down, left, and right.

Navigating Between Performance Statistics and Associated PCle Data

By placing markers in charts

You can place markers in charts and use these markers to navigate to the PCle packet associated
with the chart location at which you placed a marker. Markers placed in charts are correlated to
markers displayed in the trace data in the upper pane of the Protocol Viewer.

This type of navigation is particularly useful when you notice a sudden variation in a chart and want
to navigate to the exact trace position that corresponds to that chart location.

8. Sample Husber Tims FCI-Express Packet Link Spesd
1764 35.618% us EHP 05 GFend
1600 35. 625 us MagD Gend
1765 35.635 ua hck Genld
1601 35. 645 ua ID Rd Gend
1766 35.651 ua Rck Fen3
1767 33. 655 us UpdatefC-p Gend
M1 oJi602 35. 661 us Ack Gen3d

To place a marker in charts

1 Double-click the location in the chart at which you want to place a marker. A new marker is
added to that chart location and the corresponding trace location in the upper pane (trace view).

Alternatively, right-click the chart location where you want to place a marker. Then select Place >
New Marker or select an existing marker to place that marker at the current location.
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Settings Pan and Zoom Sample Rate
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Place

Delete Marker M1
Delete All Markers M3
Go To Here (28.7 us) M4
GoTa ME

Show Legend M2

Hide Band Chart

Properties... Mew Marker

To navigate to a particular marker placed in charts

In situations when you have placed multiple markers in charts, you may want to navigate to a
particular marker and its associated trace position in the upper pane. To do so, right-click anywhere
in a chart, select Go To and then select the marker to which you want to navigate.

On doing so, the chart display moves to the point at which the selected marker is located. Also, the
trace position corresponding to the selected marker is highlighted in the upper pane.

If the markers are not displayed in charts, click the Show Markers button at the top of the
charts pane.
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Samings Fan and Zoom Sample Rate
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Place

Delete Marker
Drelete All Markers
Go To Here (18.7 us)

Go To Begin Extent

Show Legend Beginning Of Data

Hide Band Chart Trigger
Properties... M3

M1

M5

M4

MB&

M2

End Extent

End Of Data

By using Extent Markers

When you pan/zoom a defined area in charts, Extent Markers are automatically placed at the
beginning and end of this defined pan/zoom extent in charts. On changing the pan/zoom area, these
markers are automatically moved. There may be situations when you zoom a specific area in charts
and then want to navigate to the PCle data associated with the chart’'s zoomed area in a Waveform
Viewer or a Listing. To accomplish this, you can navigate using Extent Markers.

To navigate using Extent markers:

1 Right-click anywhere in the zoomed area in a chart and select Go To.

2 Then select Begin Extent or End Extent to navigate to the PCle data associated with the beginning
or end of the zoomed area.

The applicable PCle data is highlighted in the upper pane of Protocol Viewer as well as in Waveform
and Listing viewers.

If the Extent Markers are not visible, then click the Extent Markers button at the top of the
charts panes to display these markers in trace view as well as other viewers in Logic and
Protocol Analyzer application.
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From the Performance Statistics pane

For some performance parameters such as Minimum and Maximum, it is possible to navigate directly
to the PCle packet that accounted for the generation of a particular statistical value of that
performance parameter.

Such performance parameters for which navigation to the PCle packet is applicable are displayed in
blue color.

In the following screen the “Message” parameter in the downstream direction has a Min of 1.0 and
Max of 1024 displayed in blue color. Clicking these numbers, navigate you to MsgD packets with
lengths of 1 and 1024 (DWords) that is accounted for the minimum and maximum value respectively
in the upper pane.
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The chart pane does not show the exact value of the data packets as displayed in
the upper pane of the Protocol Viewer window. This is because the chart pane
displays the graph of sampled series that represents an average value of all the
packets transmitted during a particular micro second as defined in the sample
rate field.
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Customizing Charts

156

Changing the Sampling Rate and Re-sampling the Chart

Sampling is a process by which captured data trace is sampled on the basis of specified time period
to create charts. The trace data is sampled to compute statistics from these samples for charts
generation. This sampling is done as per the Sample Rate set for charts. By default, the sample rate
is set to 10 microseconds. You can change this sample rate and can re-sample the data trace by
specifying time slices. By resampling the data you can regenerate charts based on the changed
sampling rate.

To change the sample rate of charts

1 Access the PCle Performance Overview tab.

2 Clickthe B putton displayed with the Sample Rate field in the Charts pane on the right.

3 Inthe Time dialog box, specify the value and unit for the sample rate. The permissible range for
sample rate is 1 us to 100 ms.

4 Click OK.

To regenerate charts based on the new sample rate

1 Click the Re-Sample button displayed with the Sample Rate field at the top of the Charts pane.

Sampling is done on the basis of specified time period defined as per the sample
rate. It is not applicable for Flow Control category because Flow Control
statistics is not time dependent and is based on the flow control credits of the
data transmitted and received, The series listed under the Flow Control category
have packet granularity whereas sampling is significant for all other categories
listed in the Statistics tree/table of the PCle Performance Overview tab.

When you capture a data trace and sample it at defined sample rate to generate charts, there may
be repeated scenarios when no message packets are received during a particular slice of time while
sampling the entire trace. Such scenarios are represented in the graph by plotting glyphs at zero

entry. The glyphs plotted at zero, which you see in the chart, signifies no data packet received at that
time.

Message packet displaying a zero/hyphen value in the chart does not mean it
has zero value, rather it means no relevant data received at that time.

Changing the Chart Display

You can change how data is presented in a performance chart. To know, how to change the chart
display, see “Changing the appearance of the graph" on page 140.

By default, data is presented as Dash Line chart type. The following chart type options are available.
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Diamond/Filled Diamond -
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To change chart type for a performance chart

Click the drop-down in the Type column from the Setup... dialog box and select the type you want to
change with.

The chart is displayed as per the changed chart type.

Showing/Hiding the Band Chart

You can show or hide the Band Chart displayed in the lower pane of the chart area.

To hide the Band Chart

Right-click anywhere in the chart location and then select Hide Band Chart.
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To show the Band Chart
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Right-click anywhere in the chart location and then select Show Band Chart.
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Viewing the Center of the Chart

If the captured PCie traffic is too large and defined pan/zoom extent in the overlay chart is outsized,
there may be situations when you want to view where the center of the chart’'s zoomed area lies. You
can do so by using Show Center check-box.

To view the center of the chart’s zoomed area, click the checkbox Show Center. Selecting this
checkbox displays a white colored vertical dotted line at the center of the Overlay Chart. It makes the
center of the chart apparent as displayed in the following screen:

Sedncs Pan and Zoom Sampla Fabe Markars
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Zooming In/Out Charts
You can zoom in or zoom out a defined area in the chart or the complete chart.

To zoom X-Axis for a defined area in the chart

1 Click the Zoom X-Axis option from the combo box displayed in the Pan and Zoom section of the
charts pane to make it active.

Pan and Zoom

EEjaRG

Zoom X-fods
Zoom Bath Axes
Fan #-fxis

Han Both Axes

Move the mouse pointer to the chart location from which you want to begin zooming.

3 Left-click at this location and while keeping the left mouse button pressed, drag the mouse to the
chart location till which you want to zoom the display. As you move the mouse, the zooming
extent is defined in chart and highlighted with gray.

When you release the left mouse button, the defined X-axis area is zoomed for all the displayed
charts. Following screen displays the chart before and after zooming in Overlay view:
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J’ After Zooming

Similarly, you can zoom both X and Y axes of the defined area in the chart by selecting the Zoom Both
Axes option from the combo box displayed in the Pan and Zoom section of the performance charts
pane.
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The X-axis zoom applies to all the displayed charts where as the Y-axis zoom (in both axis
zoom) applies only to the chart in which you define the area to zoom.

You can also zoom in or zoom out complete charts. To do this, use the following buttons in the Pan
and Zoom section of the charts pane.

@| - Zoom In magnifies the center 50% of the chart to the full width of the chart.
@l - Zoom Out doubles the time displayed in the full width of the chart.
@| - Zoom Out Full displays the entire range of Computed data across the full width of the

chart.

You can undo and redo zooms by clicking the E| and E| buttons in the Pan and
Zoom section of the charts pane.
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Glossary

D

DuUT

Device Under Test.

I

interposer

Describes a probing method where the probe is located between a slot and the PCI Express device
under test.

M

midbus probe

Describes a probing method where Soft Touch footprints are designed into a DUT board between the
controller and the device under test.

KEYSIGHT

TECHNOLOGIES
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Compute EQ, 79,83

configuration space, 98,103

configurations registers, 120

connection diagram (for PCle Gen3
analyzer), 22
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decode payload, 116, 126
decoded MSI-X table, 117
decoded transactions, 91
device setup, 93

DUT (Device Under Test), 167
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End Extent, 135

equalization coefficients, 84
equalization summary, 76, 83, 84
Errored LTSSM states, 88
errored transactions, 102

Extent Markers, 153
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0

offline performance summary, 132

P

pan both axis, 151

pan X-axis, 151

PCle, 90

PCle Gen3 Analyzer (U4301), 7

PCle Performance Overview tab, 132

performance charts, 144

performance parameters, 142

performance statistics, 142

performance summary license, 135

physical layer tuning (.ptu) file, 38

Physical Tuning file (.ptu), 34

Physical Tuning file (.ptu), creating, 38

Physical Tuning file (.ptu), selecting in
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port, 105

port specific registers, 122

PRODT, 126

Probing options, 17

probing options, 15

PRP addresses, 95

PRP entries, 112,116

PRPs, 117

Q

queues, 94,104
Quick Tune, 40

S

Sampling Rate, 156

SATA commands, 123
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submission queue, 95
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timestamp, 99
timestamp base, 99
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transaction decode results, 102

transaction navigation, 106

transaction occurrences, 103, 104
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tuning log, 40,47

tuning PCle Gen3 Analyzer
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tuning PCle Gen3 Analyzer (U4301),
preparing for, 37

U

U4301 PCle Gen3 Analyzer, 7

U4301_Performance_Viewer, 131

U4321A solid slot interposer, 37
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U4324A PCle Gen3 Flying Lead
probe, 37

v

visualize transaction, 115

Z

zoom both axis, 164

zoom charts, 70, 163
zoom out full, 71,165
zoom X-axis, 70,163

170

Keysight U4301 PCle Gen3 Analyzer User’s Guide



	Safety Summary
	Safety Symbols

	Compliance and Environmental Information
	U4301A/B PCIe Gen3 Analyzer—At a Glance
	Using the PCIe Gen3 Analyzer
	Contents
	Hardware and Software Installation
	Probing Options for PCIe Gen3
	Specifying the Connection Setup
	Setting the Capture Options
	Tuning the Analyzer for a Specific DUT
	PCIe Gen3 Tuning Overview
	Preparing the U4301A/B Module and DUT for Tuning
	Creating a Physical Layer Tuning File
	Loading a Tuning File in the Logic and Protocol Analyzer GUI
	Tuning a Bidirectional Setup
	Fine Tuning a .ptu File

	Manually Adjusting the Equalizing Snoop Probe (ESP) Settings
	Setting Up Triggers
	Setting Up Simple Triggers
	Setting Up Advanced Triggers
	Setting General Trigger Options

	Running/Stopping Captures
	Viewing PCIe Gen3 Packets and Traffic Overview
	Viewing the Captured PCIe Traffic Statistics
	Navigating through the captured PCIe packets
	Viewing a Traffic Overview Chart
	Exporting Captured PCIe Data to a .csv File

	Viewing LTSSM States, State Transitions, and Equalization Summary
	LTSSM Overview
	Configuring and Computing LTSSM States and Equalization Summary
	Viewing LTSSM States/Transitions Data
	Viewing and Interpreting Equalization Summary Data
	Navigating Through the LTSSM Transitions/States/EQ occurrences
	Interpreting LTSSM States and Transition Results

	Computing and Viewing Decoded Transactions
	Transaction Decoding - Overview
	Configuring and Computing Decoded Transactions
	Interpreting and Navigating Through the Transaction Decode Results
	Viewing NVMe Transactions
	Viewing AHCI Transactions

	Viewing Offline Performance Summary
	Offline Performance Summary - Overview
	Configuring and Computing Offline Performance Summary
	Interpreting the Performance Summary Results
	Navigating Through the Performance Summary Results
	Customizing Charts

	Glossary
	Index

